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---> Dialog Box Topics

Add Folder
Gallery Find
Gallery Properties
Gallery Sort
Paste Special
Alignment

Bitmap Export (all of them)
Control Bars

Document Info
Export

Import

Open

Options

Create Bitmap Copy

Xara Webster Web Files Export dialog box
Web Address

Color Editor

Color Editor

Color Editor Advanced
Color Editor - CMYK

Color Editor - Grayscale
Color Editor - HSV

Color Editor - Linked Colors
Color Editor - Normal Colors
Color Editor - RGB

Color Editor - Shade Colors

Color Editor - Tint Colors



---> Furniture topics

Status Line



---> Menu and Bar Topics

Menus and Buttons

Bars (submenu of the Window menu)
Always On Top

List of Menus

File Menu

Edit Menu

Arrange Menu

Utilities Menu

Window Menu

Help Menu

Arrange Control Bar

File Control Bar

Edit Control Bar

Button Palette Control Bar
List of Default Control Bars
Gallery Control Bar
General Control Bar
Standard Control Bar
Window Control Bar

Selection Pop-up Menu
View Pop-up Menu



---> Message Topics



---> Operation Topics

1234 (recently used files list)
Xara Webster Help

About Xara Webster
Movies (Help Menu)

Tip of the Day (Help Menu)
Arrange Icons

Arrange Views

Bitmap Gallery (Utilities menu)
Color Gallery (Utilities Menu)
Clipart Gallery (Utilities Menu)
Web Address

Clear Selection

Bring to Front

Clone

Zoom Magnification
Zoom To Drawing

Zoom To Work Area

Zoom To Selection

Group

New

New View

Paste

Paste at Same Position
Paste Attributes

Previous Zoom

Copy

Cascade

Put To Back

Quality

Save

Save All

Save As

Using Help

Select All

Show Grid

Snap to Grid

Undo and Redo

ungroup

Close

Line Width

Move Backwards

Move Forwards

Full Screen

Delete

Cut

Duplicate

Exit



---> Overview Topics

Colors Overview

Galleries Overview
Pop-up Menus Overview
Units Overview

Zero Width Lines Overview
OLE Overview

Xara Web File Overview



---> Reference Topics

Xara Webster Help - Empty page
Xara Webster Basics

List of Keyboard Shortcuts

List of Supported File Formats
List of Text Tool Key Shortcuts
The Xara Webster Workplace
Welcome to Xara Webster
About Xara Ltd.



---> Task Topics

Adding clipart to the clipart gallery

Adding titles, descriptions and keywords to documents
Adding web addresses to objects

Aligning and distributing objects

Applying an object's color to another object
Applying attributes to a selected region of text
Applying attributes to a whole text object
Applying attributes to individual text characters
Applying attributes to text

Applying attributes to the text cursor

Applying circular transparency

Applying flat transparency

Applying linear transparency

Applying transparency

Changing an object's fill color

Changing an object's line color

Changing bitmap palettes

Changing line thicknesses

Changing text font

Changing the baseline shift of text
Changing the constrain angle
Changing the duplication distance
Changing the grid spacing

Changing the spacing between lines of text
Changing the nudge size

Changing the paper size

Changing the screen quality of documents
Changing the size of text

Changing the way galleries look
Closing a gallery

Coloring objects

Configuring a web server for Xara files
Copying objects

Creating GIF files

Creating JPEG files

Creating PNG files

Creating animated GIF files

Creating bitmaps

Creating bitmaps from objects

Creating new documents

Creating realistic shadows
Creating simple text

Creating Xara Web files
Customizing the appearance of Xara Webster
Cutting and copying objects to the clipboard

Deleting objects

Deselecting all objects
Deselecting objects
Deselecting selected objects
Displaying the grid

Editing text

Enabling grid snapping

Finding clipart

Flipping objects

Getting help with Xara Webster
Grouping objects

Importing CDR files

Importing CMX files



Importing animated GIF files
Importing colors and palettes
Importing files

Importing transparent bitmap files
Increasing the available work area
Inverting a grayscale bitmap
Justifying text

Loading Files

Making text bold

Making text italic

Moving and resizing galleries

Moving between documents

Moving objects

Moving objects accurately

Moving objects backwards and forwards
Moving objects by dragging

Moving the document

Moving the transformation center
Nudging objects

Opening another view on a document
Opening documents from disc
Pasting objects from the clipboard
Putting Web files on WWW pages

Removing bitmaps from a document
Removing objects from groups
Removing transparency

Removing web addresses from objects
Reordering gallery items

Reordering gallery sections
Returning to the previous zoom
Rotating objects

Rotating objects accurately

Rotating objects by dragging

Saving bitmaps from a document
Saving documents

Scaling objects

Scaling objects accurately

Scaling objects by dragging
Searching a gallery

Selecting a single object

Selecting all objects

Selecting characters in text objects

Selecting items in a gallery
Selecting lines of text in text objects
Selecting objects

Selecting part of a text object
Selecting several objects
Selecting text

Selecting text objects

Setting document options
Setting program options
Skewing objects

Skewing objects accurately
Skewing objects by dragging
Stretching objects

Timing Xara Webster redraw
Turning Tip of the Day on and off
Typing international characters
Undoing and redoing operations
Ungrouping objects

Updating the clipart gallery
Using the Push Tool temporarily
Using the Selector Tool temporarily
Using the Zoom Tool temporarily
Using the keyboard

Viewing document information



Viewing several document at once
Zooming in and out

Zooming to the selection

Zooming to the whole drawing
Zooming to the whole work area



---> Windows 3.1 Contents Topics

Howdol..?



1,2,3,4 (File Menu)

You can use the filenames listed near the bottom of the File menu to open one of the documents recently worked on. Choose the
number or name that corresponds to the document you want to open. For more information, see Opening documents from disc.



About Xara Ltd.

Xara was set up by Computer Concepts Ltd. (UK) to develop CorelXARA and other high-technology Graphics and Internet
applications. Computer Concepts has been developing mainstream application software since 1981. CC was one of the pioneer
microcomputer software houses of the early eighties in the UK developing applications such as the Wordwise word processor
which sold a quarter of a million copies.

With over fifteen years of development experience, more than six of which have been developing 32-bit windowing based
applications for RISC based computers, this has given us an unrivaled experience of developing microcomputer application
software. This experience predates the arrival of 32-bit Windows based environments by many years.

The arrival of 32-bit Windows programming environments (Windows 95 and Windows NT) meant we could exploit that experience
in the wider PC and Windows market, rather than the more niche markets we occupied before.

Web Links
u Xara Home Page
| g
- Xara Ltd.
a3+
u Gaddesden Place, the mansion home of Xara Ltd.
Xara Ltd.

Gaddesden Place
Hemel Hempstead
Hertfordshire HP2 6EX
United Kingdom

Tel +44 1442 350000
Fax +44 1442 350010

Email info@xara.com



About Xara Webster (Help Menu)

About Xara Webster on the Help menu opens a dialog box containing the following information :

Xara Webster Version Number.
Xara Webster Licensee.
Licensee

Organization.

Xara Webster Serial Number.
Host Operating System.

For more information about Xara Ltd. who developed Xara Webster, click here.



Add Folder Dialog Box

With this dialog box, you can add folders of clipart to the Clipart Gallery. For more information, see Adding clipart to the clipart
gallery.
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Related Topics

Updating the clipart gallery



Add Folder Dialog Box - Add Button

Add inserts the selected folder into the gallery. If it contains an index and thumbnails a section (or sections) will appear in the

gallery showing the folder's contents. If the folder does not contain an index or thumbnails you will be asked if you would like to
create them.



Add Folder Dialog Box - Update Button

Update renews all the index and thumbnail information for a folder where necessary. This is generally most useful where you have
changed files in a folder or added new files and you want the gallery updated.



Adding clipart to the clipart gallery
For details on how to add folders of your own clipart to the Clipart Gallery, click the web link below.

Web Link
= Adding Clipart to the Clipart Gallery



| g

Adding titles, descriptions and keywords to documents
To find out how to add title, descriptions and keywords to your documents, click the web link below.

Web Link
= Adding Titles, Descriptions and Keywords to Documents



| g

Adding web addresses to objects

You can add a web address attribute to any object. When someone clicks on the object on a web page it will take them to the web
address (see Putting Web files on WWW pages). For more details on web addresses, an example and a movie showing you how
to use web addresses, click the web link below.

[ To add a web address to an object

1. Select the object (see Selecting objects). You can select more than one.
2. From the Utilities menu, choose Web Address.

3. Type in the web address (URL).

4. Click Add (or Change if the object already has a web address).

Web Links
I.E" Adding Web Addresses To Objects
= Webster Movies - The Basics
3+

Related Topics

Removing web address from objects



Aligning and distributing objects

You can easily move objects on the work area so they are aligned along an edge or their center. You can also move objects so
they are distributed across the work area or between other objects.
| To align or distribute objects

1. Select all the objects you want to move.

2. From the Arrange menu, choose Alignment.

3. In the dialog box, choose whether you want to move the objects within the bounding box of the selection, the work area.
4. From the Vertical Position drop-down list, choose how you want the objects to move vertically.

5. From the Horizontal Position drop-down list, choose how you want the objects to move vertically.

6. When the diagram at the top of the dialog box shows what you want, click Apply.

Tip

| For more information on the options available, click the Help button in the dialog box.
Web Link

g Webster Movies - The Basics

Related Topics
Alignment dialog box



#h Alignment (Arrange Menu)
% CTRL+SHIFT+L

Related Topics
Aligning objects



Always on Top

Always On Top is available from the Document Control Menu. If Always On Top is selected for a view, it will always remain on top
of all other views. This could be used, for example, to edit one view of a document with a smaller higher Quality view set to always
be on top. The edits made in the first, larger view would be reflected in the smaller view which would always be visible.



Animated GIF Export Dialog Box

With the Animated GIF dialog box you can choose how your animated GIF files are created. For information on how to create
animated GIF files see Creating animated GIF files.

Bitmap Size
Color Depth
Interlacing
Transparency
Palette

Dithering
Animation Delay
Animation Restore

Animation Loop
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Related Topics
Importing animated GIF files



Animated GIF Export Dialog Box - Animation Delay

This option sets the time delay between frames in the animation. The units are hundredths of a second, so if you want a delay of a
second between each frame, enter a value of 100. Remember that some browsers display the frames quite slowly and may not be
able to keep up with the value you set.

If you alter this setting, it will override any individual delays you have set for frames using the Bitmap Properties dialog box in the
Bitmap Gallery.



Animated GIF Export Dialog Box - Animation Loop

From these options you can select :

O+ The number of times the animation will repeat.
or
&+ The Loop Continuously option.



Animated GIF Export Dialog Box - Animation Restore

This sets what happens after each frame has been displayed, the Animated GIF Restore setting.

If you alter this setting, it will override any individual restore values you have set for frames using the Bitmap Properties dialog box
in the Bitmap Gallery.



Annotating clipart scrolls
For details on how to add your own text to the clipart scrolls on the Xara Ltd. web site, click the web link below.

Web Link
[ Annotating Clipart Scrolls



| g

Applying an object's color to another object

For details on how to take the color from one object in a drawing and apply to it to another object so they are exactly the same
color, click the web link below.

Web Link
| g Copying Color



O
Applying attributes to a selected region of text

By selecting a region of text inside a text object you can apply attributes to a small section of it. For example you could change the
point size of one word in a line of text.
| To apply attributes to a region of text

1. Select the text region (see Selecting text).

2. Apply the required attributes. For example, drag-and-drop a color from the Color Gallery or change the font size.

Tip
O+ If you drag-and-drop an attribute onto the selected region, it will only be applied to the selected region. Note that attributes
can be applied to the selected region by dragging and dropping the attribute onto the selected region.

Related Topics

Text Tool



Applying attributes to a whole text object

If you apply an attribute to a whole text object, it affects every character. If you want to apply text-specific attributes (like font size),
select the Text Tool first.

| To apply attributes to a whole text object
1. Select the text object (see Selecting text).

2. Apply the required attributes. For example; double-click a color in the Color Gallery or choose the Text Tool and change the font

size.
Tips
O+ If the text cursor is visible, press Escape to remove it. You can then apply attributes to the whole text object.
| You can apply attributes to a text object using drag-and-drop,. If you do this, you do not need to select the text object first.

For example you can change the color of text by dragging a color from the Color Gallery onto the text object.

Related Topics
Text Tool

Selecting objects



Applying attributes to individual text characters
You can easily apply attributes to a single character inside a text object.
G To apply attributes to a single character in a text object
1. Select the text character (see Selecting text).
2. Apply the attributes. For example, choose the Text Tool and change the font size or double-click on a color in the Color Gallery.
Tip
| You can also apply attributes to a single character by holding CTRL and using drag-and-drop. For example, dragging a

color from the Color Gallery and dropping it on a character whilst holding down CTRL will apply the color to one character rather
than the whole text object. See apply inside for more details on applying attributes inside objects.

Related Topics

Text Tool



Applying attributes to text

You can apply any attribute to a whole text object, a single character inside it or a selected region of it.
What do you want to do?

2 Apply attributes to a whole text object

B Apply attributes to a selected region of text

X Apply attributes to individual text characters

2 Apply attributes to the text cursor

[zl 29



Applying attributes to the text cursor

If attributes are applied when the text cursor is present in a text object, the attributes are applied to the text cursor and used for all
the text you type in that text object. When the text cursor is moved, it takes on the attributes of the character to its left.
&+ To apply attributes to the text cursor

1. Choose the Text Tool.
2. Insert the text cursor in the document.

3. Apply the attributes. For example, double-click on a color in the Color Gallery or choose a font size from the Infobar.

Tips
&+ If you want to change the attributes for all text objects you create in future, select the Text Tool (ensuring the text cursor is
not visible in the document) and set the attributes.
G+ You have to type something for the change of attribute to have any effect. Moving the cursor without typing discards the

change of attribute.



Applying bitmap fills

You can use any of the bitmaps in the Bitmap Gallery to fill an object. CorelXARA includes a Fill Tool for applying and manipulating
bitmap fills. Although Xara Webster does not include this tool, you can do some basic manipulation of fills, e.g. if you rotate an
object using the Selector Tool and press and release the ' - ' key on the number keypad during the drag, you can rotate, move,
scale and skew the shape and leave the bitmap fill unchanged. For more details on how to do this, see the web links below.

G+ To apply a bitmap fill
1. Select the object.
2. From the Utilities menu, choose Bitmap Gallery to open the gallery.
3. In the gallery click on the bitmap to be used as a fill. This selects it.
4. Click the Fill button in the gallery.

Tips
&+ If all the text you type is appearing filled with a bitmap, deselect all objects, choose the Text Tool, open the Color Editor,
ensure the Line/Fill button is pulled out and select the color you want your text to be.
O+ You can also double-click on a bitmap in the gallery to apply it to the selected object. (CTRL-double-click closes the
gallery afterwards.)
&+ You can also drag-and-drop a bitmap from the gallery onto any object, selected or unselected.
O+ To apply the bitmap fill to an object inside another object, hold down CTRL as you drop the bitmap (this is apply inside).
O+ If you want to apply a bitmap fill from the Clipart Gallery, drag the bitmap into your document and then drag it from the
Bitmap Gallery onto the object.

Web Links
| Using Bitmaps to Fill Objects
O

Related Topics
Bitmap Gallery

Selecting objects



Applying circular transparency

Circular transparency is one of the types of transparency you can use.
G To apply circular transparency

1. Select the object (see Selecting objects).

2. Choose the Transparency Tool.

3. Ensure the transparency is set to 'Flat'.

4. Move the slider to set the transparency for the center of the circle.

5. SHIFT-drag from where you want the center of the transparency to where you want the transparency to end.
6. You can now change the transparency of the outer edge of the circle.

Tips
| You can also choose Circular from the Transparency Shape drop-down list on the Transparency Tool Infobar.
&+ While you are dragging the transparency, you can press the Tab key to swap between two methods of transparency
rendering. One mode updates the transparency when you stop moving the mouse and the other updates the transparency as you
drag.
&+ After you have drawn the transparency, you can move the slider to change the transparency setting of one end. To change
the setting of the other end, just press tab and move the slider again.

Web Links
G+ Transparency
ca*

g Webster Movies - Transparency

Related Topics

Transparency Tool



Applying flat transparency

Flat transparency is one of the types of transparency you can use.
&+ To apply flat transparency

1. Select the object.

2. Choose the Transparency Tool.

3. If the object already has transparency applied, choose 'Flat' from the Transparency Shape drop-down list on the Transparency
Tool Infobar.

4. Drag the Transparency Slider on the Infobar to select the required level of transparency.

Tips
O Applying flat transparency to an object with an outline (or a line) also applies the transparency to the line. To remove the
line transparency, change the object's line color. See Coloring objects for details.
Web Links
&+ Transparency
Ca*
g Webster Movies - Transparency

Related Topics
Transparency Tool

Selecting objects



Applying linear transparency
Linear transparency is one of the types of transparency you can use.
G To apply linear transparency
1. Select the object (see Selecting objects).
2. Choose the Transparency Tool.
3. Ensure the transparency is set to 'Flat'.
4. Move the slider to set the start transparency.
5. Drag from where you want the transparency to start and release where you want it to end.
6. You can now change the end transparency by moving the slider.
Tips
| While you are dragging the transparency, you can press the Tab key to swap between two methods of transparency

rendering. One mode updates the transparency when you stop moving the mouse and the other updates the transparency as you
drag.

G+ After you have drawn the transparency, you can move the slider to change the transparency setting of one end. To change
the setting of the other end, just press tab and move the slider again.
Web Links
| Transparency
3
g Webster Movies - Transparency

Related Topics

Transparency Tool



Applying transparency

With the Transparency Tool you can make any object transparent using a wide range of types and shapes of transparency.

&+ Applying flat transparency
a3+ Applying linear transparency
[ Applying circular transparency

Web Links
| g Transparency
[

g Webster Movies - Transparency

Related Topics
Transparency Tool

Removing transparency



Arrange Control Bar

Bring to Front
Put to Back

Move Forwards

Move Backwards
Group

ungroup
Alignment

SEEAIE D

Related Topics
List of the Default Control Bars



Arrange Icons (Window Menu)

Arrange Icons arranges the icons of all minimized documents at the bottom left-hand corner of the main Xara Webster window.



Arrange Menu

3 B33 QJQ{[[

Bring To Front
Move Forwards

Move Backwards
Put To Back

Group
Ungroup
Alignment

Create Bitmap Col



Arrange Views (Window Menu)

Arrange Views tiles all the open document views to fill the main Xara Webster window.



BMP Export Dialog Box

The BMP (Windows Bitmap) export bitmap dialog box is opened by selecting BMP as the exported file format from the Export
dialog box. With it you can set the size/resolution of the exported bitmap, the area to be exported and the number of colors in the
bitmap. For details of how to create a BMP file, see Creating BMP files.

Bitmap Size and Resolution
Color Depth

Area to Save

Palette

Dithering

R334



Bitmap Export Dialog Box - Area to Save

The bitmap can be created using one of three areas of the document :

The Drawing This exports the entire drawing.
The Work Area The entire work area.

The Selection The area covered by the objects in the selection. Only available when objects are selected.



Bitmap Export Dialog Box - Bitmap Size

Enter the width and height of the bitmap here (in pixels).

Tip
| This bitmap format does not store the resolution information in the file, this is why the resolution drop-down list is dimmed.



Bitmap Export Dialog Box - Bitmap Size and Resolution

The size of the exported bitmap can be set in two ways :

Resolution Type the resolution into the dpi field. The Width and Height are calculated from this to ensure the aspect ratio of
the area being exported is fixed.
Size Type the required width or height into one of the fields. Note that the aspect ratio of the drawing is fixed so only
one dimension can be set - the other is calculated automatically.
Tip
&+

If you choose a resolution of 96dpi, the bitmap will be created at the same size as the objects when you use 100%
magnification.



Bitmap Export Dialog Box - Color Depth

You can create bitmaps with the following number of bits per pixel :

32 bit Millions of colors
24 bit Millions of colors
8 bit 256 colors

4 bit 16 colors

1 bit 2 colors

If you export a transparent bitmap, one of the colors will be used for the transparency. This means a 2 bit transparent bitmap has
only one 'spare’ color.

Some bitmap formats only support some of the color settings :

Name Supported Colors
GIF Compuserve GIF 1 bit, 4 bit and 8 bit.
BMP  Windows Bitmap 1 bit, 4 bit, 8 bit, 24 bit and 32 bit.
PNG 1 bit, 4 bit, 8 bit, 24 bit and 32 bit.
JPG JPEG 24-hit (effectively)

Remember that with GIF and PNG files, you can also set how many of the colors in the palette are used, so for example you can
create a 4-bit (16 color) bitmap where only 9 of the colors are used. By using less colors, the resultant files will usually be smaller.



Bitmap Export Dialog Box - Dithering

You can select between three types of dithering with these options. Choosing none means there will be no dithering, ordered using
an ordered (regular) dithering pattern and diffusion uses error-diffused dithering (a more complex dithering technique). In general,
error diffusion will give the best results, but remember to only use dithering when really necessary as it prevents the file
compression working so well and so makes files larger.

If you turn off dithering, you'll find the images contain perfectly flat areas of color, but where you have graduated color, you will

almost certainly see 'steps' because without dithering there aren't enough colors to accurately represent your drawing. you may
need to experiment to obtain the right effect.

You cannot use ordered dithering if you are using an optimized palette.



Bitmap Export Dialog Box - GIF Transparency

If transparency is enabled the bitmap will be ‘transparent' in all areas not covered by a selected object. If the selection has been
chosen then this will be only the visible and selected objects. This makes it easy to remove the white background from exported
pictures and makes them ideal for publication on the World Wide Web.

If the Quality setting is high (i.e. anti-aliasing is turned on) the edges of the drawing will be anti-aliased with whatever is behind it
(as normal). Normally the anti-aliasing will be to the paper color of white.

When transparency is enabled, the selected items are used to determine what is going to be transparent in the GIF, but all objects
are rendered. This makes it simple to create bitmaps which anti-alias to the background they will eventually be on, by placing that
background behind the drawing in Xara Webster. Then when the bitmap is exported ensure that the background is not selected but
the drawing is and that the selection option is used.

Note that if you create a transparent GIF file, one of the palette colors is used as the transparency. This means (for example) that a
2 color GIF contains one color and transparency.

Note that GIF transparency has a different meaning to Xara Webster transparency. This process does not take into account any
Xara Webster transparency applied to objects in the document.



Bitmap Export Dialog Box - Interlacing

If interlacing is enabled the bitmap file produced will be interlaced. Remember only PNG and GIF files can be interlaced.



Bitmap Export Dialog Box - JPEG Quality

This setting is specific to JPEG output. A low setting will result in a small file with a loss in quality whereas a high value will give
only slight file size reduction, but high quality. Note that a setting of 100% will still compress the file.
As an example, a setting of 75% will give good compression without causing a noticeable loss in quality for most uses.



Bitmap Export Dialog Box - Number of Colors in Palette

Number of Colors
With this field, you can specify how many colors in the palette of the bitmap are actually used. This means you can create, for

example, an 8 bit bitmap where only 100 of the 256 palette entries are used. With some experimentation you can alter this setting
to create bitmaps that are very small by reducing the number of colors until the quality is just at the level you will accept.

Add System Colors

Selecting this option adds 28 colors to the palette. These colors are the normal Windows system colors and a number of primary
colors. This ensures the palette includes a spread of colors and may improve the quality of the image, particularly if it contains a
wide range of colors. You may need to experiment with this option to get the best results.



Bitmap Export Dialog Box - Palette

You can use these options to choose between the browser palette and an optimized palette



Bitmap Export Dialog Boxes

Xara Webster can create bitmaps from the selected document and export them in a variety of different formats. The following list
contains links to all the pages describing the dialog boxes used for exporting bitmaps. If you want to know how to create bitmaps,
see Creating bitmaps.

JPEG Export dialog box

GIF Export dialog box
Animated GIF Export dialog box
PNG Export dialog box

BMP Export dialog box
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Related Topics
List of Supported File Formats



g
Bitmap Gallery (Utilities Menu)
E* Fl11
The Bitmap Gallery item on the Utilities menu and the Bitmap Gallery button open the Bitmap Gallery if it is closed and close it if it
is open. The button remains pressed in if the gallery is open.

Related Topics
Bitmap Gallery



Bitmap Gallery - Delete Button

Delete I

The Delete button in the Bitmap Gallery deletes the bitmaps selected in the gallery, from the document. This operation cannot be
undone, though Delete is generally unnecessary as unused bitmaps are automatically deleted when the document is closed or
saved. You can also delete a bitmap using the pop-up menu. You cannot delete the default bitmap (the Xara Ltd logo).

Related Topics

Bitmap Gallery



Bitmap Gallery - Fill Button

Fill |
The Fill button in the Bitmap Gallery applies the bitmap selected in the gallery as a bitmap fill to the selected objects. You can also
drag-and-drop the bitmap onto an object to apply it as a bitmap fill (CTRL-drag to apply inside) , double-click it to apply it to the
selection (CTRL-double-clicking closes the gallery afterwards) or right-click on the bitmap in the gallery to open the pop-up menu

and choose Apply As A Fill.

Related Topics
Bitmap Gallery



Bitmap Gallery - Insert Button

Inzert I

The Insert button in the Bitmap Gallery inserts the currently selected bitmap into the selected document. Any bitmap in the gallery
can be inserted into the selected document, even from other sections of the gallery. i.e. this button can be used to copy bitmaps
between documents.

You can also drag-and-drop the bitmap onto a blank part of the work area to insert it or open the pop-up menu over the bitmap and
choose Insert.

Related Topics
Bitmap Gallery



Bitmap Gallery - Options Button

The Options button in the Bitmap Gallery opens a menu containing the single option, Find. By selecting this option you can search
the Bitmap Gallery.

Related Topics
Searching a galler

Bitmap Gallery



Bitmap Gallery - Pop-up Menu

Right-clicking on the Bitmap Gallery opens a pop-up menu which contains the following options :

Insert Identical to the Insert Button.

Apply as Fill Identical to the Eill Button.

Delete Identical to the Delete Button.

Save Identical to the Save Button.

Properties Identical to the Properties Button
(Un)Fold Section Folds up or unfolds the current section.
Previous Section Moves to the start of the previous section.
Next Section Moves to the start of the next section.

Right-clicking on a bitmap in the gallery will select it, so opening the pop-up menu over a bitmap allows you to operate on it
directly.



Bitmap Gallery - Properties Button

PfDEE[tiES"'I

This button opens the Bitmap Properties dialog box which shows the properties of the bitmap. You can also use this dialog box to
set the Delay and Restore settings for the bitmap if you are using it as a frame in an animated GIF.



Bitmap Gallery - Save Button

Save.. I

The Save button in the Bitmap Gallery opens the Bitmap Export dialog box so you can save the selected bitmap in any of the

supported bitmap export formats (see the List of Supported File Formats). Note that you will not be able to alter the size
(resolution) or color depth (number of colors) of the bitmap when you export it.

For more information on the options in the save dialog box, click the Help button.
Tip

O+ To save a bitmap more quickly, right-click on it to open the pop-up menu (this also selects the bitmap) and choose Save.

Related Topics
Bitmap Gallery



g
Bitmap Gallery Overview
E* F11
The Bitmap Gallery shows all the bitmap objects that are currently being used in each of the loaded documents. You can use it to
look at the bitmaps in your drawing, insert copies, delete bitmaps and change settings before you create an animated GIF. The
gallery is divided into sections, one for each document currently open.

__ Insert | Insert Insert the bitmap into the selected document.
__ Delete | Delete Delete the bitmap from the document.
w Fill Fill the selected objects with the selected bitmap.

Options Bitmap Gallery options.
E Save Save the bitmap.

| Properties Alter the properties of the selected bitmap.

Many operations using the Bitmap Gallery are made easier by the Bitmap Gallery pop-up menu.

Note
If a bitmap is deleted from a document it will remain in the Bitmap Gallery until the document is closed or saved; to remove it from

the gallery, select it and click the Delete button.

Web Links
| g Using a Bitmap to Fill Objects
&+

| Webster Movies - Bitmaps
o+

Related Topics

Selecting items in a gallery
Galleries Overview

Applying bitmap fills



Bitmap Properties Dialog Box
This dialog box shows the following information about the bitmap :

Name

Format

Size (K)
Dimensions (Pixels)
Colors

Transparent

RRF33Y

GIF Animation

O+ Delay (the time this frame is left on screen)
O Restore



3* Bring To Front (Arrange Menu)
[3* CTRL+F

Moves all the selected objects to the front of the document. For more details, see Moving objects backwards and forwards.



Cascade (Window Menu)

Cascade shows all the open document views stacked on top of each other along a diagonal line.



Changing an object's fill color
You can easily change the color of the center of objects.
G To change an object’s fill color
1. Select the object (see Selecting objects).
2. From the Utilities menu, choose Color Editor.
3. Ensure the Fill/Line button is pulled out.
4. Choose the color you want or click the 'no color' button to make the line or outline invisible.

After you have chosen a color, you can click the Browser Palette button in the Color Editor to change the color to the nearest web
browser color that will not be dithered when it's shown on screen by a web browser. If you do this, your objects will look far
smoother in 256 color modes.

Tips

There are several other ways of changing the fill color which you may prefer to use :
G+ Drag-and-drop a color from the Color Gallery onto any object (selected or unselected).
&+ Select the object and double-click on a color in the Color Gallery or select the object, select the color in the Color Gallery
and click the Apply button in the gallery.
| To remove the fill color of an object (to make it hollow), apply ‘No Color' (the hatched square in the Color Editor) to the
object.
&+ If the object is inside another object (for example, as part of a group), hold down CTRL and drag-and-drop one of the two
color swatches from the Color Editor or a color from the Color Gallery. See Apply inside.

When you drag a color, the pointer shows what will happen if you drop it :

O
[% The color will be applied as a (flat) fill color.

&

I
%";ﬁ
The color will be used for objects you draw in future.

Web Link
3+ Webster Movies - Color
&+

The color will be applied as a line color.

Related Topics

Changing an object's line color
Colors Overview

Color Gallery
Color Editor



Changing an object's line color

You can easily change the color of any line including the outline around objects. You can also use 'no color' to make a line or
outline invisible.
| To change an object's line color

1. Select the object (see Selecting objects).

2. From the Utilities menu, choose Color Editor.

3. Ensure the Fill/Line button is pressed in.

4. Choose the color you want or click the 'no color' button to make the line or outline invisible.

After you have chosen a color, you can click the Browser Palette button in the Color Editor to change the color to the nearest web
browser color that will not be dithered when it's shown on screen by a web browser. If you do this, your objects will look far
smoother in 256 color modes.

Tips
There are several other ways of changing the line color which you may prefer to use:
&+ Drag-and-drop a color from the Color Gallery onto the edge of any object. You do not need to select the object first.
O+ Select the object, select the color in the Color Gallery and then CTRL-click on the Apply button in the gallery.
G+ If the object is inside another object (for example, as part of a group), hold down CTRL and drag-and-drop from the Color

Gallery. See Apply inside.
When you drag a color, the pointer shows what will happen if you drop it :

&

|
The color will be applied as a line color.
[%D
The color will be applied as a (flat) fill color.

i
[% The color will be used for colors you draw in future.

Web Link
| Webster Movies - Color
o+

Related Topics

Changing an object's fill color
Colors Overview

Color Gallery



Changing bitmap palettes

To find out how to change the colors in bitmaps, for example creating black and white images from colors ones, click the web link
below.

Web Links
| g Changing Bitmap Palettes

[
g Creating Bitmaps from Objects
[ Webster Movies - Bitmaps



O
Changing line thicknesses

You can change the thickness of lines and outlines of shapes and text. This changes the thickness of the entire line; you cannot
change the thickness of just a part of a line.
| To change the line thickness

1. Select the object (see Selecting objects).
2. Do one of the following :

O+ Select a thickness from the drop-down list on the control bars.
O+ Type a thickness into the field on the control bars (for example "2cm" or "0.1in") and press RETURN.
Tip
&+ If you want to make a line invisible, set its color to No color. (See Changing an object's line color.) This is better than
setting the line to zero width. For the reasons why, see Zero Width Lines Overview.
Web Link

=+ Webster Movies - The Basics



| g

Changing text font

Once you have created a text object, you can change the font used by all of it or part of it. If you want to create a new text object
using a particular font, just place the text cursor in the document and choose the font from the Text Tool Infobar.
O+ To change text font

1. Select the text you want to change (see Selecting text).

2. Choose the Text Tool.

3. Select the font from the drop-down list on the Infobar.

Tip
O+ The symbol on the left of the font name in the font drop-down list shows whether the font is a TrueType font or an ATM
(PostScript) font.

Web Link
a3+ Webster Movies - Text
&+

Related Topics

Text Tool



Changing the baseline shift of text

Once you have created a text object, you can change the vertical position (baseline) of any piece of text inside the text object. If
you want to create a new text object using a specific baseline shift, just place the text cursor in the document and set the baseline
shift on the Text Tool Infobar.

O+ To change the baseline shift
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.

3. Click the buttons on the Line Spacing control on the right hand side of the Text Tool Infobar.

Tips
O+ You can also set the line spacing by typing a value into the line spacing field and pressing RETURN.
O+ You can enter values using any unit, for example you can enter '4pt' or '2cm'. If you type a value with no units, it uses the
text units. For more details, see the Units Overview.
Web Link
| Webster Movies - Text
O

Related Topics

Text Tool



Changing the color of clipart buttons
For details on how to change the color of the clipart buttons on the Xara Ltd. web site, click the web link below.

Web Link
[ Changing the Color of Clipart Buttons



| g

Changing the color of clipart dividers

Xara Webster's clipart includes some dividers to place between sections of your web pages. To find out how to change their color
easily using Xara Webster's connected colors, click the web link below.

Web Link
| g Changing the Color of Clipart Dividers



O
Changing the colors in clipart

When you import clipart from the web, much of it uses connected colors. This means you can use the Color Gallery to edit all the
different shades of a color in one simple operation. For example, you can load an image of a button and change the color of the
whole button in a few mouse clicks without needing to change the color of all the individual parts of the drawing.

| To change the colors in clipart
1. Import the clipart (see Importing web clipart).
2. From the Utilities menu, choose Color Gallery.
3. Find the section of the gallery for the drawing you have imported and make sure it's open.
4. To change one of the connected colors listed, click on it to select it and click the Edit button in the gallery.
You can now change the color and see how the whole drawing changes. For more information on clipart using connected colors,
click the web link below.

Tip
&+ You can also drag colors from the Color Gallery onto the Color Editor to change them.
Web Link

[ Clipart Using Connected Colors



O
Changing the constrain angle

When you move, rotate and skew objects or move handles, you can use the CTRL key to constrain the angle of movement.
&+ To change the constrain angle
1. From the Utilities Menu, choose Options.

2. Click the General tab.
3. In the Angle Constraint section, choose a value from the drop-down list.

Tip
O+ If the value you want is not listed, type the value (in degrees) into the field and press RETURN.

Related Topics

Options



Changing the duplication distance

Duplicate creates a copy of the selected objects which is offset from the original object. The horizontal and vertical offset can be

changed.
| To change the duplication distance

1. From the Utilities Menu, choose Options.
2. Click the General tab.
3. Enter the horizontal distance in the X field (positive values move it to the right).

4. Enter the vertical distance in the Y field (positive values move it up).

Related Topics
Options

Duplicate



Changing the grid spacing

Grids consist of lines of major grid points spaced a specific distance apart. Between these major grid points are a number of
subdivisions. For example, you might have a grid with a spacing of 1cm, but with subdivisions of 1mm. Major grid points are
marked on the work area as crosses whereas subdivisions are marked as small points.

O+ To change the grid spacing

1. From the Utilities Menu, choose Options.

2. Click the Grid tab.

3. Enter the major spacing value.

4. Enter the number of subdivisions between the major grid points.

Tips
| You can type values into the Major Spacing Field using any units, e.g. '2cm’, '4in'. See the Units Overview.
&+ If you zoom out from a document, some of the subdivisions will not be shown if they are very close together.
O+ If you do not see the grid, you need to turn it on. See Displaying the grid.

Related Topics

Options



Changing the nudge size

You can change the distance objects move when you nudge them.
&+ To change the nudge distance

1. From the Utilities Menu, choose Options.

2. Click the General tab.

3. Enter a nudge distance in the Nudge Size field.

Tip
&+ You can enter the nudge distance using any units, see the Units Overview.

Related Topics
Options

Nudging objects



Changing the screen quality of documents

You can change the way a document appears on screen by altering the screen quality setting.

il

0
-I Outline On this setting, no solid colors shown - only outlines even for bitmaps and objects with no outline color). If the Quality
slider is moved to a fraction above outline bitmaps are shown in full.

5
ol SimpleOn this setting, graduated fills are shown in flat color, anti-aliasing is not used and lines are all shown one pixel wide.

1

Dll NormalOn this setting all detail is shown, but anti-aliasing is not used.

11
I- Anti-aliased On this quality setting all edges are anti-aliased to reduce on-screen jaggies and graduated fills are shown with 256
steps.

O+ To change the quality setting

Drag the quality slider on the control bars.

Tips
&+ You can also change the Quality setting using the Quality submenu on the Window menu or by right-clicking on the
document work area to open the pop-up menu.
| If you want to edit in outlines but see still bitmaps, drag the quality slider so it is a tiny amount to the right of the outline
setting.
| The Quality setting defines how bitmaps are exported from Xara Webster as well as how they appear on the screen. See
Creating bitmaps.

Web Link

| g Screen Display Quality
&+
[ Webster Movies - The Basics



| g

Changing the size of text

Once you have created a text object, you can change the size of all the characters in it or just some of them. If you want to create
a new text object using a particular font size, place the text cursor in the document and choose the font size from the Text Tool
Infobar.

O To change text size

1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Select the font size from the drop-down list on the Infobar.

Tips
&+ You can also change the size of whole text objects using the Selector Tool. See Scaling objects.
O+ You can type any value into the field on the Infobar using any of the units available, e.g. '1cm' or '100pt' (see the Units

Overview). Remember to press RETURN after you have typed in the size.

Related Topics

Text Tool



Changing the spacing between lines of text

Once you have created a text object, you can change the spacing between the lines of text. If you want to create a new text object
using a specific line spacing, just place the text cursor in the document and set the line spacing on the Text Tool Infobar. Line
Spacing is displayed as a percentage of the character size. '100%' spaces the lines as closely as possible without lines coming
into contact; "200%" is double-spaced text.

g To change the line spacing of text
1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.

3. Click the buttons on the Line Spacing control on the right hand side of the Text Tool Infobar.

Tips
g If you only select part of a line, changing the line spacing will affect the whole line.
G+ You can also set the line spacing by typing a value into the line spacing field and pressing RETURN.
&+ You can enter a value as a percentage of the size of the largest character in the line or an absolute value using any unit,
for example you can enter '4pt' or '2cm’ (see the Units Overview).
Web Link
G+ Webster Movies - Text
3

Related Topics

Text Tool



Changing the way galleries look

You can change the way in which information is displayed in the Clipart Gallery
&+ To change the way galleries look

1. Open the gallery from the Utilities menu.

2. Click the Options button on the gallery.

3. Choose Properties to open the Gallery Properties dialog box.

4. Choose the required display format from the drop-down list in the gallery.

Related Topics

Galleries Overview



Changing the work area size

With Xara Webster you can produce drawings of virtually any size.
G To change the work area size

1. From the Utilities menu, choose Options.

2. Click on the Work Area tab.

3. Enter the width and height of your drawing in pixels.

Tip
G You can enter the width and height in any units supported by Xara Webster. For more information, see the Units
Overview.

Related Topic
Options



Eﬁ Clear Selection (Edit Menu)
3* ESC (Escape)
Clear Selection deselects all selected objects. This can be useful to :

O+ See the document without any handles visible.
G+ Reset the transformation center.

Related Topics
Deselecting all objects



B
il Clipart Gallery (Utilities Menu)
#* SHIFT+F10

The Clipart Gallery item on the Utilities menu and the Clipart Gallery button on the control bars open the Clipart Gallery if it is
closed and close it if it is open. The button remains pressed in if the gallery is open. For details of the Clipart Gallery, see Clipart

Gallery.



Clipart Gallery - Disc Clipart Button

The Disc Clipart button in the Clipart Gallery opens a dialog box which you can use to choose a folder to add to the gallery or
update an existing folder. See Adding clipart to the clipart gallery for more details.

Related Topics
Adding titles, descriptions and keywords to documents

Clipart Galler:



Clipart Gallery - Get Clipart

Clicking this button connects to the Xara Ltd. web site on and Internet and adds (or updates) the web clipart in the Clipart Gallery.

Tips
O+ If you find the window that appears when you download clipart is getting in your way, just minimize it. When it opens in
future, it will stay minimized so you can see the clipart being downloaded but it won't be so visible.
o+ If this button does not function, have a look at Web Links and Web Clipart.



Clipart Gallery - Import Button
Impart |

The Import button in the Clipart Gallery imports the selected image into the selected document. You can also import a clipart file by
dragging it from the Clipart Gallery and dropping it on a document.

Related Topics
Clipart Gallery



Clipart Gallery - Open Button

DEEH I

The Open button in the Clipart Gallery opens a new document and imports the selected picture into it. You can also open a clipart
file by double-clicking on it in the gallery (CTRL-double-click to close the gallery afterwards).

Related Topics
Clipart Gallery



Clipart Gallery - Options Button

aptians.. |

Clicking the Options button in the Clipart Gallery opens a menu containing the following options :

O+ Disc Clipart Add a folder of your own clipart to the Clipart Gallery.

O+ Remove Web Folders Remove all the web folders (click the Web Clipart button to put them back) from
the Clipart Gallery.

O+ Eind Search the Clipart Gallery.

&+ Sort Sort the Clipart Gallery.

&+ Icons Size Size of the images shown in the gallery.

Related Topics
Clipart Gallery



Clipart Gallery - Pop-up Menu

Right-clicking on the Clipart Gallery opens a pop-up menu which contains the following options :

Open Identical to the Open button.

Import Identical to the Import button.

Remove Section Identical to the Remove button.

(Un)Fold Section Folds up or unfolds the current section.
Previous Section Moves to the start of the previous section.
Next Section Moves to the start of the next section.

Note
When you right-click in the gallery to open the pop-up menu the picture under the mouse pointer will be selected, so using the pop-

up menu is a quick way to select a picture and operate on it in one go.

Related Topics
Clipart Galler



Clipart Gallery - Remove Button

Femoe I

The Remove button in the Clipart Gallery removes the selected sections from the Clipart Gallery. You will be asked to confirm the
operation. You can add your own clipart again or clipart from the Xara Webster CD using the Disc Clipart button. See Adding
clipart to the clipart gallery. To add the web clipart, click the Get Clipart button (see Importing web clipart).

To select multiple sections, CTRL-click on each to select several or click on the first and SHIFT-click on the last to select them all.

Related Topics
Clipart Galler



B
il Clipart Gallery Overview

3 SHIFT+F10

DEEH I
|ITIEIZI[t I
Get CIiE&rt---l
DEtil:lnS--- I

Open
Import

Get Clipart
Remove
Disc Clipart
Options

Open a new file.

Import a file into the document

Add/update the web clipart listing

Remove the selected sections from the gallery.
Add your own clipart to the gallery

Clipart Gallery Options

You can also access some of these items using the Clipart Gallery pop-up menu.

Display Options

&+ Large Icons
a3+ Full Information
=+ Small Icons

Related Topics

Selecting items in a gallery
Finding clipart

Galleries Overview



Clipart using connected colors
For details on how to quickly change the colors in Xara Webster clipart using Xara's connected colors, click the web link below.

Web Link
[ Clipart Using Connected Colors



| i

lE' Clone (Edit Menu)

E* CTRL+K
Clone creates a copy of the selection. and places it in the document in the same place as the original. Unlike Duplicate, no offset is
used. For more details, see Copying objects.

Tip
O You can remember the key shortcut by thinking of Clone as 'Klone'!



L3
£a Close (File Menu)

Close on the File menu closes the selected document and all views onto it. If you attempt to close a document which has been
altered but not saved Xara Webster will ask whether the document should be saved or not before closing it.

If you have multiple views open for a single document, one of the views can be closed using Close on the document control menu.
Alternatively, double click on the application control button (the top-left corner of the document window).

If you are editing a drawing which is embedded in a document in another program, this menu item will read "Close and Update
DocumentX" where DocumentX is the document you are editing in the other program. Selecting this item will close the document
and return you to the other program.



Closing a gallery

Click on the icon in the top right-hand corner of the gallery or alternatively, when a gallery is open, its button on the control bars is
pressed in - clicking the button closes the gallery.

Web Link
g Webster Movies - Control Bars and Galleries

Related Topics
Galleries Overview



3 Color Editor (Utilities Menu)

The Color Editor is used to edit the color of objects and to change the colors in clipart that uses connected colors to change the
color of whole pieces of clipart in one easy action. You can use the Color editor in either of two color models, HSV and RGB. For
information about colors in Xara Webster, see the Colors Overview.

3* CTRL+E (to open and close)
You can open the Color Editor by :

O+ Selecting Color Editor from the Utilities menu.
&+ Selecting the Edit button in the Color Gallery.
O+ Selecting Color Editor from the pop-up menu when you right-click on an object.

You can use the Color Editor to Change the colors in clipart and to Color objects.

Browser Palette

Browser palette
When you create images for the web, many people will look at them using a 256 color screen mode. In this mode web browsers
use dithering to try and simulate more colors on the screen. This can mean you get a dotted pattern effect as the browser tries to
create the exact color you have chosen. However, there are 216 colors you can use which are guaranteed not to be dithered by
Netscape Navigator and Microsoft Internet Explorer and so appear perfectly smooth on the screen. To use one of these colors,
choose the color you want in the Color Editor as normal and then click this button. The color will change to the nearest of the 216
smooth colors. All 216 colors are also in the Color Gallery so you can drag and drop them straight onto your objects.
If you use transparency or import clipart that uses graduated fills or other more complex objects that generate new colors when
they are shown on the screen, colors may be dithered.

No Color
With this button you can set the color of an object or its outline to 'no color' so it disappears. Click it just like you would select a
color in the Color Editor normally.

FilllLine Color

5
When you are changing the color of selected objects this button sets whether the color you choose changes the fill color of the
selected objects or their outline. To change the outline color of the objects, make sure this button is pressed in.

Show Menu
-

Clicking this button opens the Color Editor Menu so you can choose the way you want to edit colors (for more information on this,
click the web link below). You can also open the menu by right-clicking on the Color Editor.

Color Swatches

In the top-right corner of the color editing area are two color swatches; the lower one shows the edited color and the upper one
shows the color as it was before you changed it. Either of the swatches can be drag-and-dropped onto objects to apply them.
When you first open the Editor, both swatches are the same color.

Web Links
| g Color Editor
&+
a3+ Copying Color
&+
| g Webster Movies - Color
&+

Related Topics

Color Gallery
Importing colors and palettes

Copying color to another object



Color Editor Menu
-

The Color Editor menu, opened using the Menu button in the Color Editor or right-clicking on it, contains the following options :

HSV Selects the HSV color model.
RGB Selects the RGB color model.
Help Opens the Xara Webster documentation on the Color Editor.

Related Topics
Color Editor



ﬂl Color Gallery (Utilities Menu)
C3* F9

The Color Gallery item on the Utilities menu and the Color Gallery button on the control bars open the Color Gallery if it is closed
and close it if it is open. The button remains pressed in if the gallery is open. For details, see Color Gallery.



Color Gallery - Apply Button
Appl

The Apply button in the Color Gallery applies the color selected in the gallery as a flat fill color to the selection. Double clicking on
a color in the gallery has the same effect. CTRL+double-clicking on a color in the gallery will apply the color to the selection as a
line color. For more details, see Coloring objects.

Related Topics
Color Gallery



Color Gallery - Edit Button

The Edit button in the Color Gallery opens the Color Editor so you can change the connected color which is currently selected in
the gallery. Alternatively, you can right-click on the color in the gallery to open the pop-up menu and choose Edit.

Related Topics
Color Gallery
Color Editor



Color Gallery - Options Button

options.. I

The Options button in the Color Gallery opens a menu containing the following options :

O+ Find Search the Color Gallery
&+ Sort Sort the Color Gallery
&+ Icon Size Alter the way the colors are displayed in the Color Gallery.

Related Topics
Color Gallery



Color Gallery - Pop-up Menu

Right-clicking on the Color Gallery opens the pop-up menu which contains the following options :

Edit Opens the Color Editor, see Edit above.

(Un)Fold Section Folds up or unfolds the current section.

Previous Section Moves to the start of the previous section.

Next Section Moves to the start of the next section.
Note

When you right-click on a color the color is selected and the pop-up menu opens, so this is a quick and easy way to select a color
and operate on it.



3* Color Gallery Overview
3 F9
The Color Gallery lists :

| All the connected colors in clipart you have loaded (see Changing the colors in clipart for more details).
| A set of Web Browser Colors which will not be dithered when shown in 256 color modes.

O Any color palettes you have added (see Importing colors and palettes).

For information about colors in Xara Webster, see the Colors Overview.

Apply |
Options-_|

Web Browser Colors

Applying a color to objects
Edit Change a color
Color Gallery options

In the Color Gallery is a library of 216 colors designed for use on the World Wide Web. You can't change the colors in this section.
To use them, just drag them into the gallery section for your document or apply them to objects in your document. If you just use
the Web Browser colors, your images will not be dithered when they are displayed on the screen by a web browser and so the
images will appear very sharp. If you overlay transparent objects, you are creating new colors, so the image may be dithered.

If you have colored an object using the Color Editor, you can set its color to the nearest web browser color by selecting the object

and clicking the Browser Palette button in the Color Editor.

Color Gallery Menu
You can right-click on the Color Gallery to open a pop-up menu.

Display Options

G+ Full information (color swatch, name and 'Not in use")
G Small Icons (color swatch and name only)
O+ Icons Only (color swatch only)
Web Links
g Importing Colors and Palettes
Ca* Webster Movies - Color
O+

Related Topics
Coloring objects

Changing the way galleries look
Color Editor

Reordering gallery items
Searching a galler



Coloring objects

When you want to color an object, there is more than one way to do it. You can use the Color Editor to create a specific color, or
you can choose a color from the Web Browser Colors in the Color Gallery.

What do you want to do?

[ Change an obiject's fill color
| g Change an object's line color

Web Link
| g Webster Movies - Color
=+

Related Topics

Copying color to another object
Color Editor

Color Gallery



Colors Overview

Xara Webster has three types of colors:

Local Colors - created using the Color Editor. Each local color is a separate color and is used in only one place. Editing a local
color does not affect any other color in the drawing. For more details, see Coloring objects.

Pre-defined Colors - selected from Web Browser Colors in the Color Gallery. These colors match the 216 colors in the Netscape
Navigator and Microsoft Internet Explorer palettes and so are ideal for creating Internet graphics. You cannot change pre-defined
colors. Loading a pre-defined color into the Color Editor and editing it creates a local color. You can import palette files

(\ACO, .ACT, .CPL, & .PAL formats) into Webster to increase the range of pre-defined colors (see Importing colors and palettes).

Imported Colors - CorelXARA lets you create a range of colors based on a single 'parent' color. Editing the parent changes all
colors based on it.

Importing an image containing such colors into Webster displays the parent color in the Color Gallery. You can then edit the
parent color by selecting it in the Color Gallery and then clicking Edit in the Color Gallery. All colors based on that parent change
as you edit the parent.

Most of the buttons, bullets, page dividers and scrolls supplied in the Clipart Gallery use parent colors. This makes it easy, for
example, to import several buttons and change them all to a different color. For more information on recoloring clipart see

Changing the color of clipart.

Web Link
&+ Webster Movies - Color
[

Related Topics
Color Gallery

Color Editor



Configuring a web server for Xara files
To find out how to place Xara .web files on web pages (in HTML) click the web link below.

Web Link
| g Configuring a Web Server for Xara Files



O
Xara Webster Help Contents

The xaraweb.cnt file in your Xara Webster directory seems to have been deleted. To bring Xara Webster's Help Contents and
Index back, you will need to reinstall this file. The easiest way to do this is to reinstall Xara Webster.



Control Bar Customization

You can customize Xara Webster's control bars any way you choose. You can move the bars, resize them, turn them on and off

and even create new bars. You can also add and remove buttons from the bars and choose between large and small buttons. For
details on how to customize your bars, click the Web Link below.

Web Links
g Control Bar Customization

| g Webster Movies - Control Bars and Galleries



O
Control Bars (Window Menu)

You can use the Control Bars dialog box to customize the control bars. For more details, see Control Bar Customization.
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Control Bars Dialog Box - Delete Button

This button deletes the selected control bar. You will be asked to confirm deletion of the control bar. Note that you cannot delete
the Infobar or the Button Palette.



Control Bars Dialog Box - Large Buttons

The icons used for the buttons on the control bars and galleries can be set to small icons or larger icons. The bottom part of the
dialog box describes what sizes the icons on control bars at the top, left, right and bottom of the window are set to as well as the
size of icons in floating control bars. The setting for the size of buttons on floating bars is also applied to gallery buttons. For more
details, see Control bar customization.



Control Bars Dialog Box - New Button

This button opens a dialog box which will prompt for the name of a new control bar. Entering a new name and clicking the OK
button will create a new control bar with the given name. The new control bar will be opened, floating.



Control Bars Dialog Box - Reset Button

This button resets the control bars to their 'factory' settings. It will remove all the buttons and bars you have added and replace any
you have removed.



Copy (Edit Menu)

3* CTRL+C or CTRL+INSERT
Copies the selection to the clipboard. Once the objects are on the clipboard they can be pasted back into the document any
number of times, pasted into other documents and into other programs. For more information, see Cutting and copying objects to

the clipboard.

Tips
O+ You can copy an object to the clipboard quickly by right-clicking on it to open the pop-up menu and choosing Copy.
| Cut is the same as Copy, but moves the objects to the clipboard removing them from the document.

Related Topics

Pasting objects from the clipboard



Copying objects

There are several ways of creating a copy of an object. Which method you use depends on what you want to do with the copy.

&+ Copy to the clipboard then paste back. This lets you easily copy objects between documents. The object remains on the
clipboard and you can paste it several times if required.

G+ Create a duplicate (a copy slightly offset from the original). This is a quick way to create a copy in the same document.
You can change the duplicate offset. See Changing the duplication distance.

O+ Create a clone (a copy exactly on top of the original).

G+ To copy an object using Copy and Paste

1. Select the object (see Selecting objects).
2. From the Edit menu, choose Copy (CTRL+C).
3. If required, change document.

4. From the Edit menu, choose Paste (CTRL+V). This pastes a copy into the center of the window.
&+ To copy an object using Duplicate

1. Select the object.

2. From the Edit menu, choose Duplicate (CTRL+D).
| To copy an object using Clone

1. Select the object.

2. From the Edit menu, choose Clone (CTRL+K).
G+ To copy an object using the mouse

1. Choose the Selector Tool.
2. Drag to move, rotate, skew or scale the object.
3. Right-click where you want to leave a copy (or press '+' on the number keypad). For more details, click the web links below.

Web Links
Rotating Objects

Skewing Objects

Scaling Objects
Webster Movies - The Basics

ps
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Instead of using CTRL+V you can press CTRL+SHIFT+V to paste the copy into the same position as the original. This is
useful when moving objects between documents.
You cannot clone or duplicate objects selected using select inside. This includes selected regions within text objects.

q

Related Topics
Moving objects

Deleting objects



Create Bitmap Copy (Arrange Menu)

#* CTRL+SHIFT+C
Create Bitmap Copy creates a bitmap version of the selected objects. When you select it, it opens the Create Bitmap Copy dialog
box where you can set the options for the bitmap. Click the Create button to create the bitmap. By using the Transparent

Background option you can create non-rectangular bitmaps. For more information on creating bitmaps from objects, see Creating
bitmaps from objects.

Bitmap Size and Resolution
Color Depth

Palette

Dithering

Background

Number of Colors in Palette

eb Link
Creating Bitmaps from Objects
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O
Create Bitmap Copy - Background

If you set the Transparent option, any areas of the bitmap not covered by objects will be see-through. This will generally mean your
bitmap is not rectangular. Only objects with no fill color will appear see-through, objects with transparency applied will not be see-

through in the bitmap.

Tip
G You can apply transparency to any bitmap, even if it does not have a background.

Related Topics
Create Bitmap Copy



Create Bitmap Copy - Bitmap Size and Resolution

These two fields set the resolution (size) of the created bitmap. If you choose 96dpi, the bitmap will be the same resolution as it
appears on screen if you look at it at 100% magnification. Either choose a resolution from the drop-down list or type a width or

height into the fields.

Related Topics
Create Bitmap Copy



Create Bitmap Copy - Color Depth

When you create a bitmap copy of objects, you can choose the number of colors in the bitmap :

Bits Colors

24 Millions of colors
8 256 colors

4 16 colors

1 2 colors

If you create a transparent bitmap, one of the colors will be used for the transparency. This means a 2 bit transparent bitmap has
only one 'spare’ color.

Remember that when you create a bitmap, you can set how many of the colors in the palette are used, so for example you can
create a 4-bit (16 color) bitmap where only 9 of the colors are used. By using less colors, the resultant files will usually be smaller.
this is most useful when you are creating bitmaps to use as frames in an animated GIF (see Creating animated GIF files).
Related Topics

Create Bitmap Copy



Create Bitmap Copy - Dithering

When you create a bitmap from objects, you can select between three types of dithering. Choosing None means there will be no
dithering, Ordered using an ordered (regular) dithering pattern and Diffusion uses error-diffused dithering (a more complex
dithering technique). In general, error diffusion will give the best quality bitmaps. You cannot use ordered dithering if you are using
an optimized palette.

Related Topics
Create Bitmap Copy



Create Bitmap Copy - Number of Colors in Palette

Number of Colors
With this field, you can specify how many colors in the palette of the bitmap are actually used. This means you can create, for

example, an 8 bit bitmap where only 100 of the 256 palette entries are used. With some experimentation you can alter this setting
to create bitmaps that are very small by reducing the number of colors until the quality is just at the level you will accept.

Add System Colors

Selecting this option adds 28 colors to the palette. These colors are the normal Windows system colors and a number of primary
colors. This ensures the palette includes a spread of colors and may improve the quality of the image, particularly if it contains a
wide range of colors. You may need to experiment with this option to get the best results.



Create Bitmap Copy - Palette

These options set whether the bitmap has the standard document palette or an optimized palette.
Related Topics

Create Bitmap Copy



Creating BMP files

BMP (Windows bitmap) format files can be used by many programs on the PC. Note that when exporting a bitmap, the current
Xara Webster Quality (see Changing the screen quality of documents) setting is used. For example with Quality set to a low value,
the bitmap is exported as outlines.

O+ To create a BMP file

1. From the File menu, choose Export.

2. In the Export dialog box, choose Windows Bitmap (BMP) from the drop-down list.

3. Enter the filename and location then click Save. This opens the BMP Export dialog box.

4. Set the options in the dialog box and click Export. For more information on these options, click the Help button in the dialog box.

Tips
| To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the BMP Export dialog
box.
O+ If you want to export a small area of a document, select the objects in that area and choose the "Selection" option in the

Area to Save section of the BMP Export dialog box.
Related Topics

Creating bitmaps



Creating GIF files

You can create GIF format bitmap files using a wide variety of options including interlacing and transparency (masking). Note that
when exporting a bitmap, the current Xara Webster Quality (see Changing the screen quality of documents) setting is used for the
bitmap. For example if the Quality is set to a very low level the bitmap exported will be in outline only. For information in addition to
this page including how to get your bitmaps blending perfectly onto web page backgrounds, click the web link below.

This covers creating a single GIF bitmap. For information on animated GIFs, see Creating animated GIF files.
i To create a GIF file

1. From the File menu, choose Export.

2. In the Export dialog box, choose GIF from the drop-down list.

3. Enter the filename and location and click Save. This will open the GIF Export dialog box.

4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box or
click the web link below.

Tips
&+ To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the GIF Export dialog
box.
&+ To make the bitmap see-through where there are no objects in your document, select the Transparent option in the GIF
Export dialog box.
G+ If you want to export a small area of a document, select the objects in that area and choose the "Selection" option in the
Area to Save section of the GIF Export dialog box.

Web Links

&+ Creating GIF Files
&+

Related Topics

Creating bitmaps



Creating JPEG files

You can create JPEG format bitmap files using a wide variety of options. JPEG files are stored using compression which works
best with photographic-type images. You may want to experiment with the JPEG quality setting to find a level that creates the files
you want.

Note that when exporting a bitmap, the current Xara Webster Quality (see Changing the screen guality of documents) setting is
used. For example if the Quality is set to a very low level the bitmap exported will be in outline only (do not confuse this Quality
setting with the JPEG Quality).

O+ To create a JPEG file

1. From the File menu, choose Export.

2. In the Export dialog box, choose JPEG from the drop-down list.

3. Enter the filename and location and click Save. This will open the JPEG Export dialog box.

4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
&+ To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the JPEG Export dialog
box.
| If you set the JPEG quality slider to a low value the picture will not look as good but the file will be smaller.
G If you want to export a small area of a document, select the objects in that area and choose the "Selection" option in the
Area to Save section of the JPEG Export dialog box.
Web Link
&+ Creating JPEG Files
O

Related Topics

Creating bitmaps



Creating PNG files

You can create PNG format bitmap files using a wide variety of options including interlacing and transparency (masking). Note that
when exporting a bitmap, the current Xara Webster Quality (see Changing the screen quality of documents) setting is used for the
bitmap. For example if the Quality is set to a very low level the bitmap exported will be in outline only.

O+ To create a PNG file

1. From the File menu, choose Export.

2. In the Export dialog box, choose PNG from the drop-down list.

3. Enter the filename and location and click Save. This will open the PNG Export dialog box.

4. Set the options in the dialog box and click Export. For more information on the options, click the Help button in the dialog box.

Tips
| To export a bitmap the same size as it is on the screen (at 100% magnification) choose 96dpi in the PNG Export dialog
box.
O+ To make the bitmap see-through where there are no objects in your document, select the Transparent option in the PNG
Export dialog box.
O If you want to export a small area of a document, select the objects in that area and choose the "Selection" option in the

Area to Save section of the PNG Export dialog box.



Creating Xara Web files

Using Xara Webster, you can easily create images that look great on web pages. You can either put the image on the page as
a .web file so people with the Xara plugin can zoom in and out of the image just like you can in Webster itself or you can create a
bitmap of the drawing (see Creating bitmaps) which anyone can see even if they don't have the Xara plugin.

O+ To create a Xara Web file

1. From the File menu, choose Save.
2. Enter the location and name for the file and click Save.
3. In the Xara Web dialog box, set the options. Click the Help button for more information on what they mean.

For more details on creating .web files or on the format itself, click one of the Web links below.

Web Links
&+ Creating Xara Web Files
&+

| g Xara Web Format



| g

Creating a bitmap button
For step by step details on how to create a bitmap button using Xara Webster, click the web link below.

Web Link
a3+ Creating a Button Bitmap



| g

Creating animated GIF files

To create an animated GIF file you draw each frame and create a bitmap from the drawing. When you have created all the
bitmaps, you can change their order in the Bitmap Gallery and then export the animated GIF file. For information on creating GIFs
for the Internet, see the web links below.

o To create an animated GIF
1. Draw what you want to appear in the first frame.
2. Select the objects in the drawing.
3. From the Arrange menu, choose Create Bitmap Copy. For more information, see Creating bitmaps from objects. Remember to

keep all the frames exactly the same size.
. Change the drawing to how you want it in the next frame.
. Use Create Bitmap Copy again to create the next frame.
. Repeat steps 4 and 5 until you have built up the sequence of frames in the Bitmap Gallery.
. Drag the frames in the Bitmap Gallery to place them in the right order. The first bitmap will appear as the first frame.

o N o 0o b

. Set the delay for each frame by right-clicking on each bitmap in the gallery and selecting Properties. you can also set the
restore setting in this way.

9. In the Bitmap Gallery, select all the bitmaps you want in the animation. The easiest way to do this is to click on the first and
SHIFT-click on the last.

10. In the Gallery, click the Save button.
11. When you have entered the filename and destination, click Save. This will open the Animated GIF Export dialog box

12. The dialog box contains all the normal GIF export options and also special options for the animation. In the dialog box, set the
options and alter the width and height if you want (all the frames will be stretched to fit)

13. Click Export to create the file.

Web Links
g Creating Animated GIF Files
| g Creating GIF Files
&+

Related Topics

Bitmap Gallery



Creating bitmaps

You can create bitmaps in a wide variety of different formats. For more information on each of them, click below.

Creating JPEG files
Creating GIF files

Creating animated GIF files.
Creating PNG files

Creating BMP files

p
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If you want to create a bitmap of some objects in a document and use the bitmap in the document, see Creating bitmaps
from objects.



Creating bitmaps from objects

You can create a bitmaps from objects in your document. The bitmaps can be virtually any size, use any number of colors and can
even use a mask (include see-through areas).
&+ To create a bitmap from objects

1. Select the objects.

2. From the Arrange Menu, choose Create Bitmap Copy.

3. In the dialog box, set the size you want the bitmap, set the number of colors and choose the dithering and palette (standard or
optimized).

4. If you select the Transparency (mask) option in the dialog box, the bitmap will be see-through where there are no objects. For
example, if you create a transparent bitmap of a circle, the bitmap will be circular, not rectangular.

Tips
&+ To create a bitmap copy quickly, right-click on one of the selected objects to open the pop-up menu and choose Create
Bitmap Copy.
&+ If you hold down SHIFT when you click the Create button in the dialog box, the bitmap will be created on top of the
selected objects. Note that this may mean it looks like nothing has changed after the bitmap has been created.
O+ Bitmaps can look like they are of a lower quality than normal if they are not shown at a high enough magnification.
Web Link
g Creating Bitmaps from Objects

&+ Webster Movies - Bitmaps



| g

Creating different width clipart scrolls
Xara Webster's clipart includes some scrolls. For details on how to create scrolls of different sizes, click the web link below.

Web Link
&+ Creating Different Width Clipart Scrolls



| g

Creating embossed text
To find out how to draw embossed text, click the web link below.

Web Link
a3+ Creating Embossed Text



O
Creating new documents

This opens a blank document ready for you to start a new drawing.
O+ To create a new document:
From the File menu, choose New.



Creating realistic shadows

To find out how to create realistic shadows with Xara Webster, click the web link below.

Web Link
=+ Creating Realistic Shadows



O
Creating simple text

Simple text objects are the best way to do headings, labels and other small areas of text. You can set the attributes of the text
before you type the text (by applying them to the text cursor) or afterwards.
| To create a simple text object

1. Choose the Text Tool.
2. Position the pointer where you want to start the text and click - a red text cursor appears.
3. Set any attributes you want the text to have. For example, color, font, font size.

4. Type the required text, pressing RETURN to create new lines if necessary.

Related Topics

Text Tool

Applying attributes to text

List of Text Tool Key Shortcuts

Typing international characters



Creating smooth edged bitmaps
If you want to know how to create the smoothest edged bitmaps you have ever, click the web link below.

Web Link
[ Creating Smooth Edged Bitmaps



| g

Customizing the appearance of Xara Webster

You can customize the appearance of your Windows desktop and the programs you use in a variety of ways. You can change the
size and color of ToolTips, caption buttons (the buttons on the title bar), the active title bar, inactive title bar, menu items, gallery
title bars, selected menu items, scrollbars and the Status Line. These settings apply to all the programs you use that support this
feature.

Web Link
3+ Customizing Windows



i+

cliIE Cut (Edit Menu)

3* CTRL+X or SHIFT+DELETE
Cuts the currently selected objects to the clipboard. The selected objects are removed from the document. Note that you can get
the objects back in the same place (or use CTRL-SHIFT-V to paste the objects back in the same place). Once the objects are on
the clipboard they can be pasted back into the document any number of times, pasted into other documents or into other
applications. Copy is the same as Cut, but copies the objects to the clipboard leaving the selection in the document

Tip
| To cut an object to the clipboard quickly, right-click on the object to open the pop-up menu and choose Cut.

Related Topics

Cutting and copying objects to the clipboard



Cutting and copying objects to the clipboard

You can use the clipboard to move objects within a Xara Webster document and between documents. You can also use it to move
and copy objects into documents in other programs.
| To cut and copy objects to the clipboard
1. Select the objects you want to put on the clipboard. (See Selecting objects).
2. From the Edit menu, choose either Cut (CTRL+X) or Copy (CTRL+C).
You can now click in another document and press CTRL+V to paste the objects. For example you could click in a Microsoft Word
document and place the selected objects in it.

Tips
| You can also Cut or Copy by right-clicking on the objects and then choosing Cut or Copy from the pop-up menu.
&+ Cut removes the objects from the document and places them on the clipboard. Copy leaves the original objects in your
document.

Related Topics
Pasting objects from the clipboard



Alignment is the horizontal and vertical relationship of several objects to each other. For example, objects can be aligned so that
their top-most edges all line up and they are distributed evenly horizontally. For details on how to change the alignment and
distribution of objects, see Aligning and distributing objects.



The Animated GIF Restore setting sets what happens between each frame in an animated GIF :

g Nothing means no action is taken. Many World Wide Web browsers take this as meaning the same as the Leave As Is
option.

G Leave As Is displays the frames one on top of another - this leaves many frames visible in a stack if some are
transparent. Some browsers clear the animation before it loops again, some do not.

G+ Background restores the area covered by the graphic to the background color of the GIF (most usually white).

&+ Restore Previous restores the area covered by the frame to what it was before the frame was displayed. This is

interpreted by some browsers to mean that the frame should be cleared to the background before each frame is displayed and by
others to mean that the frame should be shown on top of the previous frame.

As browsers interpret these values in different ways, you may need to experiment to achieve the desired result.



Xara Webster can export animated GIF files which contain several separate images rather than just one. Programs which support
this type of file show each image one after the other with a set time delay between each. This means you can create animations
using Xara Webster. Most World Wide Web browsers (Netscape Navigator Version 2 and Microsoft Internet Explorer 3) support
animated GIFs, so using Xara Webster it is very easy to create animations for your World Wide Web pages. Remember, as Xara
Webster displays images at a very high quality and has a wide range of dithering and palette options, your animations will look

great! For more details, see Creating animated GIF files.



Anti-aliasing improves the quality of on-screen images by inserting extra pixels of calculated colors around the edges of objects
on screen. This has the effect of smoothing the edges and of appearing to improve the resolution of the display. Anti-aliasing only

occurs when the Xara Webster Quality setting is at its highest level. For more details, see Changing the screen guality of
documents.

Smooth



Smooth

Apply Inside allows you to apply attributes to objects that are contained inside other objects. To apply inside you must hold down
CTRL when you drop the attribute onto the object. For example to apply a color to an object in a group (not the whole group)
CTRL-drag the color from the Color Gallery onto the object. For more details, see the web link on Selecting objects.



The aspect ratio of an object is the ratio between its width and the height. For example, if an object has an aspect ratio of 100%,
its width and height are the same. If an object has an aspect ratio of 50%, it is twice as high as it is wide. See Scaling objects.
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Attributes are the properties of objects in your drawings. For example, color, web addresses and line thickness are attributes.



A Bitmap is a picture composed, of small 'dots' called pixels. Bitmaps are exported from programs such as Microsoft Paintbrush
and Photoshop or taken from a scanner. Xara Webster can import and export many common bitmap formats.



With Bitmap Fills you can fill text and shapes with bitmaps. The bitmap can be tiled (repeated) to fill objects. For more
information, see the Applying bitmap fills.



Blends are objects you may find in some of the clipart (you need CorelXARA to create them). They are created by showing
intermediate steps between two or more objects. For example, you could blend from a square to a circle. Blends are often used to
draw repeating patterns and highlights and are amazingly flexible. You may find that some of the files you load into Xara Webster
contain blends, with the full CorelXARA package you can create a wide variety of different effects with them. With Xara Webster,
you can use select inside to select the objects at each end of the blend and move them around.



The Bounding Box of an object or selected set of objects is an imaginary box enclosing them all.



The Browser Palette is the palette used by web browser to show images on the screen in 256 color modes. If you create bitmaps
using this palette, they will not be dithered by the browser when it displays them. If you only use web browser colors (using the

Browser Palette button in the Color Editor or the colors in the Web Browser section of the Color Gallery) and export a bitmap using
the browser palette, all flat areas of color will be displayed in 256 color modes without being dithered.



Circular Transparency graduates from one transparency to another in a radial fashion. For more information, see Applying
circular transparency.



The Clipboard is a temporary store and is used like a physical clipboard. You can cut or copy part or all of your drawing onto the
clipboard. You can then transfer the clipboard contents to another part of the document or even a completely different document or
application. The clipboard can only hold one item or set of items at a time. Placing something on it overwrites any existing

contents. Objects remain on the clipboard until deleted or overwritten by Xara Webster or another application. The contents of the
clipboard are lost when Windows is exited.



Color Models define the way in which a color is defined. In Xara Webster you can define colors using these color models :
g RGB (Red-Green-Blue). Most often used by video cards to define colors.
G+ HSV (Hue-Saturation-Value). The "artists" method of defining colors. Hue is the pure pigment of the color, Saturation is
the amount of white mixed into the color and Value is the amount of Black mixed into the color. Hue is measured in degrees

representing the angle around a color wheel that sweeps from Red through Yellow, Green, Cyan, Blue, Magenta and back to Red
again.



Compound Objects are objects in a document which contains other objects. The following are the compound object types :
G+ Group Contains one or more objects of any type
G Text Object Contains one or more Text Lines
O+ Text Line Contains one or more characters



Contone is short for "continuous tone". The term Contone is most commonly used in relation to bitmaps. A bitmap is a contone
bitmap when all of the colors used in it are varying mixtures of two colors. For instance, a grayscale bitmap is a contone bitmap
because all the colors in it are a mixture of black and white. You can change the two colors of contone bitmap fills by selecting the
fill handles and changing their color in the usual ways. You can give a bitmap an old-fashioned sepia look by setting one contone
color to dark brown and the other to a yellow-creamy color. For more details, see Changing bitmap palettes.



Control Bars are placed around the edges of the Xara Webster windows to make commonly used operations (in the form of
buttons, sliders and edit boxes) more accessible. New Control Bars can be created and the size of the buttons on different bars
altered. Control Bars can be free floating or docked (fixed) to the sides, top or bottom of the Xara Webster window. For more
details, see Control Bar Customization.



The Default Bitmap is always present in Xara Webster documents in the Bitmap Gallery. This default bitmap is the Xara Ltd. logo
in grayscale and can be used like any other bitmap but cannot be deleted.



Dithering is a technique where patterns are applied to areas of color in a bitmap in order to simulate a wider color range. It works
very well in pictures which contain a large number of colors as it creates the illusion of more colors. Xara Webster uses dithering
when it displays images on the screen and also when you create bitmaps. However, if you use dithering when you create a bitmap,

it will not compress as well and will probably create a larger file.



A Docked control bar is one which is attached to one of the edges of the Xara Webster window and moves with the window. A
docked control bar can be dragged away from the edge of the window so it becomes a floating control bar. for more details, see
Control Bar Customization.



You can think of a Document as a conventional sheet of paper. Like a sheet of paper, you can create images and write text (and
erase them later). You can save the document for later use by storing it on disc. Unlike conventional paper, the computer provides
you with many extra options. You can move objects around on the document just by grabbing them and sliding them around, even
over other objects. You can copy objects and reuse them, either in the same document or in a different document. Xara Webster
documents are displayed as a work area with a wide margin around all four sides shown in gray on screen. You can import or
create objects on the work area margin before moving them onto the work area, or move objects onto the margin for temporary
storage.



File Format is the way in which information is arranged in a file. Different programs arrange the information in different ways
depending on their requirements. This means that files from one program cannot be read by another or, if it can be read, not all the
information can be displayed correctly. Xara's Webster's native file format is called Xara Web format (.web). Xara Web files can
describe all of the advanced graphics produced by Xara Webster. No other file format can fully describe the same graphics and, if
drawings are saved in other formats, either some parts of the drawing are lost or changed or they are no longer editable when
the file is reloaded into Xara Webster.

There are two major groups of graphic file formats; Bitmap (a rectangle of colored dots) and Vector (a list of drawing instructions).
Xara Webster can import and export many types of both Bitmap and Vector file formats. See the Xara Web Files Overview for
more information on the .web format.



Flat Transparency is a fixed level of transparency applied uniformly over a whole object. For more details, see Applying
transparency.



Flipping an object is as if it was reflected in a mirror. This process is sometimes called 'mirroring’ or 'reflecting’. See Flipping
objects for more information.



A control bar is a Floating Control Bar when it has been dragged and dropped away from the edges of the Xara Webster window.
A floating control bar has a thick edges so it can be resized, a title bar and a close button. A floating control bar moves
independently of the Xara Webster window. For more details, see Control Bar Customization.



A Folder is a directory on a disc containing files. You can add folders of files to some of the galleries. When you add a folder of
files to a gallery Xara Webster creates an index for the files and creates a small ‘thumbnail' image of each of the files in the folder.
When you open the Gallery, you will see small versions of all the files in the folder you added. Xara (.xar and .web) files do not
need separate thumbnail pictures as they are built into the files themselves. Though, remember you can create .web files without
thumbnail previews.



A Font is a collection of characters which are all designed in a particular style. Also known as a "typeface". Many different types of
fonts are available; often the difference between them is very slight. A font often has several variants, the commonest being Bold
and /talic



Compuserve GIF files are bitmap files compressed using lossless compression. GIF files can contain up to 256 colors. They are
widely used for pictures on World Wide Web pages. Xara Webster supports both interlacing and transparency (import and export)
in GIF files. For more information, see Creating GIF files. You can also create animated GIF files with Xara Webster.



Galleries are scrolling windows containing lists of items. Xara Webster has three galleries; one for bitmaps in the current
document, one for clipart and one for colors. For more information, see Galleries Overview.



A grayscale bitmap is a bitmap with a palette consisting entirely of grays. Grayscale images are often called "black and white"
images. For more details on creating grayscale bitmaps, see Changing bitmap palettes.



A Grid is a set of regularly spaced points to which objects and points can be snapped. By setting an appropriate grid spacing and
turning grid snapping on, it is very easy to create drawings of very precise dimensions. The grid can be shown or hidden whether
or not grid snapping is turned on. At small zoom levels, grid points may become very close to each other. If they were all displayed,
the screen would be covered by points and it would be difficult to see the drawing. To prevent this, Xara Webster leaves out some
points if necessary. You can still snap to these invisible points. For more information, see Displaying the grid.



Group objects are compound objects which contain other objects (even groups). The group object is a single object and can be
treated like any other, for example applying attributes to it, rotating it, etc. Note that if you want to change one object in the group
you do not have to ungroup it, you can use select inside to select it from within the group. For more details, see Grouping objects.
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Many people find HSV the easiest color model to use. The HSV color model uses Hue, Saturation and Value components to define
colors. Hue is the pure pigment (defined as an angle round the color circle) of the color. Saturation is the amount of white added to
the color. The smaller the Saturation value, the greater the amount of added white. Value is the amount of black added to the color
which can be viewed as the brightness of the color. So the Saturation and Value produce all the shades of the basic Hue value.



The Tool Infobar is a context sensitive control bar. It displays different information and controls dependent on the currently
selected Tool. For example, when the Text Tool has been chosen the Infobar contains only text related controls. The different
functions available on the Infobar are described in the descriptions of the individual tools - see Tools.



Interlacing is an option when you create GIF and PNG bitmap files. When an interlaced file is loaded into an application which
supports interlacing, the picture will first appear as a low resolution image and the resolution increase as more of the file is loaded.
This technique is used commonly on the World Wide Web to improve the appearance of bitmaps as they are downloaded. It will
almost look like the picture is coming into focus. If you do not use interlacing, the picture will only be displayed when the whole
image has been downloaded.



The JPEG format allows bitmaps to be stored in compressed form. Unlike most other compression techniques, the amount of
compression is user selectable. JPEG works by discarding redundant information (it is 'lossy') although generally there is no

noticeable reduction of image quality. Xara Webster can import and export JPEG bitmaps. For more information, see Creating
JPEG files.



All the Xara Webster clipart has Keywords associated with it. Keywords are associated words which help you to find documents
more easily. As an example a document containing a picture of a puppy might contain the keywords "animal" and "dog". For
information on adding keywords to your own files, see Adding titles, descriptions and keywords to documents.



A Line can be straight, curved or contain a mixture of both straight and curved segments. A line must have a start and an end; thus
it cannot be filled. You can apply a thickness, color and transparency to a line. When the two ends of a line are joined the line can
be filled and is referred to as a shape.



A Linear Transparency is a smooth, linear graduation between two transparencies. You can alter the direction of the
transparency, the level of the transparency at either end and the type of transparency. For more details, see Applying
transparency.



A mould is an object which contains a set of objects which have been moulded. For example CorelXARA includes a circular mould
so you can take a set of objects and mould them into a circle. Although you cannot mould objects with Xara Webster, you can
import moulded objects in drawings that have been created with CorelXARA.



Objects in Xara Webster are the building blocks used to create drawings. Object is a general term used to describe the contents
of the document. Objects can be contained within other objects. For example, groups contain other objects. Text is also a type of
container object as each text object contains a line of text which itself contains a set of characters. You can create other types of
object (e.g. blends and moulds) using the full CorelXARA package. You can also load these types of object into Xara Webster.




A bitmap with an optimized palette is one where the colors in the bitmap have been chosen carefully to make the bitmap look as
good as possible. Optimized palette bitmaps with 256 colors will usually look as good as the 24 bit equivalent (one with millions of
colors) when you display them in a screen mode with millions of colors. If you display an optimized palette 256 color bitmap in a
256 color screen mode it will look as good as one with a browser palette, but will look far better in screen modes with more colors.
If you use an optimized palette, you can choose the number of colors in the palette that are used. e.g. you could create an 8 bit

bitmap where only 100 of the 256 colors in the palette are used. With some experimentation, you will often find this reducing the
number of colors reduces the size of the bitmap file.



Document view Quality is the way in which documents are drawn on the screen. The Quality can range from the drawing being

rendered in simple outline, to being edited in full color, anti-aliased mode. This is useful for altering the speed at which a document
is redrawn as a lower quality setting will result in faster redraw times, but a higher setting will give far better results. Sometimes it is
useful to set the Quality to its lowest level for selecting some objects which would be obscured by other objects on higher settings.

The quality setting is also used when you create bitmaps.



RGB (Red, Green, Blue) is the natural model of computers. Colors would usually be defined using this model if they are to remain
‘on-screen' - for example if the Xara Webster were being used to create bitmaps for use on the World Wide Web.



Redo allows you to redo an editing operation which has been Undone.



Redraw is the process of Xara Webster building up the on-screen image from the information stored about the drawing.



Selection handles operate in two modes; Scale mode and Rotate/Skew Mode. The former allows the selection to be scaled, the
latter allows it to be rotated and skewed.



Scaling resizes or stretches something. You can scale any object using the Selector Tool. For more details, see Scaling objects.



Selection Handles operate in two modes; Scale Mode and Rotate/Skew mode. The former allows the selection to be scaled; the
latter allows it to be rotated and skewed.



Select Inside can be used to select an object inside a compound object. This can be done in the Selector tool by CTRL-clicking or
by ALT-CTRL-clicking on the object. Objects are said to be "inside" a group when they are members of the group. Normally,
clicking on the object would select the group but a CTRL-click selects the object that you clicked on inside the group. Select inside
also works inside blends (selects the end objects) and text (selects individual characters). When any selected object is inside
another one, the status line shows for example: "2 shapes selected (“inside")". Select-inside is just like select member, except it
goes straight to the innermost object. It is a quick way to select the object you actually click on, irrespective of whether it is part of
a group, blend, or mould. Some operations are unavailable when any selected object is inside another one. For more details, see
the web link on Selecting objects.




Select Member

To select an object which is a member of a group. (This is a special form of Select inside.) This can be done in the Selector Tool by
ALT-CTRL-clicking on the object. Objects are said to be "inside" when they are members of a group. Normally, clicking on the
object selects the group but ALT-CTRL-click selects the object inside the group containing the clicked object. That object may itself
be a group and then further ALT-CTRL-clicks can be used to select members of that group, etc. When the last selected object was
not a group, it cannot have any members and so the next ALT-CTRL-click will select the outermost group again. Select member
also works inside blends, moulds and text. When any selected object is inside another one the status line shows, for example "2
shapes selected ("inside") " Some operations are unavailable when any selected object is inside another one. For more details,
see the web link on Selecting objects.



Select Under allows you to select an object which is underneath another object. This can be done in the Selector Tool by ALT-
clicking on the top object. Select under is most useful when one object is completely covered by another one. Clicking on the top
object selects the top object; ALT-clicking on the top object selects the object underneath.

If there are several objects covering each other, repeatedly using ALT-click selects the next object underneath the one that was
last selected. When the last selected object is the one at the back, the next ALT-click will start at the top again and select the top
object. For more details, see the web link on Selecting objects.



The Selection is all the currently selected objects. The selection is most often manipulated using the Selector Tool. For details on
how to select objects, see Selecting objects.



Selection Handles are displayed when the Selector Tool is the current tool. They are displayed around the boundary of the
selection and allow the selection as a whole to be scaled, rotated, skewed and stretched. They operate in two modes: Scale mode
and Skew/Rotate mode.




A Shape is a solid (or closed) object. The difference between a line and a shape is that a shape has no start or end. Because a
shape is a closed object it can be filled with a color. A thickness can be applied to the outline of the shape. Xara Webster
sometimes uses 'Shape' as shorthand for ‘Line or Shape'. In PostScript terminology, a shape is a "closed path". Shapes can have

two main attributes applied; a fill and a line color. The line color is the color used for the outline of the shape and the fill in the color
of the object itself.



Skewing is often called shearing and involves sliding the top (or side) of something to stretch it, without moving the opposite side.
For more details, see Skewing objects.



The Text Cursor is displayed when the Text Tool is selected. The cursor shows you where characters will appear if you start typing
or where editing will take place if the cursor is inside an existing text object. To move the cursor click the mouse where you want
the cursor. No cursor is displayed if there is a selected text region. You can apply attributes to the text cursor which will be used
when you type. For more details, see Creating text.



A Text Object is one or more lines of text which can be moved and copied like any other object. The Text Tool allows you to edit
the contents of text objects by typing new characters, changing the font, font size, etc. You can apply all the normal attributes to
text objects, such as thick line widths, color and transparency. If you use Select Member on a text object you first select the whole
object, then a line of text in it, then a single text character in the line. For more details, see Creating text.



A Tool in Xara Webster is much like a tool in normal life. It is used for a specific job. Xara Webster is divided into well-defined tools
each of which has a specific purpose. When you choose a Tool, the Infobar changes to give you a set of options specific to that
Tool leaving more editing area available. For more information on the Xara Webster Tools, see The Toals.
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The Toolbar is a special control bar containing buttons for all the Tools available in Xara Webster. For more details, see The Tools.



The transformation center is the point/axis around which objects are skewed, flipped and rotated using the Selector Tool. The
transformation center is only visible when the Selector Tool is in Rotate/Skew mode. For more information, see Moving the
transformation center.



&

You can change the transparency of any object in a document. There several transparency 'shapes' including circular and linear.
Most of the transparency types are 'graduated transparencies', this means the level of transparency changes across the object.
The level of transparency is measured in percentages. By combining transparency types and shapes with different fill colors and
types you can create a wide range of effects and shading. Note that documents using transparent objects take longer to redraw
on-screen and to print. For more information, see Applying transparency.



Xara Webster allows you to Undo your most recent changes to a document. Undo allows you to get rid of changes which you've
applied mistakenly to your document, which went wrong or which you simply don't like the look of. Undo is a very powerful tool
when combined with Redo because it gives you the freedom to experiment with a drawing, secure in the knowledge that you can
always undo any changes or if you eventually decide you do actually like the changes, to redo them again.



Vector Format files describe a picture as a list of drawing instructions. This has two advantages over Bitmap formats:
1. The instructions can be scaled to work at any size.
2. The list can be edited to add, remove or alter any part of the drawing very easily.



A View is a window showing a document in a particular way. The different ways in which a View can show a document are:
g Area of document in the view,

=+ Zoom factor,
&+ Quality setting,
a3+ Grid visible,

You can have more than one View open onto a document. For instance, you could have two Views onto different areas of the
same document, two views showing the same document at different zoom factors or at different Quality settings.



A Web Address specifies a page on the Internet. http:/lwww.xara.com/ is the Web Address for the Internet home of Xara Ltd.
Web addresses are also called URL's, Shortcuts and Hotlinks. For more information, see Adding web addresses to objects.



The Work Area is the area onto which drawings are placed. The white is the actual work area with the gray area around the
outside a 'pasteboard' for rough drawings or unwanted objects.



Xara Web Format is a new graphics format. Web (.web) files are very similar to CorelXARA .xar files but they do not contain as
much information. This makes them far smaller and ideal for publication on the World Wide Web using the Xara plug-in for
Netscape Navigator and Microsoft Internet Explorer. Xara Web files can be edited just like .xar files so you don't need to create
bitmaps copies of all your graphics to put them on the Internet. As Xara Web files are vector files you can zoom into a Web file at
over 25,000% without loss of quality. Web files also look far better when printed than bitmaps and it's easy to create complex
looking images that are very fast to download. For more details, see the Xara Web File Overview.



The Zoom level of a View lets you see a document in close up or at a distance. You can think of the zoom level being like a
magnifying glass whose strength you can vary. When you look at your document with a zoom level of anything other than 100%,
you are looking at it through a magnifying glass. But note that changing the Zoom level only changes your view onto the document
- it does not change the size of the document or anything in it.
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K Delete (Edit Menu)

3* DEL (Delete)
Delete removes the selection from the document. Unlike Cut, Delete does not copy the selection to the clipboard, the clipboard is
not affected in any way by Delete. A Delete operation can be reversed using Undo.

Tip
&+ To delete an object quickly, right-click on it to open the pop-up menu and choose Delete.

Related Topics

Deleting objects



Deleting objects

You can delete any type of object to remove them from a drawing.
&+ To delete objects

1. Select the objects (see Selecting objects).

2. From the Edit menu, choose Delete.

Tips
| You can also select the objects then press the Delete key on the keyboard.
&+ If you might want the object in the future, you can move it onto the gray pasteboard at the side of the white work area.
Objects on the pasteboard are still saved.
G+ Deleting objects does not put them on the clipboard. If you want to remove an object and leave it on the clipboard, use
Cut.
O+

You can recover deleted objects using undo. See Undoing and redoing operations.

Related Topics

Cutting and copying objects to the clipboard



Deselecting all objects

Sometimes you may need to deselect every object in your drawing.
&+ To deselect all objects

From the Edit menu, choose Clear Selection.

Tips
&+ You can also press ESC (Escape).
&+ You can also choose the Selector Tool and click on a blank part of the work area..

Related Topics

Clear Selection



Deselecting objects

When you have selected objects and you no longer need them selected, you can deselect them all or deselect them one by one.

What do you want to do?

=+ Deselect selected objects
&+ Deselect all objects

Related Topics

Selecting objects
Selector Tool

Using the Selector Tool temporarily



Deselecting selected objects

If you have selected an object or several objects you can easily deselect one or more of the objects.
&+ To deselect selected objects

1. Choose the Selector Tool.
2. SHIFT-click on each selected object to swap it from being selected to not being selected.

i SHIFT-Click to swap the object under the mouse pointer between selected and not selected

Related Topics

Selector Tool



Displaying the grid

The grid is useful for aligning objects especially as you can make grid points magnetic.
&+ To display the grid

From the Window menu, choose Show Grid.

Tips
&+ You can also right-click on the work area to open the pop-up menu and choose Show Grid.

Related Topics
Enabling grid snapping



E Document Info (File Menu)

Document Info on the File Menu opens the Document Information dialog box which displays information about the current
document. It also contains a comments field which you can use to add a title, description and keywords to the document.

Location. The folder where the file is located.

File Name. The name given to the document.

Created. The time and date when the document was created.

Last Saved. The time and date when the document was last saved.

Memory Used. The total memory used by the document.

Undo Size. The amount of memory used by undo information. See Undo.

Undo Steps. The number of undo steps stored.

Number of Bitmaps. The total number of bitmap in the current document.

Bitmap Size. The amount of memory used by bitmaps in the current document.

Number of Fractals. The total number of fractal fills and fractal transparencies in the document. Xara Webster can import
hese, but you need the full CorelXARA package to create them.

Fractal Size. The amount of memory used by fractals

Number of Objects. The total number of objects in the document.

Number of Selected Objects. The total number of objects in the Selection.

Document Fonts. This drop-down list contains a full list of all the fonts contained in the document. If the document uses a
font not currently installed on your PC, an asterisk ( * ) will appear next to the font name.

Comments. The comments field allows details about the file to be added to the document. It can also be used for adding
keywords and a title to a file which is then displayed in the Clipart Gallery. Note that the first line of this field is stored as the
description of the file and will be displayed in the Clipart Gallery if the file is added to it.
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Related Topics
Viewing document information
Adding titles, descriptions and keywords to documents



Drawing Xara Webster clipart with CoreIXARA
To find out the best way to create clipart for Xara Webster using CorelXARA, click the web link below.

Web Link
&+ Drawing Xara Webster Clipart with CorelXARA
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Iaa Duplicate (Edit Menu)

E* CTRL+D
Duplicate creates a copy of the selection a certain distance from the original. After the copy has been created, it is selected and
the original deselected.

Tips
&+ To duplicate an object quickly, right-click on it to open the pop-up menu and choose Duplicate
O+ For information on how to change the distance, see Changing the duplication distance.

Related Topics
Copying objects



Edit Control Bar
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Related Topics
List of the Default Control Bars



Edit Menu
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Editing text

There are two editing modes used with the Text Tool. You can either change the text using the text cursor or by changing a
selected region of text

G To edit text with the text cursor
1. Choose the Text Tool.
2. Click in the text object to insert the text cursor.

3. Edit the text as required (see List of Text Tool Key Shortcuts).

G+ To edit text selections
When a region of text has been selected (see Selecting text) you can :

&+ Apply attributes to the selected region - see Applying attributes to text

O+ Replace the selected region by typing new text.

O+ To scale and stretch text
You can use either the Text Tool (see Changing the size of text) or the Selector Tool (see Scaling objects or Stretching objects).
Tip

&+ Whenever the text cursor is moved it takes on the attributes of the character to its left.

Related Topics
Text Tool

Creating text.

Typing international characters



Enabling grid snapping

With grid snapping enabled, you can snap objects to the on-screen grid.
G To enable grid snapping

From the Window menu, choose Snap to Grid.

Tip

&+ You can also enable grid snapping by pressing '.' on the numeric keypad.
Web Link

g Webster Movies - The Basics

Related Topics
Displaying the grid



Exit (File Menu)

Choosing Exit from the File menu will close the program. If you have changed any documents, Xara Webster will ask you if you
want to save them to disc before the program closes. You can also exit Xara Webster by doing one of the following:

G+ Open the application control menu, (press ALT+SPACEBAR) and choose Close.
&+ Double-click the Application Control-menu box.

If you are editing a drawing which is embedded in a document in another program, this menu item reads "Exit and Return to
DocumentX" where DocumentX is the document in the other program. Selecting this item will return you to the other program after
updating the drawing in the document.



@ Export (File Menu)

3* CTRL+SHIFT+E
Select Export from the File menu to export your document in any of a wide variety of file formats (see the List of Supported File
Formats for a complete list).

With Windows 95 and Windows NT 4, if you click on a .xar or .web file, you will see a preview of it in the dialog box (if the file
contains a preview).

Related Topics

Exporting part of a document



Exporting part of a document
You can easily export a selection of objects from a document.
&+ To export part of a drawing
1. Select the objects you want to export (see Selecting objects).
2. From the Edit menu, choose Copy to copy the objects to the clipboard.
3. From the File menu, choose New to create a new, blank document.
4. Press CTRL+SHIFT+V to paste the objects back in the same position in the new document.
5. Export the new document as normal.



File Control Bar

G Close

m Save As
Import

@ Export

E Document Info

Related Topics
List of the Default Control Bars



File Menu
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Finding clipart

To find clipart, use the Clipart Gallery. You can find pictures using the file name of the picture, the title of the picture or using
keywords (words related to the picture). For more details, see Searching a gallery.



Flipping objects

Objects can be flipped around the vertical and horizontal lines passing through the transformation center.
&+ To flip objects

1. Select the object(s) to be flipped (See Selecting objects).

2. Do one of the following :

| Press the Horizontal flip button on the Selector Tool Infobar.
&+ Press the Vertical flip button on the Selector Tool Infobar.
Tip
O+ The transformation center is only visible when selection handles are in Rotate/Skew mode. The flip will normally occur
around the center of the selection unless you have moved the transformation center.
Web Link
g Webster Movies - The Basics

Related Topics
Selector Tool



GIF Export Dialog Box

The (Compuserve) GIF export bitmap dialog box is opened by selecting GIF as the exported file format from the Export dialog box.
It allows the setting of the size/resolution of the exported bitmap, the area to be exported and the number of colors in the bitmap.
In addition Xara Webster also allows GIF files to contain simple transparency and interlacing - two facilities of GIF files used
extensively on the World Wide Web. For details of how to create a GIF file, see Creating GIF files.

Bitmap Size
Color Depth
Area to Save
Interlacing
Transparent
Palette

Dithering
Number of Colors

YRR

Related Topics
Creating Animated GIF files



Galleries Overview

Xara Webster has a set of Galleries for manipulating items you use as you create your documents. Some list items in your
documents and some list items on disc. All the Galleries support drag-and-drop and are often a quick and easy way to use the
program. For more information on any of the galleries, click on the gallery name below.

| g Color Gallery
3+ Bitmap Gallery
[ Clipart Gallery

The galleries have many common features; the title bar allows you to position the gallery on the screen. You can resize any gallery
using the window border in the normal way. The close button closes the gallery completely. When you want to reopen a gallery use
the appropriate button on the control bar or a keyboard shortcut.

All galleries have a row of buttons under the title bar for working on selected items in the gallery and for setting gallery options.
Note that you can make the buttons at the top of the galleries large or small using the Control Bars dialog box .

The main display area of all galleries is scrollable and contains one or more sections. Each section is shown by a gray "section
bar" with a folder icon in it and the name of the section written in white. Sections can be folded so that only the section bar is

showing or unfolded to see all the items within them. To fold or unfold a section double-click on its gray section bar or click on the
folder icon.

Web Link

g Webster Movies - Control Bars and Galleries

Using Galleries
Selecting items in a gallery
Moving and resizing galleries
Reordering gallery items
Reordering gallery sections
Searching a gallery
Changing the way galleries look
Closing a gallery
Adding clipart to the clipart gallery
Updating the clipart gallery



Gallery Control Bar

The Gallery Control Bar contains seven buttons which are used to open and close the seven Xara Webster galleries.

| g Color Gallery

a3+ Bitmap Gallery

| g Clipart Gallery
Related Topics
List of the Default Control Bars



Gallery Find Dialog Box

To open this dialog box, click the Options button in the gallery and choose Find from the menu.

Find items including the text

Search Names and Keywords and Search full information
Find first

Find next

9339

Related Topics
Searching a galler



Gallery Find Dialog Box - Find First Button

Click this button to start the search. If the gallery does not contain any items that match the search text, a message box will be
displayed.



Gallery Find Dialog Box - Find Next Button

Click this button to continue a search that has just found an item (or which starts at the currently selected item). If the gallery does
not contain any more items that match the search text, a message box will be displayed.



Gallery Find Dialog Box - Search Type

Click one of these radio-buttons to either restrict the search to the names (and file names) and keywords of gallery items, or
search all information available for each item. This table shows which information is searched for the two searching options.

Names and Keywords All Information
Color Gallery color name definition (for example RGB(255,255,255) )
Bitmap Gallery file name & title file name & title
Clipart Gallery title, keywords & file name title, keywords, file name, file size & full description (if

present)



Gallery Find Dialog Box - Text

Into this field, type the text you want to search for. For example, "dog" in the Clipart Gallery or "100%" in the Color Gallery.



Gallery Icons Size Dialog Box

You can use the Gallery Icon Size dialog box to alter the way items are displayed in each of the Galleries. Open the dialog box by
clicking the Options button in a gallery and choosing Icon Size from the menu.

Related Topics
Searching a gallery
Reordering gallery items

Galleries Overview



Gallery Sort Dialog Box

With the Gallery Sort dialog box you can sort the contents of the galleries. To open the dialog box, open the relevant gallery, click
Options and choose Sort from the menu.

[ Primary and Secondary Keys
| g Apply sort to all the gallery sections
&+ Only apply the sort to sections containing selected items

Related Topics

Reordering gallery items
Galleries Overview



Gallery Sort Dialog Box - Apply to All Gallery Sections

Select this option to apply the sort to all the items within all folders contained in the gallery.



Gallery Sort Dialog Box - Only Apply to Some Sections

Click this radio-button to apply the sort to only those sections which have an item selected within them. See Selecting items in a
gallery.



Gallery Sort Dialog Box - Primary and Secondary Keys

You can choose a sorting-order for items within the gallery from these two drop-down lists. Items can be sorted by name
(alphabetically), by their size in memory, by their size on disk, by the file type, or by the length of their name (depending on the
gallery). If the Reversed check box is checked then the items are sorted in the reverse order.

For example, you may have a gallery of bitmaps that you would like sorted according to the type of bitmap, e.g. .BMP or .JPG, and
within each category of bitmap, alphabetical order. To sort the items this way choose Sort By File Type from the Primary Key list
and Sort by name from the Secondary key.



General Control Bar

Color Editor

Work Area Options
Web Address

Options

HemT

Related Topics
List of the Default Control Bars



@ General Options

To open the General Options, choose Options from the Utilities menu and click on the General tab.

Angle Constraint
You can use the CTRL key to constrain objects and handles when you move them You can change the constraint angle, see

Changing the constrain angle for more information.

Nudge Size
When you move (nudge) objects using the cursor keys, they move by a set amount. You can change this value, see Changing the

nudge size.

Duplication Distance

When you use Duplicate (on the Edit Menu) the copy is placed on the wok area at a different position from the original. The
horizontal and vertical distances the copy moves can be changed. See Changing the duplication distance for more details.
Related Topics

Options



Getting help with Xara Webster

If you need some help using Xara Webster, here are some sources of information that may be of use...

&+ Online Help. Choose Help Topics from the Help menu to open Xara Webster help (containing hundreds of pages
information). See How do [...? for more details on how to use it.
G+ Status Line. Try reading the text on the Status Line at the bottom of the main Xara Webster window. It always describes

what actions are currently possible and what they will do, even during drags and so is ideal for learning to use the Xara Webster
tools. It also gives details of what buttons and controls do as you move the pointer over them. See Status Line for more details.

G+ ToolTips If you hold the mouse pointer over a button or control for a short while and a small message appears telling
you what it does.

O+ Menus. If you want to know what a menu item does, highlight it and press F1.

G+ Dialog Boxes. If you want to know what a dialog box does or how to use it, click the Help button.

&+ Internet. You can access Xara's web site using the items on the Xara On The Web submenu on the Help menu and you'll

also and links to the site throughout Xara Webster's help.
G+ Technical Support. Registered users of Xara Webster can get free Technical Support.



lzl Grid Options
To open the Grid Options, choose Options from the Utilities menu and click on the Grid tab. They control the way the grid appears.

Grid Spacing
Major Spacing defines the distance between the major grid divisions. The units used for the grid is defined by the units you use for
the Major Spacing. For example entering a major grid spacing of "2cm” will set the grid units to centimeters. For more details, see

Changing the grid spacing.

Related Topics
Options



3* Group (Arrange Menu)
F* CTRL+G
Combines all the selected objects into a single group object.

Related Topics
Grouping objects

Ungrouping objects



Grouping objects

Grouping objects together lets you select and move them as a single object. This is useful, for example, when you create a
shadow effect. Grouping the object and its shadow means you cannot separate them by accidentally moving either.
| To group objects

1. Select the objects (see Selecting objects).
2. From the Arrange menu, choose Group.

Tips
| If you want to change an object inside a group, you do not need to ungroup it. For more details, see the web link on
Selecting objects.
&+ You can still apply attributes to individual objects within a group. Just hold down CTRL as you drag-and-drop the attribute.
See Apply inside.

Web Link
g Webster Movies - The Basics

Related Topics
Ungrouping objects

Removing objects from groups



Help Menu

e

Xara Webster Help

Use Help Pages and Movies from CD

Xara On The Web
Tip of the Day

About Xara Webster



Howdol...?

Xara Webster's help contains hundreds of pages of information. If you need a hand using the program or want to know how to do
something, try searching the help. Not only are there pages describing what all the parts of the program do, there are overviews,
pages explaining terms, step-by-step procedures to help you get your work done and lots of links to World Wide Web pages giving
you even more information (click the web link below). We have also created a set of Xara Webster Movies for you to download and

watch off the Internet.
To open the help at any time, just press F1.
&+ To find information in help
1. Click the Index button at the top of this window.
2. Type in a word at the top of the dialog box.
3. The list will move to show the word you typed.

Now just double-click on the index entry that interests you. If the index entry refers to more than one page, a small window
appears so you can choose which page you want to go to.

Web Link
&+ Xara Webster Web Help
&+

Related Topics
Getting help with Xara Webster



3* Import (File Menu)
* CTRL+SHIFT+|



Importing CDR files

You can import CDR files from versions 3, 4, and 5 of CoreIDRAW. If you are using CoreIDRAW 6 or later use CMX to transfer
your files - see Importing CMX files. If a CDR file contains a CMX file the CMX file will be loaded (to include a CMX file in a CDR
file, select the "Include Presentation Data" in the Save dialog box).

As CDR is not Xara Webster's native file format, some objects may not appear how you expect them to. Note that if the file
contains a CMX file, the CMX importer will be used so the following does not apply.

G Fills. All fill types apart from full color pattern fills are supported. However, custom fills are imported as fills from the start
color to the end color. Square fills are approximated to radial fills. Full color pattern fills which are just a bitmap (no paths or other
objects) are imported as bitmap fills.

G Text. Text is imported with the font name, font size, bold, italic, underline, super/subscript and line spacing attributes. Only
the alignment and baseline shift options from the fit path to text roll-up are imported. Text on a path can only be imported if the path
it is fitted to still exists in the file. If you delete a path in CoreIDRAW after fitting text to it, the text will be imported into Xara Webster
as normal text in the position it was before this operation.

O+ Special Effects. Mix, Color limit and ColorAdd Lenses are supported. Other types of Lenses are not supported. Some
PowerClips may be imported incorrectly. All other effects are supported.

G Envelopes. Envelopes are approximated. You will be warned about this after the file has been imported if there were any
envelopes in the file.

| Extrusions. Some extrusions cannot be imported correctly.

&+ Lines. If lines are imported which have arrowheads, the object will appear as a group containing two objects, a line and a

shape (the arrowhead).

If Problems Occur. If any of these limitations cause problems, try saving the .CDR file from CoreIDRAW as EPS and import that
instead. If a file is found to load incorrectly, please send the file to Corel with full details so we can fix the problem.



Importing CMX files

You can import Corel CMX version 5 and 6 files. As CMX is not Xara Webster's native file format, the file may contain some
objects that do not have direct equivalents. Below is a list of objects that may not import as you expect them to.

7

Fills. Multiple color (custom) graduated fills are imported with just the end colors. Postscript and Vector (full color) pattern
fills are not supported. Any objects imported with them will not be filled.

Bitmaps. Cropped bitmaps will appear as rectangles with a bitmap fill.

Text. Underlined text is not supported. Individually rotated letter will not appear rotated.

Clipping. The outlines of PowerClip and Place Inside containers are approximated.

Lenses. You can only import Transparency, Color Add and Color Limit lenses.

Outlines. If you have an object with a behind fill, CorelXARA will import the shape without the behind fill.

Tiling. Some tiling options such as offset-tiling will not import correctly.

IRF3RY

If Problems Occur. If any of these limitations cause problems, try saving the .CMX file from CoreIDRAW as EPS and import that
instead.

If you have persistent problems importing a CMX file, email it to Xara - websterbug@xara.com
Related Topics

Importing CDR files



Importing animated GIF files
If you import or open an animated GIF file, each frame is imported as a bitmap with all the bitmaps placed on the work area on top
of each other. Note that the frames will appear in the Bitmap Gallery in the animation sequence (the first bitmap is the highest in
the gallery).
Tip

O+ You can easily alter an animated GIF by loading it into Xara Webster, altering one or more frames, creating bitmaps for

the new frames (see Creating bitmaps from objects), replacing the old bitmap with the new one (in the Bitmap Gallery) and exporting
the new animated GIF file. For more details, see Creating animated GIF files.

Related Topics

Bitmap Gallery



Importing colors and palettes
To find out how to import palettes of color into the Color Gallery, click the web link below.

Web Link
g Importing Colors and Palettes

Related Topics

Color Gallery



Importing files

You can incorporate (import) an existing drawing into a document. Note the difference between Opening (which opens the drawing
in a separate window) and Importing (which loads the drawing into the existing window).
| To import a file

1. From the File menu, choose Import.

2. Browse to the directory containing the document file.

3. To display only particular file formats, choose from the Files of type list. (If in doubt, choose All Files.)
4. Double-click on the file.

Tips
G For a list of types of file Xara Webster can load, see the List of Supported File Formats.
O+ Usually the importer automatically determines the type of file format and imports it correctly. In a few cases, this may not

work and the file is imported incorrectly. If this happens, Undo the import and select the specific file type from the Files of type list.
Then re-import the file.

g You can also use the Clipart Gallery to import drawings from the Internet.

G+ You can use drag-and-drop to import a file into a document just by dropping it onto the work area.

Related Topics

Import

Clipart Gallery

Importing transparent bitmap files
Importing CDR files

Importing colors and palettes

Opening documents from disc



Importing transparent bitmap files

Compuserve GIF files and PNG files support 'masks' which are a very basic form of transparency. When a bitmap file with a mask
is placed on a background (for example in a World Wide Web page) some areas of the background show through the bitmap. This
method is often used to remove the background from pictures so the bitmap doesn't appear rectangular. Importing a masked
bitmap files retains the transparent mask and you can see through parts of the bitmap when it is in Xara Webster.

Note that GIF/PNG Transparency (masking) and Xara Webster Transparency are different. Bitmap Transparency means you can
see through the background of the bitmap. Xara Webster Transparency means you can see through objects and is variable from
fully transparent to fully opaque. In the example, both imported bitmaps are completely see-through in places, but the one on the
right also has transparency applied to it using the Transparency Tool.

g To import a transparent bitmap file

You can import these in the same way as other files. See Importing files.
Tips

O+ You can apply Xara Webster transparency to any bitmap, including masked bitmaps.
G+ You can create transparent GIF files and PNG files with Xara Webster. (See Creating GIF Files or Creating PNG files).



Importing web clipart

With Xara Webster you can download clipart off the Internet using the Clipart Gallery just as easily as if it was on your hard drive.
O+ To get a list of web clipart

1. From the Utilities menu, choose Clipart Gallery.

2. Click the Web Clipart button in the gallery.

3. Xara Webster will connect to the Xara Ltd. web site and add folders of clipart to the gallery.

As you open these folders, Webster will download small versions of the files for you to look at. As you scroll down the folder in the

gallery, it will download more.
O+ To download a piece of clipart

1. Scroll to the piece of clipart you want to download.

2. Double-click the image to load it or drag it onto Xara Webster to merge it with an open document.

Tip
&+ If you installed Xara Webster from CD, the CD contains much of the clipart from the Internet site and will already be listed
in the Clipart Gallery.

Related Topics

Changing the colors in clipart



Increasing the available work area

To help you gain as much screen area as possible, this page lists changes you can make to Xara Webster so you can see as
much of your document on the screen as possible. For instance, you can move the control bars around and remove any buttons
you do not use.

To increase the work area you can...

3+
| g Maximize the main document window so it fills the screen. To do this, double-click on the title bar or select Maximize from
the application control menu.

O+ Remove any buttons from the bars that you do not use (see Control Bar Customization).
O+ Move the control bars so they make more efficient use of the area around the edge of your document (see Control Bar
Customization).
O+ Change the size of the buttons on the control bars (the toolbar has large buttons by default). See Control Bar
Customization.

Tip
&+ You can use Zoom To Work Area and Zoom to Drawing to fill the screen with your drawing. See Zooming to the work area

or Zooming to the whole drawing.



Inverting a grayscale bitmap

Web Links
a3+ Changing Bitmap Palettes



O
JPEG Export Dialog Box

The JPEG export bitmap dialog box is opened by selecting JPEG as the exported file format from the Export dialog box. It allows
the setting of the size/resolution of the exported bitmap, the area to be exported and the ‘'quality’ of the final bitmap. For details of
how to create a JPEG file, see Creating JPEG files.

Bitmap Size and Resolution
Area to Save

JPEG Quality

Progressive

Use Original JPEG

335



JPEG Export Dialog Box - Progressive

If you select this option, the JPEG will be a 'progressive JPEG'. This is similar to an interlaced GIF and means that when the JPEG
is displayed by a web browser that understands progressive JPEG files, it will slowly come into focus as it is downloaded. If the

browser doesn't support progressive JPEG files, the JPEG will only be displayed once the whole file has been downloaded, just as
if the JPEG wasn't progressive. Netscape 3 supports progressive JPEG files.



JPEG Export Dialog Box - Use Original JPEG

This option is only available if you have opened the JPEG Export dialog box by clicking the Save button in the Bitmap Gallery. If
you select a JPEG in the Bitmap Gallery and click Save, you can select this option to save the JPEG file out again with it being re-
encoded. This means the JPEG you save is an exact copy of the original file and has not been through the JPEG process a
second time. You will notice that when you select this option, you cannot change the Quality setting.



Justifying text
After creating a text object, you can justify it so each line is aligned on the left, on the right or in the center. If you want to create a
new justified text object, just place the text cursor in the document and click one of the justification buttons on the Text Tool Infobar

before typing.
O+ To change the justification

1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Click one of the justification buttons on the Infobar.

Related Topics
Text Tool



Line Width

IEI.Ept TI

S _.You can choose a value from the drop-down list or you can type a value and press
RETURN.

Related Topics
Zero Width Lines Overview
Units Overview

Changing line thickness



List of Default Control Bars

Xara Webster contains several default control bars in addition to the Toolbar and the tool-specific Infobar. The Button Palette
contains all the buttons available in Xara Webster. You can copy buttons from the Button Palette to existing or new control bars. To
find out what the buttons on a bar do, click one of the links below :

Standard Control Bar
File Control Bar
Edit Control Bar

Arrange Control Bar
Window Control Bar

Gallery Control Bar
General Control Bar

333339

Related Topics
Control Bar Customization



3* List of Keyboard Shortcuts

This page contains a list of the key shortcuts available in Xara Webster. If you want any more information on what a shortcut does,
click on the underlined text next to it.

The Tools
Selector Tool F2 or ALT+S (or the Space Bar if you are not using the Text tool).
Transparency Tool F6
Text Tool F8
Push Tool SHIFT+F8 or ALT+X
Zoom Tool SHIFT+F7 or ALT+Z

The Galleries

Clipart Gallery
Color Gallery
Bitmap Gallery

Zooming

Previous Zoom
Zoom To Selection
Zoom To Work Area

Manipulating Documents

New document

Open document

Save document

Import

Export

Time a document redraw
Show Grid

Snap to grid

Undo

Redo

Manipulating Objects

Select all

Put object to back

Copy object to clipboard
Duplicate object with offset
Bring object to front

Clone object

Paste object from clipboard
Cut selection to clipboard
Move object backwards

Paste object in original position
Move object forwards

Open the Alignment dialog box
Web Address

Delete the selection

Clear selection

Move the selected objects
Move the selected handles

Other

Color Editor

Options dialog box
Xara Webster Help

Related Topics
List of Text Tool Key Shortcuts

CTRL+N

SHIFT+F10
F9
F11

CTRL+R
CTRL+SHIFT+Z
CTRL+SHIFT+P

CTRL+O

CTRL+S

CTRL+SHIFT+I
CTRL+SHIFT+E
CTRL+SHIFT+T

#

"." on the Number Keypad
CTRL+Zor'<' or'"
CTRL+Y or >'or "'

CTRL+A

CTRL+B

CTRL+C

CTRL+D

CTRL+F

CTRL+K

CTRL+V

CTRL+X

CTRL+SHIFT+B

CTRL+SHIFT+V

CTRL+SHIFT+F

CTRL+SHIFT+L
CTRL+SHIFT+W

DELETE

ESC

Cursor keys with the Selector Tool
Cursors keys in tools other than the Selector.

CTRL+E (opens and closes)
CTRL+SHIFT+O
F1



List of Menus

Xara Webster provides the following menus on the menu bar :

39

Related Topics
Pop-up Menus Overview



List of Supported File Formats

Import

It important that you use the three letter file extensions listed below when you load files into Xara Webster.

XAR  Xara Webster

\WEB Xara Web Format

Al lllustrator EPS (88, 3, 4 & 5)

.EPS lllustrator EPS (88, 3,4 & 5)

.CPL CorelDRAW Palette

.PAL  CorelDRAW Palette

.PAL  Microsoft Palette

.PAL PaintShop Pro Palette

.ACT Adobe Color Table

.ACO Adobe Color Swatch

.BMP Windows Bitmap (uncompressed)

.GIF  CompuServe Graphics Interchange Format (see Importing transparent bitmap files)
JPG  JPEG

.PBM UNIX monochrome

.PGM UNIX grayscale

.PNG PNG (see Importing transparent bitmap files)
.PPM UNIX color (up to 24 bit)

.EPS CorelDRAW! 3, 4 & 5 EPS

.EPS FreeHand 3.0 EPS

.EPS ArtWorks EPS

.AFF  Acorn Draw

.CDR CorelDRAW (3,4 & 5) (see Importing CDR files)
.CDT CorelDRAW Template

.CMX Corel CMX 5 & 6 (see Importing CMX files)
.DRW Acorn Draw

WMF Windows Meta File

For information on how to import palettes, see Importing colors and palettes.

Export

.GIF  CompusServe GIF (see Creating GIF files)
.GIF  Animated GIF files (see Creating animated GIF files)
JPG JPEG (see Creating JPEG files)

.PNG PNG (see Creating PNG files)
XAR CorelXARA 1.5 and later

.\WEB Xara Web Format (see Creating Xara Web files)



List of Text Tool key shortcuts

Cursor keys Move the text cursor one character at a time up, down, left or right.

Home Move the text cursor to the start of the line.

End Move the text cursor to the end of the line.

CTRL+right-cursor Move the text cursor right one word.

CTRL+left-cursor Move the text cursor left one word.

CTRL+HOME Move the text cursor to the start of the first line in a text object.

CTRL+END Move the text cursor to the end of the last line in a text object.

CTRL+A Selects all characters in a text object.

CTRL+B Apply the Bold attribute (see Bold).

CTRL+I Apply the Italic attribute (see ltalic).

CTRL+C Copy the selected region of text to the clipboard.

CTRL+L Selects all characters in the line containing the text cursor.

CTRL+V Paste text at the text cursor position (If the clipboard contains text)

CTRL+W Swap the case of the character to the right of the text cursor.

RETURN Start a new line of text.

DELETE Delete the character to the right of the text cursor. If the cursor is on the end of a
text line, join this line to the line below.

BACKSPACE Delete the character to the left of the text cursor. If the cursor is at the start of a
text line, join this line to the line above.

SHIFT+cursor keys Select all text between the cursor position and the beginning of the line.

SHIFT+END Select all text between the cursor position and the end of the line.

For details of how to enter special characters with the Text Tool, see Typing international characters.



Loading files

Note the difference between Loading (which opens the drawing in a separate window) and Importing (which loads the drawing into
the existing window).

| g To load a file
1. Click the Open button on the control bars.

2. Choose the location and file name of the file (see Open for details).

Tips
| You can also load a file by dragging it from the Explorer (or File Manager) onto Xara Webster. Drop it onto the control bars
or anywhere away from the document because if you drop it onto a document it will be imported into that document.
O If you have loaded the file recently its name will be on the bottom of the File menu. Click to load it.
O+ If the file is on the Xara Webster CD you can use the Clipart Gallery to load it. You can add your own files to the Clipart
Gallery.
O For a list of types of file Xara Webster can load, see List of Supported File Formats.

Related Topics

Importing files



Making drawings lighter and darker
To find out how to lighten and darken your drawings, click the web link below.

Web Link
[ Making Drawings Lighter and Darker



O
Making text bold

Once you have created a text object, you can make all the characters in it bold, or just some of them. If you want to create a new
text object in bold, just place the text cursor in the document and click the Bold button on the Text Tool Infobar.
| To make text bold

1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Click the Bold button on the Infobar.

Web Link
3+ Webster Movies - Text
&+

Related Topics

Text Tool



Making text italic

Once you have created a text object, you can make all the characters in it italic or just some of them. If you want to create a new
text object in italic, just place the text cursor in the document and click the Italic button on the Text Tool Infobar.
| To make text italic

1. Select the text you want to change (see Selecting text).
2. Choose the Text Tool.
3. Click the Italic button on the Infobar.

Web Link
| g Webster Movies - Text
&+

Related Topics
Text Tool



Menus and Buttons

Xara Webster has a standard Windows menu bar containing all the options additional to the Tools. Additionally Xara Webster has a
wide range of default control bars available which provide buttons to access these options more easily.

| g List of Menus
| g List of Default Control Bars

Related Topics
Control Bar Customization



Message: A bars settings file is invalid or corrupt

Cause
Xara Webster creates a file in your Windows directory to save the configuration of the control bars and Galleries.

XARAWBN.INI Bars settings.
This error indicates that this files is corrupted or missing.
What Can | Do?

=+ No action is necessary as clicking on OK recreates the corrupt or missing file using the default settings. This loses any
customized control bar and gallery settings.



Message: Bitmap is being used within a document

Cause
You have attempted to delete a bitmap in the Bitmap Gallery that is currently being used within a loaded document.

What Can | Do?
| Choose Delete to delete the bitmap from the gallery. The bitmap is replaced in the document by the default bitmap.
O Choose Cancel to keep the bitmap in the gallery.



Message: Bitmap too large
Cause
The bitmap you are trying to create is too large for Xara Webster. You can only export bitmaps up to 4,000 by 4,000 pixels.

What can | do?

This limit is fixed in Xara Webster. You can create even larger bitmaps using CorelXARA.



Message: Cannot close file

Cause

If the file is on a floppy disc, the disc may have been removed from the drive.
If the file is on a hard disc, the disc structure may be corrupt.

What Can | Do?

O If the file is on a floppy disc, check the disc is correctly inserted in the drive.
O+ If the file is on a hard disc, run your disc diagnostic utilities to check for a corrupted disc structure.



Message: Cannot create file

Cause

Xara Webster tried to create a file but did not succeed. This may be because:

| g
O+
o+
o+

The disc is full.

The drive is read-only (For example, a CD-ROM drive).
Afile of that name already exists and is read-only.

You do not have write permission for the directory.

What Can | Do?

| g
O+
o+

Check that the disc is not full - if it is, then choose another disc or delete some unwanted files from it.
Choose another name for the file, or another disc or directory.
Ask your system administrator to change your access permissions.



Message: Cannot read or write your initialization file

Cause
The initialization file, XARAWEB.INI, has been moved, deleted, or corrupted.

What Can | Do?

| XARAWEB.INI should be in your Windows directory. If it has been moved to another directory, close Xara Webster and
copy XARAWEB.INI into the Windows directory. Then rerun Xara Webster.
g If XARAWERB.INI has not been moved, then it may be corrupted. Close Xara Webster and delete the XARAWEB.INI file.

Then rerun Xara Webster. This creates a new initialization file with default settings.



Message: CorelDRAW version 6 files are not supported

Cause
You cannot load CorelDRAW 6 CDR files into Xara Webster.

What Can | Do?
| Re-save the file from CorelDRAW in CMX 6 format (or CDR 5 or CMX 5).
&+ Note that a CoreIDRAW 6 file will load into Xara Webster if it contains a CMX file. To include a CMX file in a CDR file,
select the "Include Presentation Data" in the Save dialog box in CoreIDRAW.



Message: Could not locate the specified web page

Cause

This error occurs when Xara Webster cannot open a web page. This could be because it cannot find the weblink utility (installed
along with Xara Webster) that opens web pages in your web browser or it could be because weblink cannot find your web browser.

Recommended Action
O Reinstall Xara Webster
g If this does not fix the problem, reinstall your web browser.



Message: Creating a new index

Cause
This message is displayed after attempting to create a new index for a folder.

What Can | Do?
| Unless otherwise stated, the index and thumbnails will be placed in the Xaralnfo subdirectory in the selected folder. This
will require disc-space, and it is left up to you to delete this sub-directory if you require the space back. If this is OK, click Create,
otherwise click Cancel.



Message: Creating remote indexes

Cause
This message is displayed when the selected folder is read-only, but does not have an index.

What Can | Do?

| If you are creating an index and thumbnails and the specified location is OK, click Create. If you do not want to create an
index there, click Cancel. Note that you can change the location which Xara Webster attempts to use for the remote indexes via the
'XARAWERB.INI' file which can be found in your Windows\System directory. Exit Xara Webster, load the 'XARAWERB.INI' file into a
text editor, such as Notepad, and add a directory path to the line that starts "RemotelndexLocation=". (For example if your remote
indexes were being written to your Xara Webster directory, you'd have the following line in your ini file: "RemotelndexLocation=C:
\XaraWeb".) Save the edited ini file, and rerun Xara Webster.



Message: Document file is invalid
Cause
The file you tried to open or import is corrupt or has the wrong format.

What Can | Do?
| Recreate the document file from a backup or from the original creating program.

Related Topics
List of Supported File Formats



Message: Document is unsaved

Cause
You have tried to close a document, or exit Xara Webster when a document has changes that have not been saved to disc.

What Can | Do?
| Click the Save button if you want to save your work.
&+ Click the Don't Save button to discard the changes you have made to the document.
O+ Click the Cancel button to cancel the close. This lets you continue running Xara Webster.



Message: Drawing is too large for CMX export

Cause
The drawing you are exporting is more than 40 inches across. You can only save drawings in CMX 5 format if they are smaller
than 40 inches across.

What Can | Do?
O You do not need to do anything. Xara Webster has automatically scaled your drawing so it fits.
g If you do not want the drawing scaled, use another format like CMX 6 which does not have a limit on page size.



Message: Export entire work area?

Cause
If you try to export a document as a bitmap when there are no objects in the document, the bitmap is likely to be very large.
What Can | Do?

| If you want to create the bitmap, click Export.
O+ If you do not want to create the bitmap, click Don't Export.



Message: Failed to find the CD
Cause
This message is displayed when the 'Find CD' button is clicked in the Add folder dialog box, and the CD cannot be found.

What Can | Do?
| Insert the CD, and click 'Find CD' again.



Message: Failed to locate gallery index

Cause

This message is displayed by Xara Webster not being able to find the index for a section in the gallery (for example if the directory
it was contained in has been deleted or if you removed the CD).

What Can | Do?

O Click Skip to ignore the error. The relevant gallery section will remain in the gallery, but you cannot open it or search it until
the index is available.
| Click Retry to force Xara Webster to look for the index again. This is particularly useful if you have put the CD in the drive.

G Clicking Quiet will ignore all errors found and will leave all the sections in the gallery even if the index cannot be found.



Message: Failed to make transparency mask for GIF

Cause

The GIF file that was being imported or opened has been loaded correctly but it specifies that it requires transparency. When the
transparency mask was being created, a problem was encountered and the process halted. Therefore, the GIF file will be
displayed without the transparency mask. The reason for the failure is likely to be lack of memory.

What Can | Do?
g Free up some memory by closing documents or quitting other applications and try loading the GIF file again.



Message: File already exists

Cause
You have tried to save or export to a file that already exists.

What Can | Do?
| Click the Replace button to overwrite the existing file.
&+ Click the Cancel button to abort the save or export. You can then repeat the operation using a different file name.



Message: File is read-only

Cause
Xara Webster attempted to write to:
| a file that is read-only,
&+ a read-only drive, such as a CD-ROM drive.

What Can | Do?
O Use the Windows Explorer (or File Manager) to check if the file is read-only. If itis, then the file's read-only status can be
changed. (Although there may be a reason why the file is read-only - if in doubt, then contact your system administrator.)
Alternatively, choose another file name or another disc drive.



Message: File not found

Cause
The document file name you typed in does not exist.

What Can | Do?
| Check that the name, drive and directory path are correct.
O Check that the file exists.



Message: File-sharing violation

Cause
Another process (or possibly, in the case of a file on a network, another user) has already claimed the file.

What Can | Do?
| Often if you wait a few seconds for the other user to finish, you can write to the file yourself. If this fails, contact your
system administrator.



Message: General failure to read or write a file

Cause

There may be a number of reasons why it is not possible to read or write the file.
If the file is on a floppy disc, the disc may have been removed from the drive.

If the file is on a hard disc, the disc structure may be corrupt.

What Can | Do?
G If the file is on a floppy disc, check the disc is correctly inserted in the drive.
g If the file is on a hard disc, run your disc diagnostic utilities to check for a corrupted disc structure.



Message: Internal error

Cause
Alogical error in Xara Webster has been detected.

What Can | Do?
Please note the circumstances that led up to this message being displayed, and report the problem to Xara Ltd. You can email us

with this address : websterbug@xara.com
If you click the Continue button you will usually be able to save your work and restart the program. It is highly recommended that

you save the file to a different file name. It is possible the file created will be corrupt due to the internal error and saving the
document to the same file name will delete the old version and possibly remove any chance of data recovery.

After saving the file, exit Xara Webster and restart.



Message: Invalid file name

Cause

You have entered an incorrect name for a file. Often this is because the file name contains characters that are not permitted in file
names.

What Can | Do?

Different versions of Windows have different rules concerning what is valid in a file name. Generally file names conforming to the
MS-DOS convention will work on all versions of Windows.

MS-DOS file names consist of:

&+ Up to 8 characters,
O+ Followed by a period (.),
| Followed by up to 3 characters (the extension).

Spaces, control characters, or punctuation marks are not permitted.

Windows NT and Windows 95 relax these rules, allowing file names up to 256 characters long that may contain spaces. If your
file name does contain spaces, you should surround it with double quotation marks, for example "this file name has spaces.xar"



Message: No library index file available

Cause
Index file not found for this folder.

What Can | Do?
| Choose the correct directory path where the index file can be found, or click the Create button to make a new index file for
the folder.



Message: Overruni/truncated file.

Cause

Xara Webster has tried to read a file that is incomplete. This usually means that it has been corrupted, possibly by canceling an
earlier export.

What Can | Do?
&+ Run your system's disc diagnostics - it may be possible to recover the rest of the file.



Message: Problems creating a new index

Cause
This message is displayed if creating a new index file ran into problems. Possible problems include running out of disc-space, or
writing to a floppy disc which has just been taken out of the drive.

What Can | Do?
&+ Ensure the disc is accessible and contains sufficient free space.



Message: Problems creating a thumbnail

Cause

This message is displayed when a problem occurs generating thumbnails for a file. This is likely to be because the type of files is
not supported by Xara Webster. It is also possible the file is corrupt or has the wrong file extension.

What Can | Do?
O Click OK to ignore this file, or Quiet to ignore all files with this problem. Stop will cause the index generation to cease.



Message: Program installation incomplete or corrupted.

Cause

Some of the components of Xara Webster were not installed, have been moved, or have been deleted. It is possible Xara Webster
will not function correctly.

What Can | Do?
O Replace the missing component or reinstall Xara Webster.



Message: Removing gallery sections

Cause
This message is displayed by one of the following :
G Clicking Remove in the Clipart Gallery to delete a section from the gallery.

g Xara Webster not being able to find the index for a section in the gallery (for example if the directory it was contained in
has been deleted).

What Can | Do?

| If you are trying to remove sections from the gallery, click Remove to delete them (Cancel to leave them).

&+ If Xara Webster cannot find an index for a section, clicking remove will remove the affected sections (Cancel will leave
them).



Message: Retain the clipboard contents after closing Xara Webster?

Cause

Some document objects have been placed on the Windows clipboard. On exit from Xara Webster, these objects may either be
converted into a form suitable to be left on the clipboard, or can be discarded. Converting the objects may take some time and
memory if there are a large number of objects.

What Can | Do?

g Click the Keep button to keep the image of the objects in the clipboard after Xara Webster has closed. You can then paste
them into another application.

&+ Click the Discard button to discard the contents of the clipboard.



Message: Some fonts have been substituted

Cause
A document has been opened or imported which contains fonts you do not have installed on your system.

What Can | Do?

| Open the Document Info dialog box and use the drop-down list of fonts to look for fonts listed with a' * ' next to them,
these are the fonts that have been substituted. You must install each of these fonts.
g If you do not have the fonts used, you can apply a different font to the text objects (see Applying attributes to text) or leave

them as they are.



Message: Some parts of the document could not be imported

Cause

Parts of an imported file cannot be converted to Xara Webster document format, for example an Adobe lllustrator complex
graduated fill.

What Can | Do?

&+ If you are familiar with the look of the original document, you can probably reconstruct the missing parts using the tools
provided in Xara Webster. You can then save the document as a Xara Webster document file.



Message: Spread too large

Cause

The values that have been entered into the work area width, height and margins fields in the Work Area Options to modify the
current work area size mean that the height and/or width of the pasteboard is beyond what Xara Webster will cope with, which is
about 275cm or about 9ft. The pasteboard is the gray area encompassing the work area and the margins around the outside.
The height of the pasteboard is always the total of the work area height and twice the size of the margin, as there is a margin
above and below the work area.

What Can | Do?
&+ Reduce the size of the width, height and margin fields so that the pasteboard size becomes less than the maximum.



Message: Text to search for is invalid
Cause
You have not entered any text to search for.

What Can | Do?
| Repenter the text you wish to search for.



Message: The appropriate type of object is not selected

Cause

In Xara Webster, operations are often performed on objects that are selected. You have tried to perform an operation when no
object is selected, or the wrong kind of object is selected.

What Can | Do?
&+ Select the object you wish to perform the operation on, then try the operation again.

Related Topics
Selecting objects



Message: This document contains overlapping transparent objects

Cause

The document you are exporting contains transparent objects on top of one another. Exporting transparent objects to a CMX file
when there are more than three transparent objects in a stack is likely to cause problems for other programs.

What Can | Do?
&+ To limit the transparency to the lower three objects and export the other objects solid, click Limit.

O+ To continue exporting and include all the transparent objects, click Continue. This may cause problems when you import
the file into other programs.



Message: Unable to find any files to add to index

Cause

This message is displayed after attempting to generate an index for a directory with no recognized files that can be used in the
relevant gallery.

What Can | Do?

&+ Check the path is correct. Files are currently chosen by their extensions, if these are incorrect this may explain the
problem.



Message: Unable to find folder

Cause
Cannot find the required folder / directory for the gallery.

What Can | Do?
| If the folder is on the CD, and the CD is not in the CD drive, insert the CD and click Retry. If this is not possible, or the
folder has been deleted, click Add to locate a new folder. Cancel will open a, possibly empty, gallery.



Message: Unable to find index

Cause
This message is displayed when an index is unavailable.

What Can | Do?
| If the index is on the CD, and the CD is not currently in the CD drive, insert the CD and click Retry. If this is not possible,
or the folder has been deleted, click Continue and the relevant folder will be removed from the gallery. Clicking Quiet will remove all
the affected folders with no further warnings.



Message: Unable to update index

Cause
This message is displayed when you try and update a read-only index.

What Can | Do?
| If the index is on a CD, it is not possible to update it - the entire folder must first be copied to a writable drive.
&+ If the index is on a read-only network mount, copy the folder to a different drive or contact your system administrator.



Message: Web address is too long

Cause
The web address you have entered is too long. It must be less than 255 characters.

What Can | Do?
| g Use a shorter form of the address or an alternative address.



Message: Xara Font Not Found

Cause
This message is displayed if the XARAFONT.FON font has been de-installed. This font is required by Xara Webster to run.

What Can | Do?

Windows 95 and Windows NT 4 - Run the Windows Control Panel application to reinstall this font. Double-click the 'Fonts' icon
in Control Panel to display the fonts installed on your computer. Choose the File/Install New Font... menu option to display a
dialog box that will allow you to enter the directory path to the font. When Xara Webster is installed, the font is copied to the
Fonts subdirectory of your Windows directory. If the font has been deleted from there, a backup copy of it can be found in the
Xara Webster directory, where the Xara Webster program is located.

Windows 3.1x - Run the Windows Control Panel application to reinstall this font. Double-click the 'Fonts' icon in Control Panel to
display a dialog box that allows you to install or de-install fonts. Click the Add button to display a dialog box box that will allow you
to enter the directory path to the font. When Xara Webster is installed, the font is copied to the System subdirectory of your
Windows directory. If the font has been deleted from there, a backup copy of it can be found in the Xara Webster directory, where
the Xara Webster program is located.

Alternatively, reinstalling Xara Webster will solve the problem.



Message: You cannot edit library colors

Cause
PANTONE® colors cannot be edited.

What Can | Do?
| To see the CMYK definitions of PANTONE® colors, change the Color Gallery to display colors in "Full information" mode.
See Changing the way galleries look.

O+ To edit a PANTONE® color - click Copy. This will place a copy of the color into your document, and allow you to edit the
copy. Note that editing a PANTONE® color definition will render its appearance incompatible with the original PANTONE® Color,
and so your printing bureau may not be able to correctly match the color.



Message: Your Initialization file is out of date

Cause
The initialization file, XARAWERB.INI, was created by an older version of Xara Webster.

What Can | Do?

g Clicking Default recreates your initialization file so that it contains the standard settings. You lose the previous settings,
such as the window position and the list of recently used files, as well as the settings set in the Options.
O If you want to keep your existing settings, then click Current. Any settings which apply to the new version of Xara

Webster are merged into your existing initialization file.



Message: About to lose Undo information

Cause
You have changed the maximum size of the undo information buffer. This will discard existing Undo information.

What Can | Do?
| To discard the existing Undo information click the Resize button.
&+ To make the Undo information buffer larger and hence preserve the existing Undo information, click Don't Resize and
enter a higher value.



3* Move Backwards (Arrange Menu)
#* CTRL+SHIFT+B
Moves every object in the selection backwards in the stack of objects in the drawing.

Related Topics
Moving objects backwards and forwards



#* Move Forwards (Arrange Menu)

[3* CTRL+SHIFT+F
Moves every object in the selection forwards in the stack of objects.
Related Topics

Moving objects backwards and forwards



Movies

We have created a set of movies for you to download off the Internet and watch which show you how to use Xara Webster. To go
to the Movies, click the Web Link below.

Web Link
&+ Xara Webster Movies



O
Movies (Help Menu)

This option displays the Movies page of Xara Webster help.




Moving and resizing galleries

You can move the galleries so that they do not obscure the part of the drawing you are working on. You can also resize them to
see more or fewer entries.

| To move a gallery
Do one of the following :
g Drag the title bar of the gallery.
G+ Drag the background of the gallery behind the buttons.
G To resize a gallery

Drag the outer edge of the gallery as you would with any other resizeable window.



Moving between documents

You can have several Xara Webster documents loaded in memory at the same time. You can then view any of them in the window
and swap between them.
O To move between documents

At the bottom of the Window menu is a list of currently loaded documents. From this list select the name of document you want to
view.

Tips
| You can also cycle through the currently loaded documents by pressing CTRL+Tab.

Related Topics

Viewing several document at once



Moving objects

Objects can be moved using the mouse, accurately using the Infobar or in small steps using the keyboard.

What do you want to do?

3+ Move objects by dragging
| g Move objects accurately



Moving objects accurately

You often want to move objects around your document. Usually you can just drag them to the required position but sometimes you
want to position them more accurately.
&+ To move an object accurately

1. Select the object (see Selecting objects).
2. Do one of the following

&+ Enter values in the Position Field on the Infobar and press RETURN.
o Use the Position field arrow buttons on the Infobar to alter the values.
Tips
O+ You can move objects using the cursor keys, see Nudging objects.
| This moves the object within the document. To move between documents see Cutting and copying objects to the

clipboard.



Moving objects backwards and forwards

Often you find to want to move objects in front of or behind other objects.
&+ To move objects backwards or forwards

1. Select the object (see Selecting objects).

2. From the Arrange menu, choose

G Bring to Front or Put to Back to move the object to the front or back.
g Move Forwards or Move Backwards to step the object towards the front or back.
Web Link

[ Webster Movies - The Basics



O

Moving objects by dragging

You often want to move objects around your document. Dragging is the easiest way to move them.
&+ To move objects by dragging

1. Choose the Selector Tool (see Selecting objects).

2. Drag the object to the new position. If the object is part of the selection, the entire selection will move.
| Moving objects using grid locking

When an object is moved with grid locking enabled the leading edge(s) of the bounding box of the selection will lock onto the
nearest grid points. The normal operation of this feature is the same as with CoreIDRAW. It is possible to force the object to remain
at the same relative position on the grid as it is moved. To do this hold down ALT during the drag.

Tips
O+ To constrain the move angle, hold the CTRL key down during the drag. Press CTRL after the mouse click (otherwise the
action will become a Select Inside operation).
&+ To leave copies of the object as you move it, drag as normal, but click the right mouse button where you want each copy
(or press ' +' on the number keypad).
G+ To move the object but not any fill applied to it, press and release ' - * on the number keypad during the drag. This is very
useful if you want to move an object with a bitmap fill and you do not want the bitmap to move.
O+ If you want to move the selected objects and for some reason you cannot drag them (for example if they are obscured

by other objects), ensure the objects are selected, move the pointer anywhere on the work area, press ALT+CTRL and drag. You
can then release CTRL+ALT and move the objects as if you had dragged them normally.
O+ If you want to move objects to a precise position, see Moving objects accurately.

Related Topics

Using the Selector Tool temporarily



Moving the document

You can easily slide your drawing around the screen so you can see different parts of it.
G To move the document

1. Choose the Push Tool.

2. Move the pointer over the work area and drag to slide the drawing around in the window.

Tip

| You can also move the drawing using the scrollbars.
Web Link

g Webster Movies - The Basics

Related Topic
Push Tool

Using the Push Tool temporarily



Moving the transformation center

When you rotate an object or skew an object (using the Infobar) the rotation or skew depends on the position of the transformation
center. For example, if you want to rotate an object around its top left corner, you can move the transformation center to the top left
corner of the object.
o+
O+ To move the transformation center
1. Ensure you are using the Selector Tool.
2. Change the selection handles to rotate/skew mode (see Switching selection handle mode).
3. Drag the transformation center to a new position. If you hold down CTRL whilst dragging the center, it will be constrained to the
nine points shown on the Transformation Center Grid on the Selector Tool Infobar.
Tip
| To move the transformation center quickly, just click on a square on the Transformation Center Grid on the Infobar to
move the transformation center to a specific position on the selection.

GER
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EEE
Web Links
| g Rotating Objects
[
&+ Skewing Objects
&+
| Scaling Objects
[ o
g Webster Movies - The Basics

Related Topics
Rotating objects
Skewing objects



D New (File Menu)
3% CTRL+N
New creates a new, blank document.



% New View (Window Menu)

New View opens another view on the current document. Changes in one view are reflected in all others. The Quality setting (see
Changing the screen quality of documents) can be different for different views.

New View is also available from the View Pop-up Menu.
Related Topics

Opening another view on a document



Nudging objects
You can move selected objects small distances by using the cursor keys (see Changing the nudge size).
G+ To nudge an object

1. Choose the Selector Tool.
2. Select the object (see Selecting objects).
3. Use the cursor keys to move the object.

Tips
O+ To move ten times the nudge size, hold down SHIFT.
&+ To move five times the nudge distance, hold down CTRL.
O+ To move a fifth of the nudge distance hold down CTRL and SHIFT.
O+ You nudge by individual screen pixels instead by holding down ALT or by ten pixels by holding down ALT+SHIFT.



OLE Overview

OLE provides a convenient way of incorporating Xara Webster drawings into suitable, OLE-compliant applications such as
Microsoft Word. Another advantage of OLE is when you want to edit an embedded drawing. All you need do is double-click on the
drawing in the Microsoft Word window. This loads the drawing into Xara Webster ready for you to edit it. When you finish, Xara
Webster copies the drawing back to Microsoft Word keeping any custom values such as scaling. You can embed Xara Webster
drawings into any OLE-compliant application.

&+ To embed a drawing into an application
This describes how to embed a drawing into Microsoft Word; other applications will be similar.
| In Xara Webster, select the objects you want to embed and drag them to Microsoft Word.
&+ In Xara Webster copy part or all of the drawing to the clipboard. Then embed it into Microsoft Word using Paste Special on
Word's Edit menu.
| Create the drawing in the usual way and save it to disc. You can then insert it into Microsoft Word by choosing Object on
Word's Insert menu. Select the Create from File tab and select the name of the file.
g Create a new drawing from within Microsoft Word. Choose Object on Word's Insert menu. Select the Create New tab.

Click Xara Webster Document. This opens a new Xara Webster window ready for you to create your drawing. When you finish the
drawing, choose Exit and Return to Word on Xara Webster's File menu. This inserts the drawing into the Word document.

Tip
G+ When you embed a Xara Webster document or Xara Webster objects in another program, the objects will look best when
displayed at 100%. For example, if you embed some objects in a Microsoft Word document and then change the magnification in
Word to 200%, the document will not look quite as good.
G+ To edit an embedded Xara Webster drawing

Just double-click on the drawing in the application. This loads the drawing into Xara Webster ready for editing. When you finish
editing, choose either Close and Return to (application) or Exit and Return to (application) on Xara Webster’s File menu.

Xara Webster menus and OLE

The File menu changes slightly when you are viewing an embedded drawing:

&+ Save becomes Update. (The embedded drawing is automatically updated every 10-20 seconds. Update lets you update
sooner if desired.)

G+ Save as becomes Save Copy As. You can use this option to save a copy of the document.

&+ Exit becomes Exit And Return To (Application). Choosing this updates the embedded document in the application and
closes Xara Webster.

G+ Close is either dimmed (if the embedded document is the only document) or becomes Close And Return To (Application).

Choosing this updates the embedded document in the application; Xara Webster remains loaded in memory.



Object Pop-up Menu

If the pop-up menu is opened with the mouse pointer over an object, it contains the following options:

Web Address
Color Editor

9z 99 7 999 339§

If you open the pop-up menu over a text object, the menu also has a "Text Tool' item at the top which you can use as a
quick way to get to the Text Tool.

Related Topics
Pop-up Menus Overview



d
=4 Open (File Menu)
F* CTRL+O
Opens an existing document or file in a supported format in a new window. Xara Webster can open a wide variety of file formats,
for a full list, see the List of Supported File Formats. For information on how to open files, see Opening documents from disc.

If you click .web file (or a .xar file), you will see a preview of it in the dialog box (if the file contains a preview).



Opening another view on a document

You can open more than one view on a document. This is useful so you can see different areas of the document in different views
at the same time. You may also find it useful as you can have different settings for each view. For example you can set the Quality
setting differently for each.

O+ To open another document view
1. Click on the document.

2. From the Window menu, choose New View.



Opening documents from disc
When you want to edit a previous saved document, you must load it from disc.
&+ To open a document from disc
1. From the File menu, choose Open.
2. Browse to the directory containing the document file.
3. To display only particular file formats, choose from the Files of type list. (If in doubt, choose All Files.)

4. Double-click on the file.

Tips
&+ To open a document you have recently opened, choose the file name from the list at the bottom of the File menu.
O+ You can also drag-and-drop the file onto Xara Webster from the Explorer (or File Manager) or double-click on it.
O+ If you want to load a file into an existing document, use Import.

Related Topics

Open

List of Supported file formats
Importing files



@ Options (Utilities Menu)
3* CTRL+SHIFT+0O
Options on the Utilities menu brings up the Options dialog box from where the Xara Webster options are set. There are two types

of option :
&+ Program options
O+ Options for the current document

When options apply only to the current document, the section of the Options dialog box will show the document name (for example
‘Work Area options for map.web'). The program options are saved when you finish using Xara Webster whereas the document
options are saved with the document.

The options are divided into the following sections :

[ General Options
=+ Grid Options
&+ Work Area Options



PNG Export Dialog Box

The PNG export bitmap dialog box is opened by selecting PNG as the exported file format from the Export dialog box. With it, you
can set the size/resolution of the exported bitmap, the area to be exported and the number of colors in the bitmap. In addition Xara

Webster also allows PNG files to contain simple transparency and interlacing. For details of how to create a PNG file, see Creating
PNG files.

Bitmap Size and Resolution
Color Depth

Area to Save

Interlacing

Transparent

Palette

Dithering

Number of Colors in Palette

RRFF339



PNG Export Dialog Box - PNG Transparency

If transparency is enabled the bitmap will be ‘transparent' in all areas not covered by a selected object. If the selection has been
chosen then this will be only the visible and selected objects. This makes it easy to remove the white background from exported
pictures and makes them ideal for publication on the World Wide Web.

If you create a transparent PNG file, one of the palette colors is used as the transparency. This means (for example) that a 2 color
PNG file contains one color and transparency.

Note that PNG transparency has a different meaning to Xara Webster transparency. This process does not take into account any
Xara Webster transparency applied to objects in the document.



#* Paste (Edit Menu)

&* CTRL+V
Paste copies objects from the clipboard into the center of the current view. The objects may originally have come from the same
document, they may have come from another document loaded in Xara Webster or they may even have come from another
document in another application. If the clipboard contains text, paste will place the text at the text cursor or overwrite the selected
region (as appropriate).

Tips
O+ You can paste an object into a document quickly by right clicking on the document to open the pop-up menu and selecting
Paste.
| The Paste menu item displays a brief description of what will be pasted, for example "Paste bitmap".
&+ You can also use the key shortcut SHIFT+Insert to paste objects from the clipboard.

Related Topics
Pasting objects from the clipboard



Paste Special Dialog Box

If when you Paste with data on the clipboard from another application and there is more than one format that the data could be
transferred as, the Paste Special dialog box will appear giving you a chance to choose the specific format that you require Xara
Webster to import. The highlighted format (always the top item in the list) is the one which is considered the "best" format to paste.

Choose the format which you prefer to paste, and then click the Paste button.
Alternatively, you may click Cancel to cancel the paste operation entirely.

Note

Once you have pasted into Xara Webster, the pasted data is remembered in order to make subsequent pastes faster (as importing
some clipboard data formats can take some time). This means the Paste Special dialog box will not appear again until you copy
new data to the clipboard from another application.

Related Topics
Pasting objects from the clipboard



3* Paste at Same Position

[3* CTRL+SHIFT+V
Paste at Same Position is identical to the normal Paste, but it pastes the clipboard contents into the same X-Y position on the work
area as they were cut or copied from. This is useful for moving items between documents. (This applies only to objects cut or
copied from Xara Webster.)

Pasting from Other Applications

Occasionally, when pasting into Xara Webster from another application, the data you are pasting can be transferred in several
different formats. For example, text copied from Microsoft Word can be pasted as "unformatted text", or as a "Windows metafile
picture”. If this is the case, the Paste menu items will read Paste... and selecting it will open the Paste Special dialog box so you
can choose how you want to transfer the data.

Related Topics

Pasting objects from the clipboard



Pasting objects from the clipboard

You can put the contents of the clipboard into a Xara Webster document.
&+ To paste objects from the clipboard

From the Edit menu, choose Paste.

The objects will be placed in the center of the Xara Webster window.

Tips
G+ If you want to paste the objects in the same place you cut or copied them from, press CTRL+SHIFT+V (Paste at same
position).
O+ You can use copy, cut and paste to move objects between documents and programs.
G+ Sometimes when you paste the contents of the clipboard into a Xara Webster document, it could be inserted using

several different formats. If this is the case the Paste Special dialog box will appear so you can choose a format.

Related Topics
Cutting and copying objects to the clipboard



Pop-up Menus Overview

Many commonly used Xara Webster functions can be found on the pop-up menu which appears when you right-click on a
document. Pop-up menus are also available in other areas of Xara Webster, for example in the Galleries.

View Pop-up Menu

When you right-click where there are no objects (for example on the work area or the margin) the pop-up menu allows you to set
up the document and the view onto it.

G View Pop-up Menu
Object Pop-up Menu

When you right-click on an object the pop-up menu offers options for that object. Note that right-clicking on an unselected object
will select it before showing the pop-up menu.

&+ Object Pop-up Menu



‘& Previous Zoom
E* CTRL+R
Previous Zoom takes you back to the last zoom magnification. It is a very useful way to switch between two magnifications.

Related Topics
Returning to the previous zoom



i
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The Push Tool lets you use the mouse to move a document within the window. The Infobar contains controls for zooming on the
document.

3* ALT+X or SHIFT+F8
Push Tool Infobar Controls

IEEEEHX vI

Zoom Magnification
Previous Zoom

Zoom To Drawing
Zoom To Selection

ek

Zoom To Work Area

Push Tool Operations
Moving the document
Returning to the previous zoom
Zooming in and out
Zooming to the selection
Zooming to the whole drawing
Zooming to the work area

Related Topics
Using the Push Tool temporarily



#* Put To Back (Arrange Menu)

F* CTRL+B
Moves every object in the selection to the back of the drawing.
Related Topics

Moving objects backwards and forwards



Putting Web files on WWW pages

Full information on how to embed Xara files in HTML for publication on the World Wide Web is included on the Xara web site.

Web Links
3+ Xara Web Files and HTML

[

&+ Creating Xara Web Files
[ o

| g Xara Web Format



O
Quality (Window Menu)

O+
The Quality submenu on the Window Menu, the Quality slider on the control bars and the Quality buttons on the control bars allow
you to alter the Quality setting (the way Xara Webster redraws documents). Low settings show the document in simple 'outline’
mode and high settings give a full color, anti-aliased view. There are also buttons available (they not on the default control bars -
see_Control Bar Customization) for each of the four main settings.
The Quality setting is also used when bitmaps are exported from Xara Webster. i.e. if the Quality setting is low, any bitmaps
exported will show the document in outline.

Related Topics

Changing the quality setting



Removing bitmaps from a document

Unused bitmaps are automatically removed when you close the document. You can also manually remove a bitmap if you are
running low on memory.
| To remove a bitmap from a document

1. From the Utilities menu, choose Bitmap Gallery.

2. Select the bitmap you want to delete.

3. Click the Delete button in the gallery.

Tip
| Deleting a bitmap from a document using Delete on the Edit menu will not remove it from the document completely. It will
remain in the Bitmap gallery until you delete it or save the document.

Related Topics

Bitmap Gallery



Removing objects from groups

If you have several objects in a group, you can remove one of them without ungrouping them all.
&+ To remove an object from a group

1. Choose the Selector Tool.

2. CTRL-click on the object in the group you want to remove.

3. From the Edit menu, choose Delete (or Cut if you want to move the object to the clipboard).

Tip
G When you CTRL-click on an object, it is selected even if it is inside another object. This is called select inside.

Web Link
&+ Selecting Objects
G+

Related Topics

Selector Tool



Removing transparency

If you have made an object transparent using the Transparency Tool, you can make it solid again by removing the transparency.
&+ To remove the transparency from an object

1. Select the transparent object (see Selecting objects).

2. Choose the Transparency Tool.
3. Choose 'No Transparency' from the Transparency Shape Field on the Infobar.

Web Links
3+ Transparency
&+

g Webster Movies - Transparency

Related Topics
Applying transparency

Transparency Tool



Removing web addresses from objects

If you have added a web address to an object, you can easily remove it.
&+ To remove a web address from an object

1. Select the object (see Selecting objects). You can select more than one.

2. From the Utilities menu, choose Web Address.

3. Click the Remove button.

Related Topics

Adding web addresses to objects



Reordering gallery items

Items in galleries can often be reordered simply by dragging the items within the gallery. The gallery contents can also be sorted
from the Gallery Sort dialog box accessible from the Options button in the gallery.

Tips
G+ You can also reorder sections within the galleries. See Reordering gallery sections.
G You can sort the Color Gallery and the Clipart Gallery.



Reordering gallery sections

You may prefer to have the sections of the Clipart, Bitmap and Color Galleries in a different order.
O+ To reorder a gallery section
Drag the title of the section in the gallery to its new position. The mouse pointer will show where the section will be positioned.

Tips
&+ You can also reorder items within each section. See Reordering gallery items.



Returning to the previous zoom

Often you want to zoom into a particular part of a document and then return to the previous zoom value. Alternatively you might
zoom out to view the entire drawing then return to the previous zoom value.
&+ To return to the previous zoom
Click the Previous zoom button on the control bars

Tips
O+ You can toggle between the two zoom values to zoom in and out onto your document.
G+ You can also choose Previous from the Zoom drop-down menu on the control bars. (See Zoom Magnification.)
i Previous Zoom is also available on the Zoom Tool and Push Tool Infobars.

Related Topics

Zooming in and out
Zoom Tool

Previous Zoom



Rotating objects

Objects can be rotated about their center or about a movable transformation center (see Moving the transformation center) :

What do you want to do?

&+ Rotate objects by dragging
| g Rotate objects accurately

Web Links
3+ Rotating Objects
&+

&+ Webster Movies - The Basics



O
Rotating objects accurately

This method of rotating objects lets you specify a precise angular rotation.
&+ To rotate objects accurately
1. Select the objects (see Selecting objects).
2. Enter the required rotation in the Rotation Field on the Infobar and press RETURN.

Tip
=+ You can also use the arrow buttons on the Rotation Field on the Infobar to rotate the selection in small increments.
G The objects will rotate around the transformation center.

Web Link

3+ Rotating Objects



&+
Rotating objects by dragging
This is an easy way of rotating objects as you can see the results as you drag.
&+ To rotate objects by dragging
1. Select the object or objects.
2. Ensure the selection handles are in rotate/skew mode (see Switching selection handle mode).
3. Do one of the following

G Drag the corner selection handles to rotate the selection around the transformation center.
O+ SHIFT-drag the corner selection handles to rotate the selection about its center.
Tips
| g CTRL-drag to constrain the angle of rotation. See Changing the constrain angle.
&+ To leave copies of the object as you rotate it, drag as normal, but click the right mouse button where you want each copy
(or press ' +' on the number keypad).
=+ To rotate the object but not any fill applied to it, press and release NumPad *-' during the drag. This is useful if you want to
rotate an object with a bitmap fill and not rotate the bitmap.
Web Link

&+ Rotating Objects
&+

Related Topics

Selecting objects
Using the Selector Tool temporarily



E Save (File Menu)

E* CTRL+S
Save saves the current document to disc as a Xara .web file. The current document is saved to the same file that it was opened

from or saved to. If the document is a new document that has not yet been saved, the Save As dialog box will appear asking what
file name you would like to use and where you want to save the file. for more information on creating Xara web files, click the web

link below.

Web Link
| g Creating Xara Web Files
&+

Related Topics
Saving documents



#* Save As (File Menu)

Save As dialog box allows you to save the current document as a Xara .web file to a named file. The new file can simply be
another file in the same folder or you can change the drive and folder so the document is saved in a completely different place. If
you want to save the document in a format other than .web, use Export on the File menu.

You can set some options when you save a .web file. Click the Options button to see them (click the Help button in the Options
dialog box for more information).

If you click on a .web file (or a .xar file), you will see a preview of it in the dialog box (if the file contains a preview).

If you are editing a drawing which is embedded in a document in another program, this menu item will read Save Copy As.

Selecting it allows you to save a copy of the drawing to disc without affecting the way it is embedded in the document in the other
program.

Web Link
3+ Creating Xara Web Files
=+

Related Topics
Saving documents



Save Options Dialog Box

Xara Web format is a compact but editable vector graphics format. For more information about web files, see the Xara Web Files
Overview. For information on creating Xara Web files, see Creating Xara Web files.

When you export a Web file, you have several options which allow you to remove information from the Web file to make it even
smaller.

Convert text to outlines
Convert blends to outlines
Remove preview bitmap
JPEG Quality Slider

Area to View

R399



Save Options Dialog Box - Area to View

The area to view sets the outline of the area to be shown when the .web file is displayed. For example, if you choose Selection,
when you display the Xara Web file on a web page, the selected objects will fill the whole web file area.



Save Options Dialog Box - Convert Blends to Outlines

If you select this option, any blends in your drawing will be converted to simple outlines.

At the time of writing (February 1997), Version 2 of Xara Ltd's Netscape and Internet Explorer plug-in renderer is on beta release.
The current beta cannot display blends and so Webster includes this option to allow you to create graphics that can be displayed.
The release version of the plug-in will display blends.



Save Options Dialog Box - Convert text to outlines

The person viewing your .web file may not have the same fonts as you. Selecting this option converts all text in fonts other than
Times, Arial and Courier (which all computers should have) to simple editable shapes. This makes the file larger but means that
the viewing program will display the text correctly. Note that converting text to outlines means you cannot load the .web file and
use the Text Tool to edit converted text.



Save Options Dialog Box - JPEG Quality Slider

When you save a document all the 1 bit and 4 bit bitmaps in the document are automatically compressed using lossless
compression and all 8 bit and 24 bit bitmaps are compressed using JPEG compression. JPEG is a more efficient way of
compressing bitmaps of this type but it does discard some information in the process. This is generally not noticeable, especially
when using high JPEG Quality settings.

When you save a document, all the 8-bit and 24-bit bitmaps in the document which have not already been converted to JPEG
bitmaps will be converted before they are placed in the file. The JPEG Quality slider controls the amount of compression. Low
values give the greatest compression but the most information loss. If you set the value to the highest, the bitmaps will not
compress so well, but will be very high quality. The slider will be dimmed if there are no bitmaps in the document that can be
compressed using JPEG compression.

Important: Once you have exported a Web file, you cannot reload it and export it again at a different JPEG Quality setting as all the
suitable bitmaps will have been converted to JPEG bitmaps already. When you re-export a file like this all the JPEG bitmaps stay
the same. Bitmaps are never recompressed using JPEG compression as this will cause the image to become distorted. So until
you have the JPEG quality setting at the level you want, remember to keep the document loaded.

Tip
O+ If you want to change the JPEG Quality for an individual bitmap, export it from Xara Webster as a JPEG file from the
Bitmap Gallery. In the JPEG Export dialog box, deselect the Use Original JPEG option and vary the JPEG Quiality until you get the
file size you want at the quality level you want. You can then re-import the bitmap and export the Web file.



Save Options Dialog Box - Remove Preview Bitmap

Xara Webster .web files include a preview bitmap which adds about 5KB to the size of the file. The advantage of including a

preview bitmap is that, for example, the Clipart Gallery and Open dialog box can show a thumbnail of the document. If you want
very small files, select this option.



Saving bitmaps from a document

You can save out any bitmap that is in a document.
&+ To save a bitmap from a document

1. From the Utilities menu, choose Bitmap Gallery.

2. Select the bitmap you want to save.

3. Click the Save button.

Tips
&+ You cannot make any changes to the color or size of the bitmap.
O+ This covers exporting an existing bitmap. You can also export any part of your document as a bitmap. See Creating
bitmaps.

Related Topics

Bitmap Gallery



Saving documents
Documents are saved by writing them to disc. The first time you save a document, you must give it a name and say which
directory to save it in. For subsequent saves Xara Webster remembers the document name and directory.
| To save a document
1. Make sure the document you wish to save is the current document. If it is not, click on it.
2. From the File menu, choose Save.

If you have not saved the document before, the Save As dialog box appears. You can then name the document and specify which
directory to save it in.

Tips
&+ To save a document using a different name, choose Save As from the File menu. This lets you create backups of your
documents.

G+ To save all the open documents, choose Save All from the File menu.
G To save the document in a different file format, use Export on the File menu.



Scaling objects

Objects can be scaled either by dragging with the mouse or more accurately using the controls on the Selector Tool Infobar :

What do you want to do?

[ Scale objects by dragging
| g Scale objects accurately

Web Links
| g Scaling Objects
&+

a3+ Webster Movies - The Basics



O
Scaling objects accurately

This method of scaling objects gives you precise size control.
&+ To scale objects accurately

1. Select the object(s) to be scaled (see Selecting objects).

2. Enter the required scaling (%) in the Scaling Field on the Infobar and press RETURN.

Tips

G+ To lock or unlock the aspect ratio of the selection select the Lock Aspect Ratio button on the Infobar.

G You can also enter values in the Dimensions Field on the Infobar and press RETURN.

O+ You can also use the arrow buttons on the Scaling Field on the Infobar to change the scaling in small increments.
Web Link

[ Scaling Objects



&+

Scaling objects by dragging

This is an easy way of scaling objects as you can see the results as you drag.
&+ To scale objects by dragging

1. Select the objects to be scaled (see Selecting objects).

2. Ensure selection handles are in Scale Mode (see Switching selection handle mode).
3. Do one of the following

&+ Drag a corner selection handle to scale away from the opposite corner.
O+ SHIFT-drag a corner selection handle to scale around the center.
G+ Drag a side selection handle to stretch in one direction.
G SHIFT-drag a side selection handle to stretch in both directions.
Tips
O+

If you select the Lock Aspect Ratio button on the Infobar, the aspect ratio of the selected object is locked when you scale
using the corner handles.

To leave copies of the object as you scale it, drag as normal, but click the right mouse button where you want each copy
(or press ' +' on the number keypad).

7

| To scale the object but not any fill applied to it, press and release ' - ' on the number keypad during the drag. This is useful
if you want to scale an object with a bitmap fill and not scale the bitmap.
Web Link
3 Scaling Objects
O

Related Topics

Using the Selector Tool temporarily



Searching a gallery

The Clipart Gallery contain hundreds a large number of pictures. You can easily search all of them for items of interest.
G To search a gallery

1. Click the Options button in the gallery.

2. Choose Find from the menu to open the Gallery Find dialog box.

3. Type in the text to search for.

4. Choose whether you wish to search just the names and keywords.

5. Click the Find First button to find the first match.

Click the Find Next button to continue searching.

Tips
&+ For more information on the search options, click the Help button in the dialog box.
| You can also search the Bitmap Gallery.

Web Link
g Webster Movies - Control Bars and Galleries

Related Topics
Clipart Gallery

Galleries Overview



See ...
You have chosen a "see..." item from the index.

If you see an item in the index that reads "see...", the information is listed under another heading. Use the scrollbars to move to the
item it suggests. For example, if the index reads "control bars, see bars" move up the index until you find "bars".

To go back to the index, click the Index button at the top of this window.



See also ...
You have chosen a "see also ..." item from the index.

If you see an item in the index that reads "see also...", there is more information listed under another heading. Use the scrollbars
to move to the item it suggests. For example, if the index reads "elliptical fills, (see also) fills" down up the index until you find "fills".

To go back to the index, click the Index button at the top of this window.



E* Select All (Edit Menu)

3* CTRL+A
Select All selects (see selection) every object in the current document.

Note
O The CTRL+A key shortcut functions differently when the Text Tool has been chosen.

Related Topics

Selecting objects



Selecting a single object

Selecting an object is usually the first step in changing one or more of its attributes.
&+ To select a single object

1. Choose the Selector Tool.

2. Click on the object.

Click to select the object under the mouse pointer

Tip
O+ Often you don't need to select an object. For example, you can change its color by drag-and-dropping the color from the
Color Gallery.
Web Links
o Selecting Objects
3
g Webster Movies - The Basics

Related Topics
Selector Tool

Using the Selector Tool temporarily



Selecting all objects

This is a quick way to select all the objects in your document. See Selecting objects for details of how to select individual objects.
&+ To select all objects

From the Edit menu, choose Select All.



Selecting characters in text objects

This lets you select one character from a line of text.
&+ To select a character in text objects

1. Choose the Selector Tool.

2. Click on the text object to select it.

3. Do one of the following :

&+ CTRL-click on the character ,
O+ ALT+CTRL-click on the character twice. The first click selects the line, the second click selects the character.
Tips
&+ You can also select a character by selecting a region of the text object with only one character in it. See Selecting part of a
text object.
G+ When a text character is selected, the Text Tool Infobar shows the attributes applied to it.
&+ A selected region of text remains selected even after a tool other than the Text Tool has been chosen. This makes it
simple to apply fills and transparency to selected text regions.
Web Link

[ Webster Movies - Text



O
Selecting items in a gallery

With Galleries you can perform operations on their contents (for example deleting bitmaps). Before these operations can be
applied, the items in the gallery must be selected. Selected items are highlighted.
| Selecting a Single Item

Click on the item
| Selecting Several Items

1. Click on the first item

2. CTRL-click on each subsequent item
| Selecting a Block of Items

1. Click on the first item in the block
2. SHIFT-click on the last item in the block. This selects all items between the first and last.

Related Topics

Galleries Overview



Selecting lines of text in text objects

This lets you select a single line of text in a text object.
G To select a line of text

1. Choose the Text Tool.

2. Place the pointer over the line of text.

3. Triple-click.
Tips
&+ When a region of text is selected, the Text Tool Infobar shows the attributes applied to the region.
=+ A selected region of text remains selected even after a tool other than the Text Tool has been chosen. This makes it

simple to apply fills and transparency to selected text regions.
You can also use the Selector Tool. Click on the text object to select it, then ALT+CTRL-click on the line to select it inside.

O+ In the Text Tool click in the text object. Then press CTRL+L to select all characters in the current line. See the List of Text
Tool keyboard shortcuts for a complete list.
Web Link
ca* Webster Movies - Text
O+

Related Topics

Text Tool Overview



Selecting objects

When you want to change an object, you will normally have to select it. Objects are selected and deselected using the Selector
Tool. When an object is selected selection handles are displayed on and around the selection. For information on more advanced
ways to select objects, click the Web Link below.

What do you want to do?

a3+ Select a single object
=+ Select several objects

a3+ Deselect objects

Web Links
| Selecting Objects
| g
g Webster Movies - The Basics

Related Topics
Using the Selector Tool temporarily

Selector Tool



Selecting part of a text object

By using different options you can select either the whole text object or just a part of it, even down to a single character.
To select part of a text object

1. Choose the Text Tool

2. Do one of the following :

R

| To select characters, click and drag over them.
O To select a word, double click on it.
O+ To select all the characters on a line, CTRL-click on it.
| To extend a select region, SHIFT-click either side of it.
&+ Move the text cursor to one end of the required region. Hold down SHIFT and use the cursor keys to select the required
region.
| Press CTRL+L to select all characters in the line containing the text cursor.
&+ Press CTRL+A to select all characters in the text object.
O+ Click in the text to insert the cursor at the start of the region and SHIFT-click at the end of the required region.
Tips
&+ When a region of text is selected, the Text Tool Infobar shows the attributes applied to the region.
g A selected region of text remains selected even after a tool other than the Text Tool has been chosen. This makes it

simple to apply fills and transparency to selected text regions.

Web Link
| g Webster Movies - Text



O
Selecting several objects

Xara Webster lets you select multiple objects. You can then, for example, move them all in one operation.
&+ To select several text objects
1. Choose the Selector Tool.

2. Do one of the following :

| Drag from an empty part of the work area to form a rectangle that envelopes all the required objects. When you release
the mouse button all the objects entirely contained within the rectangle will be selected.
g Click on the first object you wish to select and SHIFT-click on each subsequent object to swap it from not being selected

to being selected.

Tip

G SHIFT-clicking swap the object under the mouse pointer between selected and not selected.
Web Links

&+ Selecting Objects

=

g Webster Movies - The Basics

Related Topics
Selecting all objects

Using the Selector Tool temporarily



Se!

lecting text

What do you want to do ?

3. 9999

Select a whole text object
Select a line of text in text object
Select characters in a text object
Select part of a text object

eb Link

Webster Movies - Text



O
Selecting text objects

This selects the entire text object.

&+ To select a text object
Depending on which tool is currently selected, do one of the following:
&+ In the Selector Tool, click on the text object.
O+ In the Text Tool, click in the text object and press Escape.
Tips
O+ When text is selected, the Text Tool Infobar shows the attributes applied to the region.
O+ In the Text Tool you can also drag from the start of the text object to the end.
Web Link
3 Webster Movies - Text
O

Related Topics
Selector Tool
Text Tool



» Selector Tool - Dimensions Field
WITEZem |k
Hl1 -58cm |=
The Dimensions Field on the Selector Tool Infobar shows the dimensions of the selection. Its values alter dynamically if you scale
or stretch the selection.
You can also resize the selection by :
&+ Typing into the fields and pressing RETURN,
O+ Clicking the arrow buttons.
If you select the Lock Aspect Ratio button, the ratio between the Width and Height is fixed.

Related Topics
Selector Tool

Stretching objects

Scaling objects
Units Overview



» Selector Tool - Flip Buttons
i =

The Flip buttons on the Selector Tool Infobar flip the selection either vertically or horizontally. Both horizontal and vertical flips
reflect the selection about the transformation center. This will usually pass through the center of the object unless it has been
moved.

Related Topics
Flipping Objects



= Selector Tool - Lock Aspect Ratio Button
}m

The Lock Aspect Ratio button on the Selector Tool Infobar locks the aspect ratio of the selected objects when you scale them
using the corner selection handles. When the button is pressed in, the ratio is locked. When the button is pulled out, the height and
width of the selection can be altered independently.

Related Topics
Scaling objects
Stretching objects



= Selector Tool - Position Field

A EEEETET
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The Position Field on the Selector Tool Infobar shows the coordinates of the bottom left corner of the bounding box of the selection

relative to the bottom left corner of the work area. It updates dynamically as you drag the selection.
You can also move the selection by :

g Typing into the fields and pressing RETURN,

| Clicking the arrow buttons.

Related Topics
Moving objects

Units Overview



= Selector Tool - Rotate/Skew Mode Button
b

The Rotate/Skew Mode Button on the Selector Tool Infobar sets the mode of the selection handles around the selection. When the
button is pressed in, the selection handles are in Rotate/Skew mode and when the button is pulled out selection handles are in
scale mode. Clicking on a selected object with the Selector Tool chosen will swap the selection mode between Rotate/Skew mode
and Scale mode - this is usually easier than using the Rotate/Skew mode button. For more details, see Switching selection handle
mode.

Related Topics
Selector Tool
Rotating objects
Scaling objects
Stretching objects
Skewing objects



= Selector Tool - Rotation Field
SO Jam

The Rotation Field on the Selector Tool Infobar lets you rotate the selection. To rotate the selection :

O+ Type a value in degrees into the field and press RETURN.
O+ Click the arrow buttons.

Positive angles rotate the selection anti clockwise; negative angles clockwise. The rotation is centered around the transformation
center. This will usually be in the center of the selection unless it has been moved.

Related Topics
Rotating objects



» Selector Tool - Scaling Field

100 | %

100 |2

The Scaling Field on the Selector Tool Infobar is used to scale the selection. Entering a value into the field and pressing RETURN
scales the currently selected objects.

The Lock Aspect Ratio button to the right of the Scaling Field locks the aspect ratio of the selected objects. What this means is
changing one of the scaling vales will change the other by an equal amount so the objects are the same shape. This lets you scale
objects without distorting them. To scale just the width or height of the selection, turn aspect ratio off.

The scaling is centered around the transformation center. This will usually be in the center of the selection unless it has been
moved.

Related Topics

Scaling objects
Stretching objects



= Selector Tool - Skew Field
i (O 3 PN

The Skew Field on the Selector Tool Infobar is used to skew the selection. To skew the selection :

O+ Type a skew angle and press RETURN.
| g Click the arrow buttons to skew the selection.

Positive values skew the selection above the transformation center to the right. Negative values skew the selection above the
transformation center to the right. The skew takes place along a horizontal line through the transformation center. This will usually
mean a horizontal line through the center of the selection unless you have moved the transformation center.

Related Topics
Skewing Objects



= Selector Tool - Transformation Center Grid

3+
Transformation Center Grid on the Selector Tool Infobar to move the transformation center. Clicking on one of the nine buttons

moves the transformation center to the equivalent position on the selection. For example, pressing the central button moves the
transformation center to the center of the selection. For more details, see Moving the transformation center.

Related Topics
Selector Tool

Rotating objects
Skewing objects
Flipping objects



| pd
= Selector Tool

The Selector Tool is the primary tool in Xara Webster. It is used for selecting, rotating, moving, skewing, stretching, flipping and

scaling objects as well as other editing.

The Selector Tool displays selection handles which you can use to easily rotate, scale and skew the objects you have selected.
3* F2 or SPACEBAR or ALT+S

Selector Tool Infobar Controls

| g Rotate/Skew Mode or Scale Mode
3+ Transformation Center Grid
| g Position
=+ Dimensions
100 | %
100 [ Scaling
[ Lock Aspect Ratio
| g Rotation
ir) Skew
g Elip
Web Link
g Webster Movies - The Basics

Selector Tool Operations
Switching selection handle mode
Selecting objects
Moving objects
Rotating objects
Scaling objects
Flipping objects
Stretching objects
Skewing objects
Using the Selector Tool temporarily

Moving the transformation center



Setting document options

This lets you change the options for documents loaded in Xara Webster.
&+ To set document options

1. From the Utilities menu, choose Options. See Options for details on the settings available.

2. Change the options as required.

3. Save the document.

Tip
&+ Some of the options in the Options dialog box refer to a specific document and some are general options which apply to
the program. The ones that apply to the document have the document name written above them.



Setting program options

Program options affect how Xara Webster works.
&+ To set program options

1. From the Utilities menu, choose Options. See Options for details on the settings available.

2. Change the options as required.

Tip
&+ Some of the options in the Options dialog box refer to a specific document and some are general options which apply to
the program. The ones that apply to a specific document have the document name written above them.



++% Show Grid (Window Menu)
O+

Show Grid sets whether or not the grid is displayed. A tick next to the option denotes that the grid is shown. For more details, see
Displaying the grid.

Related Topics

Enabling grid snapping



Skewing objects

Objects can be skewed along their edges, along a line parallel to their edges passing through the center of the selected objects or

along a line parallel to their edges passing through the transformation center, either using the mouse or, accurately, using the
Infobar.

What do you want to do ?

| g Skew objects by dragging

3+ Skew objects accurately
Web Links

3+ Skewing Objects

[ o

[ Webster Movies - The Basics



&+

Skewing objects accurately

This method of skewing objects gives you precise control.
&+ To skew objects accurately

1. Choose the Selector Tool.

2. Select the objects to be skewed.

3. Move the transformation center onto the required horizontal skew axis.

4. Do one of the following :

&+ Enter a skew angle (in degrees) in the Skew Field on the Infobar and press RETURN.
| g Use the Skew field arrow buttons on the Infobar.
Web Link
| g Skewing Objects
0+

Related Topics

Moving the transformation center



Skewing objects by dragging
1. Select the objects to be skewed (see Selecting objects).

2. Ensure the selection handles are in Rotate/Skew mode (see Switching selection handle mode).
3. Do one of the following :

&+ Drag the side selection handles to skew the object with opposite side used as a base line.
g SHIFT-drag the side selection handles to skew the selection about its center.
Tips
| The skew angle (see General Options) can be constrained by pressing CTRL during the drag.
&+ To leave copies of the object as you skew it, drag as normal, but click the right mouse button where you want each copy
(or press '+' on the number keypad).
G+ To skew the object but not any fill applied to it, press NumPad ' - ' during the drag. This is useful if you want to skew an
object with a bitmap fill without skewing the bitmap.
Web Link
3 Skewing Objects
O

Related Topics
Using the Selector Tool temporarily



321 Snap to Grid (Window Menu)
#* Number Keypad .
Snap to Grid sets whether or not objects drawn will automatically lock onto the grid in the document.
If the option is selected, items will lock onto the grid. Snap to Grid is also available from the View Pop-up Menu.

Tip
O The key shortcut only works if NumLock is enabled on your keyboard.

Related Topics
Enabling grid snapping

Displaying the grid



Standard Control Bar

& New

| g Open

3+ Save

| Delete

- Undo

o Redo

&+ Zoom Magnification

[ Previous Zoom
| g Zoom To Drawing
3+ Line Width

[ Color Editor

| g Quality

Related Topics
List of the Default Control Bars



Status Line Overview

1 text .uhiet:t: Click zelect; Click to clear selection; Drag o marquee select | 25005, 31.5pix ,}jl

The Status Line shows you what objects you have selected and described what you can do next. If you perform a longer
operation, the Status Line will show you its progress. You can change the size of the Status Line using Control Panel (see
Customizing the appearance of Xara Webster). The Status Line is an ideal companion to learning how to use Xara Webster.

Mouse Position

he current position of the mouse pointer in the document relative to the bottom left-hand corner of the work area. The position
is displayed in pixels.



Stretching objects

You can stretch objects by either scaling or skewing them.

What do you want to do?

3+ Scale objects
| g Skew objects



Switching selection handle mode

Selection handles allow basic manipulation of the selected objects. They operate in two modes, Scale Mode and Rotate/Skew
Mode. The former allows the selection to be scaled and stretched and the latter allows it to be rotated and skewed.

To swap selection handle mode

&+ Click the Rotate/Skew Mode Button button on the Selector Tool Infobar.
or
&+ Click on one of the objects in the selection.

Web Link

3+ Webster Movies - The Basics



| g

Technical Support
Registered owners of Xara Webster can get free technical support from Xara Ltd. For more details, click the web link below.

Web Links
a3+ Technical Support



=
= Text Tool - Bold Button

When this button on the Text Tool Infobar is depressed, the Bold attribute is applied to the text. For more information, see Making
text bold.

3* CTRL+B
Note
The keyboard shortcut only works when the Text Tool is the current tool.

Related Topics
Text Tool



= Text Tool - Center Justification Button

This button on the Text Tool Infobar sets the justification of text. When it is depressed, the text is centrally aligned around the point
where you started typing. For more information, see Justifying text.

Related Topics

Text Tool



=+ Text Tool - Font Field
Ifﬁ_‘ Times MNew Fh:umanj

This field on the Text Tool Infobar shows the current text font (typeface). Choose from the drop-down list to change the font. For
information on changing the text font, see Changing text font.

On the left-hand side of the font is an indicator which shows the format of the font :

it
T

Adobe Type Manager (ATM) Type 1

TrueType

If a font is listed with a ' * ' displayed next to it, this means the font required for the current document cannot be found. This may be
due to it not being installed on your system or the font file being corrupt. It may be possible to solve this problem by reinstalling the

font. For a full list of fonts used in a document, see Document Info.

Related Topics
Text Tool



= Text Tool - Font Size Field

|1E|:|t TI

This field on the Text Tool Infobar shows the current point size of text. For information on changing the size of text, see Changing
the size of text. You can type values into this field in any unit, e.g. "2cm®.

Related Topics
Units Overview
Text Tool



= Text Tool - Italic Button

i
When this button on the Text Tool Infobar is depressed, the ltalic (slanted) attribute is applied to the text. For more information,

see Making text italic.

3* CTRL+I
Note
The keyboard shortcut only works when the Text Tool is the current tool.

Related Topics
Text Tool



= Text Tool - Left Justification Button

This button on the Text Tool Infobar sets the justification of text. When it is depressed, the text is justified so that its left-hand edge
is aligned with the point where you started typing. For more information, see Justifying text.

Related Topics
Text Tool



» Text Tool - Line Spacing and Tracking
I[T00% | =|a
.T.

b ES

Line Spacing
This control on the Text Tool Infobar changes the spacing between lines in text objects. It always affects entire lines of text, so if
you change the line spacing of a selected section of a text object, it will affect all the lines the selection covers. For more

information, see Changing the spacing between lines of text

Baseline Shift
Changing the baseline shift of part of a text object text moves it vertically. See Changing the baseline shift of text for more
information. You can type values into this field in any unit, e.g. "2cm".

Related Topics
Units Overview
Text Tool



» Text Tool - Right Justification Button

This button on the Text Tool Infobar sets the justification of text. When it is depressed, the text is justified to the right of the point
where you started typing. For more information, see Justifying text.

Related Topics
Text Tool



*

"I Text Tool

With the Text Tool you can create text objects consisting of one or many lines of text and alter existing text objects. With the Text
Tool selected, the Infobar shows the text attributes of the selected objects.

C3* F8
&+ If there is a selected region of text, any change to a text attribute applies to that region.
| Otherwise, the change applies at the text cursor. Start typing and the text appears with the changed attribute.

If there is a selected region of text, the Infobar shows the attributes that apply to the region. If multiple values for one attribute have
been applied, the field is blank, for example if the selected region includes both 10pt and 12pt text, the Font Size field is blank.
When the cursor is visible, the Infobar shows the attributes that will apply when you type a character.

Text Tool Infobar Controls

a3+ Font
Font Size
Bold
Italic

Left Justification
Center Justification

Right Justification

il 3y~ 5 ﬂ

100% | »|a
ol |23 Line Spacing and Baseline Shift

—+ 4

Text Tool Operations
Creating text.
Editing text
Selecting text
Applying attributes to text
Typing international characters
Changing text font
Changing the size of text
Making text bold
Making text italic
Justifying text
Changing the spacing between lines of text
Changing the baseline shift of text

List of Text Tool key shortcuts



Timing Xara Webster redraw
To find out how to time how long Xara Webster takes to redraw a document, click the web link below.

Web Link
[ Timing Redraw



O
Tip of the Day (Help Menu)

Choosing Tip of the Day from the Help menu opens the Tip of the Day dialog box containing a tip on how to use Xara Webster.

Tell Me More

Clicking this button will take you from the Tip of the Day dialog box to a page in the Xara Webster help which explains the tip in
more detail.

Next Tip
Clicking this button takes you to another tip.

Related Topics
Turning Tip of the Day on and off



Tools

Tools are the main method of drawing objects and editing your documents. When you choose a tool, it customizes the Infobar to
show information and controls relevant to that tool. For example, when you choose the Text Tool, the Infobar only shows text
controls.

The currently chosen tool defines which actions can be performed on the document. The following are the buttons used to choose
Tools; they are displayed on the Toolbar.

Selector Tool
Transparency Tool
Text Tool

Push Tool

Zoom Tool

33359

To remove a Tool button from the Toolbar, ALT-drag it and drop it away from the control bars. If you like you can copy or move Tool
buttons to other control bars. For more details, see Control Bar Customization.



= Transparency Tool - Transparency Shape Field

ILinear - I

Transparency Shape field is always present on the Transparency Tool Infobar. It sets the transparency shape of the currently
selected objects.
The options available are :

&+ No Transparency
O+ Flat Transparency
0+ Linear transparency
O Circular transparency

Related Topics
Transparency Tool



= Transparency Tool - Transparency Level Slider

End Tranzp """'j"'|5?°/o

| These controls are only displayed on the Transparency Tool Infobar for some types of transparency.




O+

_I_
't Transparency Tool

With the Transparency Tool you can give objects levels of transparency using flat, linear or circular transparency.
3* F6
Transparency Tool Infobar Controls

| g Transparency Shape

End Tranzp """'j"'E?K

Transparency Tool Operations
Applying transparency
Removing transparency

Transparency Level

Web Link
| g Transparency
&+

Notes

G Using transparent objects in drawings will result in slower redraw.



Turning Tip of the Day on and off

When you start Xara Webster the Tip of the Day dialog box appears showing a tip on how to use the program. If you do not want
to see Tip of the Day every time you start Xara Webster, you can turn it off.

&+ To turn Tip of the Day off
When the Tip of the Day dialog box appears, deselect the "Show tips on startup” option.
G+ To turn Tip of the Day on

1. From the Help menu, choose Tip of the Day.
2. Select the "Show tips on startup” option.



Typing international characters
To find out how to type international and accented characters with Xara Webster, click the web link below.

Web Link
g Typing International Characters

Related Topics
Text Tool



Undo and Redo (Edit Menu)

Undo

|
@* CTRL+Z or '<'
Any changes you make to a Xara Webster document can be undone. The recorded undo information is not saved with the

document and so, if you save a document and later reload it you will no longer be able to undo changes you made before the
Save.

Redo

G+
[3* CTRL+Y or *>'

At any time when you have Undone some changes you can choose to redo them again. This is very useful because it gives you
the ability to change your mind about an edit as many times as you like.

Undo and Redo always show a brief description of what will be undone or redone. For example "Undo Delete".

Note

The < and > key shortcuts do not work when the Text Tool has been chosen.



Undoing and redoing operations

As you make changes to your drawing you can undo them to return to an earlier stage. You can also redo changes which you have
undone.
| To undo and redo operations
1. Select the document where you want to undo or redo operations.
2. From the Edit menu, choose Undo or Redo.
Tip
| However far you go back through undo steps, as soon as you edit the document yourself you will no longer be able to
redo any of those steps.



3* Ungroup (Arrange Menu)
E* CTRL+U
Ungroup separates all selected groups into their constituent objects.

Related Topics
ungrouping objects

Grouping objects



Ungrouping objects

This separates objects currently joined as a group. for details on how to select an object inside a group, click the web link below.
&+ To ungroup objects

1. Select the group.

2. From the Arrange menu, choose Ungroup.

Web Link
3+ Selecting Objects
&+

Related Topics
Grouping objects

Removing objects from groups



Units Overview

Xara Webster has a high level of support for units of measurement. Units are used widely throughout the program. Whenever a
field is visible showing a measurement in units, you can type in a value using any unit of the supported units. For example, you
can type "10pix", "2pt" or "4cm" into the Font Size field on the Text Tool Infobar. The default Xara Webster units are :

"pix" Pixels (1/96 inch). Page measurements are always shown in pixels in Xara Webster.
"mm" Millimeters

"cm" Centimeters

"m" Metres

"in" Inches

"ft" Feet

"yd" Yards

"pt" Points (1,000 mp or 1/72 inch)
"pi* Picas (12,000 mp 1/6 inch)
"mp" Millipoints (1/72,000 inch)

"mi" Miles

"km" Kilometers

With the full CorelXARA package, you can create your own custom units in addition to these.



Updating the Clipart Gallery

You can update the web clipart in the Clipart Gallery and also the web clipart (to see if any new clipart has been added to the Xara

Ltd. web site).
| To update your own clipart

1. From the Utilities menu, choose Clipart Gallery.
2. Click on the heading of the section you want to update. You can CTRL-click on additional sections.
3. Click the Add button.

4. Click the Update button.
&+ Updating the web clipart

1. From the Utilities menu, choose Clipart Gallery.
2. Click the Web Clipart button.

Any new clipart that has been added to the Xara Ltd. web site will be added to the gallery. You can tell which ones have been
added because the folder contains the word ‘New".

Related Topics
Clipart Galler

Adding clipart to the clipart gallery



Use HelpPages and Movies From CD (Help Menu)

Throughout Xara Webster's help are Web Links which you can click to open Xara Webster help pages on the Internet. If you have
installed Xara Webster from a CD, you can select this option so Xara Webster does not connect to the Internet, but takes the help

web pages and movies from the Xara Webster CD. Remember to put the Xara Webster CD in your CD drive before you click any
Web Links.

If you select this option, both the Movies and Webster Help Pages items on the Xara On the Web submenu (on the Help menu) will
work without connecting to the Internet.

Note
O+ This option is not present unless you have installed Xara Webster from a CD.



Using the Background Textures
The web clipart for Xara Webster includes some bitmaps you can use as textured backgrounds for your web pages. to find out
how to use them, click the web link below.

Web Link
&+ Using the Background Textures



&+

Using the Push Tool temporarily

The Push Tool can be used temporarily - alleviating the need to manually choose the previous tool afterwards.
O+ To use the Push Tool temporarily

1. Press and hold down ALT+X to swap to the Push Tool.

2. Use the Push Tool as required. See Moving the document.

3. Release ALT+X to return to the previous tool.

or

1. Press and release ALT+X to swap to the Push Tool.

2. Use the Push Tool as required.

3. Press and release ALT+X again to return to the previous tool.

Related Topics

Push Tool



Using the Selector Tool temporarily

The Selector Tool can be used temporarily - alleviating the need to manually choose the previous tool afterwards.
G To use the Selector Tool temporarily

1. Press and hold down ALT+S to swap to the Selector Tool.

2. Use the Selector Tool as required.

3. Release ALT+S to return to the previous tool.

or

1. Press and release ALT+S to swap to the Selector Tool.

2. Use the Selector Tool as required.

3. Press and release ALT+S again to return to the previous tool.

or (except from the Text Tool)

1. Press and hold down the Space Bar to swap to the Selector Tool.

2. Use the Selector Tool as required.

3. Release the Space Bar to return to the previous tool.

or (except from the Text Tool)

1. Press and release the Space Bar to swap to the Selector Tool.

2. Use the Selector Tool as required.

3. Press and release the Space Bar again to return to the previous tool.

Related Topics

Selector Tool



Using the Zoom Tool temporarily

The Zoom Tool can be used temporarily - alleviating the need to manually choose the previous tool afterwards.
G To use the Zoom Tool temporarily

1. Press and hold down ALT+Z to swap to the Zoom Tool.

2. Use the Zoom Tool as required.

3. Release ALT+Z to return to the previous tool.

or

1. Press and release ALT+Z to swap to the Zoom Tool.

2. Use the Zoom Tool as required.

3. Press and release ALT+Z again to return to the previous tool.

Related Topics

Zoom Tool



Using the keyboard

In these help pages, keys are shown in upper case. For example CTRL is the Control key.
Combinations of keys are shown like this: CTRL+A. This means :

1. Press and hold down the CTRL (Control) key.

2. Press and release the A key.

3. Release the CTRL key.

The Constrain Key

The CTRL (Control) key has a special function in Xara Webster. It constrains the action of the current operation in some way. For
example, normally you can rotate an object through any angle. Hold down CTRL and the rotation is constrained to preset angles
(defined in General Options). Similarly constraining the creation of an ellipse creates a circle.

The ALT keys
Most keyboards have two ALT keys. The right-hand ALT key is interpreted by Windows as CTRL+ALT. Xara Webster cannot alter
this behavior. As a result Xara Webster operations involving the ALT key only function using the left-hand ALT key.

Related Topics
List of Keyboard Shortcuts



Utilities Menu

Color Gallery
Bitmap Gallery
Clipart Gallery

Color Editor

Web Address

R 3 3 3737

Options



View Pop-up Menu

If the pop-up menu is opened with the mouse pointer over a blank area of the document or an unselected handle, it contains the
following :

| g New View

Quality
Show Grid

Work Area Options

3 3 3%

Related Topics

Pop-up Menus Overview



Viewing document information

You can view a dialog box that gives you a variety of information about the current document.
G+ To view the document information

1. Ensure the document is the current document. If it is not, click on it.
2. From the File menu, choose Document Info.

Tips
O+ This dialog box lists all the fonts used in the document. An * by the name of a font means it is not installed on your
computer.
&+ You can type into the Comments field. Comments are saved with the document and are an easy way of including notes

with a document

Related Topics

Document Info



Viewing several document at once

Do one of the following :

O+ From the Window menu, choose Arrange Views. This will place all the document views so you can see them all at once.
&+ From the Window menu, choose Cascade. This will place all the document views in a diagonal line so you can see all
their title bars.
| Drag the title bars of the document views and resize them so you can see the ares you need to.

Tip
| If you have a document open, but don't need to see it, minimize it to an icon. If you use Arrange Views now, the minimized

document will stay at the bottom of the screen.



#* Web Address (Utilities Menu)

[#* CTRL+SHIFT+W
With this dialog box you can add web addresses to objects in documents so when the document is displayed on a web page,
clicking on objects takes you to other pages. For more information, see Adding web addresses to objects.

| g Add / Change

O Remove

Note
g You can also open the Web Address dialog box by right-clicking on an object to open the pop-up menu and choosing Web
Address.

Web Link

g Adding Web Addresses To Objects

Related Topics
Xara Web Files Overview



Web Address Dialog Box - Add/Change Button

Clicking the Add button sets the web address of the selected objects to the address shown in the dialog box. If the object already
has a web address assigned to it, this button is labeled Change.



Web Address Dialog Box - Remove Button

Clicking the Remove button removes the web address from all the selected objects.



Web Links and Web Clipart

Xara Webster is an Internet connected program. The help contains web links that take you from the help onto the Xara Ltd web
site and with Xara Webster's Clipart Gallery you can download clipart from our web site.

If you have installed Xara Webster from a CD, you can select the Use Help Pages and Movies From CD option (on the Help menu)
so Xara Webster opens the help web pages and movies from the CD instead of connecting to the Internet. Some links will always
go to our web site and not be taken off the CD, like the Xara Ltd home Page. Note that the pages on the Internet are always more
up-to-date than those on the CD.

Internet Connections

When you click a web link or the Get Clipart button in the Clipart Gallery, your machine will try to connect to the Internet. If your
browser starts up and says it cannot find the Xara web site or Xara Webster just ays "Looking for host..." when you click the Get
Clipart button, you will need to connect to the Internet manually and, once connected, click the button or link again. This problem
occurs because your machine is not set up to connect to the Internet transparently when it needs to. If you normally have to
connect to the Internet manually before you browse the web, you will need to manually connect before using any of the Internet
connected parts of Xara Webster (web link in the help and web clipart).

You can set your machine up to connect automatically when you access ther Internet. You Internet service provider will be able to
tell you how to do this.

Default Browser

When you click a web link or select a web item off the Help menu, the web browser that opens is your default browser. If you want
web pages to open in a different browser, you will need to change your default browser.

-- Internet Explorer: Select Options from the View Menu. Open the Programs tab ad select the "Internet Explorer should check to

see if it is the default browser" option. If you now restart Internet Explorer, it will ask you if you want to set it as your default
browser.

-- Netscape Navigator: To set this as your default browser, you will need to re-install it.



Welcome to Xara Webster

Xara Webster is a shareware tool for Windows 95 and Windows NT 4 designed to help you create high quality Internet graphics.
Typically you'll do this by taking clipart that we provide in the Clipart Gallery, dragging it onto the page, then manipulating it in
whatever way you want (such as changing its color, size, adding your own text, etc.), and finally outputting the image as an anti-
aliased GIF or JPEG bitmap.

Of course Webster can do much more than that. You can create animated GIFs, by saving your image as a bitmap into the Bitmap
Gallery, adjusting the image slightly, saving the next frame into the gallery. In this way, you can build up a series of animation
frames. Finally you can select all the frames and output the whole sequence as an animated GIF.

Xara Webster includes an advanced color reduction system. Judging by the number of poor quality images on the Web, this area,
like anti-aliasing, is one of the least understood areas of Web graphics. To this end you can use Xara Webster to create GIF
images (from any source - a loaded bitmap, or a Webster clipart item) that are color reduced, but palette optimized, anti-aliased
and dithered, so you have full control over that delicate balance of quality versus size.

Finally Xara Webster supports the new open .web compact vector format for Web graphics. It can read and write .web files, and
includes a web browser plug-in for enabling these files to be viewed in any web browser. For more details, see the Xara Web Files
Overview.

If you ever need any help using Xara Webster, try the Getting help page.

Web Links
| Movies
| g
| g Xara Webster Home Page
| g
&+ Xara Home Page
&+
| g Click here to email us your suggestions for Xara Webster

&
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XARA
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Program designed and developed by Xara Ltd. For more information about the Xara company and its products click here.
Alternatively, visit our World Wide Web pages at http://lwww.xara.com/

Shareware

Xara Webster is a shareware product. Please read these conditions before using the software or graphic images. If you use the
software or graphics you agree to become bound by these conditions. If you do not wish to do so, do not use the software or
graphics.

This licence grants you the right to use the Xara Webster software and graphic images, subject to the restrictions listed below and
the disclaimer relating to warranties, support and damages.

1) Disclaimer:

This software is provided on an "as is" basis, without any other warranties, or conditions, express or implied, including but not
limited to warranties of merchantable quality, merchantability or fitness for a particular purpose, or those arising by law, statute,
usage of trade or course of dealing. The entire risk as to the results and performance of the Product is assumed by you. Neither
we nor our dealers or suppliers shall have any liability to you or any other person or entity for any indirect, incidental, special or
consequential damages whatsoever, including but not limited to loss of revenue or profit, lost or damaged data or other
commercial or economic loss, even if we have been advised of the possibility of such damages or they are foreseeable; or for
claims by a third party. You may have other rights which vary from state to state.

2) Restrictions:

This licence gives you the right to use this software but all rights not specifically mentioned in this agreement, including ownership
rights, intellectual property rights, trademarks and copyright, are reserved by Xara Ltd. You may not decompile, reverse engineer,
disassemble or otherwise reduce the software to a human perceivable form. You may not modify, rent or resell for profit the
software, or create derivative works based upon the software.

3) Graphics:

Xara Webster users are free to use, modify and publish the images from the free galleries on the Xara Webster web site and the
Xara Webster CD, on web sites where the image is embedded for viewing purposes or in printed material, subject to the following
conditions: They cannot be redistributed in any form, whether commercial, shareware or freeware, specifically but not exclusively
they cannot be included in clip-art collections, whether on web sites or distributed on electronic media such as CDs or discs.

© 1997 XARALTD.
Any reproduction of the CD version of the Xara Webster software is prohibited. The unregistered downloadable version of the Xara



Webster software, and the CD/downloadable versions of the XaraCube screensaver, the plug-ins and the movies can be
reproduced and redistributed or additional copies can be downloaded from Xara Webster Home Page. Use of the graphic images
is governed by the conditions set out below. For any further information please contact Xara Ltd.

Xara Webster On-line documentation - Version 1.0 (issue 1)

Xara is a trademark of Xara Ltd

Redistributable portions of Microsoft MSVC and MFC are copyright of Microsoft Corporation.

Microsoft, MS-DOS, Excel and Windows are registered trademarks of Microsoft Corporation.

Freehand is a registered trademark of Macromedia Inc.

Adobe, Adobe Type Manager, Adobe PhotoShop, Adobe lllustrator 88, Adobe lllustrator 3.0, PostScript and Encapsulated
PostScript are registered trademarks of Adobe Systems, Inc.

CompuServe is a registered trademark of CompuServe Incorporated.

WordPerfect is a registered trademark of Novell Corporation.

TrueType is a registered trademark of Apple Computer, Inc.

Acorn is a trademark of Acorn Computers Ltd.

CorelDRAW are trademarks of Corel Corporation. Corel is a registered trademark of Corel Corporation.
Corel is a registered trademark of Corel Corporation.

All other trademarks or registered trademarks are the property of their respective owners.



Window Control Bar

[ Zoom To Work Area
| g Zoom To Drawing
3+ Zoom To Selection
[ New View

| g Show Grid

3+ Snap to Grid

[ Anti-aliased Quality

| g Normal Quality

3+ Simple Quality

[ Outline Quality

Related Topics
List of the Default Control Bars



Window Menu

R 5 3 3 QR35

New View
Arrange Views

Cascade
Arrange Icons
Control Bars

Quality
Show Grid

Snap to Grid



3* Work Area Options

To open the Work Area Options, choose Options from the Utilities menu and click on the Work Area tab. You can also access them
by right-clicking on the work area in your drawing to open the pop-up menu and choosing Work Area Options.

Work Area

The work area size sets the area on screen you can use to create your drawing. Just type in how many pixels you want your
drawing to be horizontally and vertically. For more details, see Changing the work area size.

Related Topics

Options



Xara On The Web (Help Menu)

The items on this submenu take you to pages on the Xara Ltd. web site.

The Movies and Webster Help Pages items will work from the Xara Webster CD if you select the "Use Help Pages and Movies
from CD" option on the Help menu.

Web Link
| g Xara Home Page



| g
Xara Web Files Overview

The Xara Web format is a vector graphics format designed specifically for the Internet. Xara Web Files (.web) are very small and
because they are vector files, they can be displayed at any resolution without any loss of quality. If you put a Xara Web file on a
web page, you can zoom in on it to over 25,000% magnification, just like you can with Xara Webster. As Xara drawings are made
up from objects, you can easily assign a web address to an object so when you click on the object on a web page, it will take you
to another page.

For more details on the Xara Web format and how to create web files using Xara Webster, click one of the links below.

Web Links
Xara Web Format

Creating Xara Web Files
Xara Web Files and HTML

QR385

Related Topics
Adding web addresses to objects



Xara Webster Help (Help Menu)

G* F1
Choose Xara Webster Help from the Help Menu or press F1 to open Xara Webster Help.



Xara Webster help - empty page

If you have reached this page, there is a fault with the help system in Xara Webster. Please make a note of what you did to reach
this help page and report this as a fault in Xara Webster to Xara Ltd. You can email us using this address : websterbug@xara.com.



Zero Width Lines Overview

If you need a zero width line, you will usually find it is better to remove it by giving it a color of 'no color' rather than explicitly setting

the line width to zero.
3+ To set the color of a line or outline to 'no color*

1. Select the object.

2. From the Utilities menu choose Color Editor.

3. Ensure the Fill/Line button is pressed in so you can edit the line color.

4. Click the No Color button in the Color Editor.

Zero width lines are printed with a width of one device pixel. So, for example on a laser printer they will only just be visible, but on

an image setter (which has a much higher resolution) the line will be too thin to see. When you import a file containing zero width
lines, Xara Webster converts them to 0.25 point (this does not happen if you open or import a Xara Webster file).

Related Topics
Change an object's line color



Zoom Magnification

This drop-down list allows you to choose a a pre-defined zoom, or type in a user defined zoom value. It also contains options for
zooming to the work area, drawing and selection and returning to the previous zoom. It is available on the control bars and the
Zoom Tool and Push Tool Infobars.

25,601%
16,000%
8,000%
4,000%
2,000%
1,000%
500%
200%
100%
75%
50%
25%
10%
Work Area
Drawing
Selected
Previous

RRF33333R3333333737

Related Topics
Zoom Tool
Push Tool



3* Zoom To Drawing

Zoom To Drawing changes the zoom magnification so your drawing fills the window. See Zooming to the whole drawing for more
details.



3* Zoom To Selection

[3* CTRL+SHIFT+Z
Zoom To Selection changes the zoom magnification so the selected objects fill the window. See Zooming to the selection for more
details.



3* Zoom To Work Area

[3* CTRL+SHIFT+P
Zoom To Work Area changes the zoom magnification so the entire work area is visible in the window. For more information, see
Zooming to the whole work area.



| pd
Zoom Tool

The Zoom Tool allows you to alter the magnification of the current document view. It only affects the view on screen - the
document itself does not change.

3* ALT+Z or SHIFT+F7
Zoom Tool Infobar Controls

Zoom Magnification
Zoom To Work Area
Previous Zoom
Zoom To Drawing
Zoom To Selection

3335

Zoom Tool Operations
Returning to the previous zoom
Zooming in and out
Zooming to the selection
Zooming to the whole drawing
Zooming to the whole work area

Using the Zoom Tool temporarily



Zooming in and out

You often want to view part of a document in greater detail or view the entire document to see how the complete drawing looks. To
achieve this, you can zoom in and out of the document. If you want to zoom in on your whole drawing, see Zooming to the whole
drawing. If you want to zoom in on the selected objects, see Zooming to the selection.

| g To zoom in or out
1. Choose the Zoom Tool.

2. Do one of the following :

O+ To zoom in, click on the document (see less of the document but in greater detail).
G+ To zoom out, SHIFT-click on the document (see more of the document in less detail).
&+ To view a specific area, drag across the area.

Tips

O+ Zooming just changes your view onto the document. It does not change the actual size of objects in the document.
G+ The text on the Status Line shows the zoom in and out values. This tells you the effect of a click or SHIFT-click.

G You can also choose a zoom value from the Zoom drop-down list on the control bars. (See Zoom Magnification.)
O+ You can easily go back to the last zoom magnification by using Previous Zoom. See Returning to the previous zoom.
G+ If you press ALT+Z to select the Zoom Tool, you can press ALT+Z again to return to the previous tool. See Using the
Zoom Tool temporarily.
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Zooming to the selection

It is often useful to zoom in on your document so the selected objects fill the document view.
G To zoom to the selection

1. Choose the Zoom Tool.

2. Click the Zoom to Selection button on the Infobar.

Tips
| To quickly zoom to the selection, press CTRL+SHIFT+Z
G You can also choose Selected from the Zoom drop-down menu on the control bars. (See Zoom Magnification)
O The Zoom to Selection button is also on the Push Tool Infobar.
G+ You can return to the previous zoom value by clicking the Previous zoom button on the control bars. See Returning to the

previous zoom.
O+ If you press ALT+Z to select the Zoom Tool, you can press ALT+Z again to return to the previous tool. See Using the

Zoom Tool temporarily.
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Zooming to the whole drawing

It is often useful to scale your view (zoom) so the complete drawing fills the document view.
G To zoom to the drawing

Click the Zoom to Drawing button on the control bars.

Tips
O+ This button is also on the Push Tool and Zoom Tool Infobars.
| You can also choose Drawing from the Zoom drop-down menu on the control bars. (See Zoom Magnification)
&+ You can return to the previous zoom value by clicking the Previous zoom button on the control bars. See Returning to the
previous zoom.
| If you press ALT+Z to select the Zoom Tool, you can press ALT+Z again to return to the previous tool. See Using the

Zoom Tool temporarily.
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Zooming to the whole work area

It is sometimes useful to change the zoom magnification so you can see the entire work area in the document view.
O+ To zoom to the work area

1. Choose the Zoom Tool.

2. Click the Zoom to Work Area button on the Infobar.

Tips
O The Zoom to Work Area button is also on the Push Tool Infobar.
G You can also choose Work Area from the Zoom drop-down list on the control bars. (See Zoom Magnification)
O+ To quickly zoom to the work area, press CTRL+SHIFT+P.
G+ You can return to the previous zoom value by clicking the Previous zoom button on the control bars. See Returning to the

previous zoom.
g If you press ALT+Z to select the Zoom Tool, you can press ALT+Z again to return to the previous tool. See Using the

Zoom Tool temporarily.
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